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This month...

Graham Barlow Editor-in-Chief
www.facebook.com/windowsmag

It’s been another frantic month  
in the Windows Help & Advice 
office, with the brand new 
preview version of Windows 10  
to play with (read all about our 
adventures with Windows 10 
on page 66), a small clutch of 
Bluetooth speakers to try out 
(see page 80) and a selection 
of cracking games that start 
on page 88. The versatility of 
modern PCs never ceases to 
amaze me. Many tablets restrict 
what you can do with them, but 
Microsoft doesn’t like to set limits 

on what its devices are capable 
of, so you get a full version of 
Windows, even on a handheld 
device. If you’ve just bought a 
new Windows tablet then don’t 
miss our guide next issue to 
getting started with Windows 
8.1. There’s plenty of advice for 
beginners this issue too – see our 
guide to OneDrive on page 58, 
our tutorial on using a picture 
as a password in Windows 
8.1 on page 28, and our 
tour of the Xbox Music 
app on page 54.

Welcome

SUBSCRIBE TO THE MAG TODAY AND 
SAVE - JUST TURN TO PAGE 30!

We pride ourselves in being the only magazine 
on the shelves to show you exactly how to get 
the best from the Windows operating system, 
whether it’s 7, 8, 10, Vista or even XP. Windows  
Help & Advice also comes with a disc, on  
which you can find some of the great apps 
covered in the magazine. If you get a chance, 
take a look at how you can even read the 
magazine on your laptop, phone or tablet.

http://www.facebook.com/windowsmag


6 Discover Explore the mysteries of 
the oceans without getting your feet wet

30 Subscriptions Save up to 69  
per cent with a subscription bundle!
 
35 Back issues Don’t miss out!  
Order past issues while stocks last.
 
73 Bookazines Handbooks to help 
you learn new computing skills
 
98 Next month Gaze into the 
future… What’s happening in January?

74 Four pages of essential 
expert help for all your 
tricky technical queries

REGULARS

FEATURES

SUPPORT

12 Refresh Windows 
Essential hints and tips to get your 
Windows 7 PC running good as new

60 OneDrive to rule them all
Discover how to get the most out of 
Microsoft’s brilliant cloud storage service
 
68 Hands on with Windows 10 
Our experts take the Technical Preview 
edition for a spin and share their thoughts

EXPLORE  
The best PC tutorials

Want more? Visit our website at 
www.facebook.com/windowsmag

24 Research and record  
your family history

28 Set a picture password  
in Windows 8

32 Write your first novel  
with yWriter

36 Plan the perfect trip  
with Bing Travel

38 Connect to your PC  
using an iPad 

 
42 Use File History to  
back up important data

46 Investigate and improve 
Windows 7’s reliability

50 Solve hardware issues  
with Device Manager

54 Find new songs using  
Windows 8’s Music app 
 

“Each month we include as wide a range of tutorials 
as possible, to help you use your computer more 
ef ciently and inspire you to try new things.
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 NEW THINGS TO DO  AMAZING WEBSITES  FASCINATING FACTS

THE DEEP Follow our guide to exploring the sea  

and a trip to the beach will never be the same again

6  |    |  Christmas 2014



The Knowledge…

One of the biggest challenges to the ocean 
is overfishing. This can have a catastrophic 
effect on the delicate food chain in the 
oceans, resulting in the near-devastation 
of entire species. It’s not all bad news, 
though – some species are thriving, such 
as Arctic char and catfish. The UK’s 
Marine Conservation Society has a guide 
at www.fishonline.org, and it may even 
encourage you to give up cod and chips in 
favour of something more sustainable.

Explore the fascinating 
world beneath the waves

O
ur oceans make up more than a 
third of the planet’s surface, yet 
we’ve explored just five per cent 
of them. We know more about 

the surface of the moon, and even Mars, 
than we do about our seas. The fact that 
we have such rich, unmapped ecosystems 
on our doorsteps (or shorelines) is 
intriguing, and amazing new discoveries 
are made on an almost daily basis.

Nature and science society National 
Geographic’s ocean 
pages (http://ocean.
nationalgeographic.
com/ocean) are a 
great starting point 
for learning about the 
world’s watery bodies. Here you’ll find 
some amazing photographs taken both 
above and below the surface, as well as the 
latest news on expeditions to the murky 
depths, and the society’s efforts to protect 
coastlines and marine creatures. 

America’s National Oceanic and 
Atmospheric Administration runs a site 
for children (http://oceanservice.noaa.
gov/kids), and it's packed with fun 

activities so kids can learn about the seas. 
As its name suggests, www.seasky.org 
provides a friendly and easily navigable 
guide to the worlds above and below us. 

Google has helped out with mapping 
the oceans. Its underwater Streetview 
project (www.google.com/maps/views/
streetview/oceans) has taken in amazing 
aquatic sights around the world, including 
the Belize Barrier Reef System, Australia’s 
Great Barrier Reef and Sian Ka’an in 

Mexico. Browsing 
these incredible 
images is the closest 
most of us will get 
to diving into the 
pristine waters.

Finally, check out the BBC’s dedicated 
Oceans site (www.bbc.co.uk/oceans/
progcast), which was created to tie in with 
its astounding Ocean documentary series 
in 2008. Despite its age, there’s still a lot 
of fascinating behind-the-scenes content 
here, including information on the 
featured oceans, the presenters and the 
incredible discoveries the team made 
while filming the series.

Discover how to delve into the deepest chasms of the 
seven seas without even getting your toes wet

802.11ad
Is that a foreign postcode?

Probably, somewhere in the world, yes, 
but it’s also the name given to a new 
wireless technology that promises to 
deliver five times faster speeds than the 
current best option. It’s been in the 
pipeline for a while, but Samsung reckons 
it’s finally overcome the technology’s 
biggest problem.

Which is?

Walls. The technology uses 60GHz radio 
bands, as opposed to the 2.4GHz and 
5GHz bands used by current standards. 
This means that data can be sent and 
received at far faster rates, but the wireless 
signal is also more likely to be severely 
disrupted by brick walls.

So how has Samsung solved this?

With some very special antennas. 
Samsung’s technology uses beamforming, 
which shapes signals so that they are more 
penetrative and powerful: think along the 
lines of the difference between a hose 
spraying or streaming water. Devices 
connected to an 802.11ad network will 
locate one another in physical space, and 
adjust the signal to be more powerful.

What sort of speeds can I expect?

Samsung reckons it’s going to be pretty 
amazing, with maximum speeds of 
4.6Gbps, which will allow users to send 
a 1GB movie file in under three seconds. 
In turn this could change the way we 
consume media, with the ability to stream 
ultra-high definition 4K content from a 
mobile phone to a screen without any 
sign of lag or compression.

Sounds great. When can I get it?

Surprisingly soon. Despite the fact that 
Samsung has only just announced the 
technology, it believes that it will be ready 
for deployment in the wild early next year. 
It may take a while longer to be adopted 
on a larger scale though, and it’s worth 
remembering that it’s going to be a bit 
pointless if you’ve got a slow (ie British) 
internet connection.

PERCH SEARCH Enter the name of a fish in the 

search box to find out if it's sustainable.

PRAWN AGAIN Each month the site adds a new 

recipe for one type of sustainable fish.

BASS BROWSER Click on 'Fish to eat' and 'Fish to 

avoid' to see what's hot and what's not.

FISHFINDER Search for sustainable seafood 

“It's the closest most of 
us will get to diving into 

the pristine waters”

Discover
Underwater exploration
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Tip of the month Synaptic feedback

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 

‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

Windows is hugely customisable, but the 

humble mouse pointer is one of those bits 

of the operating system not many people 

realise they can change. To do so, click ‘Start’, 

followed by ‘Control Panel > Hardware > 

Mouse’. Now click the ‘Pointers’ tab and you’ll 

see a number of different options to choose 

from, including magnified and inverted, both 

of which may be easier for you to see than 

the default pointer. Here you can also turn 

a shadow on the cursor on or off. For more 

customisation options you can download 

new and interesting cursors from the internet 

– visit http://customize.org/cursor for lots of 

well-designed pointers, and instructions for 

downloading and installing them.

Change your pointer

One of the biggest problems with Windows 

8’s Start screen is that it initially only displays 

the icons Microsoft thinks you need, rather 

than the ones you want. There’s an easy 

solution for this, though – simply click the 

arrow in the lower left of the screen to see 

all your programs, then right-click on the 

relevant icon and select ‘Pin to Start’ and it’ll 

show up on the Start screen. You can also pin 

websites here by firing up Internet Explorer, 

browsing to the website you wish to 

bookmark, clicking the ‘Settings’ icon and 

choosing ‘Add site to apps’. Follow the above 

process to move it to the Start screen.

Pin to the Start screen
Your Windows user picture, which appears 

beside your name at the top of the Start 

menu, is usually something you choose 

when you first set up your computer and 

then forget about. However, it can become a 

little boring to see the same labrador puppy 

or orange flower whenever you turn on your 

computer. It’s easy to change this picture to 

something a little more personal: click the 

‘Start’ button, then choose ‘Control Panel > 

User Accounts and Family Safety > User 

Accounts’. Now click ‘Change your picture’ 

and either choose one of the images 

supplied, or click ‘Browse for more pictures’ 

to pick a snap from your computer.

Change your  
user picture

Multi-touch gestures can make using 

your laptop a lot easier. This clever 

technology means that you can use 

two-finger swipes on your touchpad 

to scroll up and down webpages, and 

pinch to zoom in and out of websites. 

Synaptics – the company that makes 

the majority of laptop touchpads – has 

made it available for older laptops that 

may not have supported it in the first 

place. To set it up, visit www.synaptics.

com/en/drivers.php and choose the 

Windows drivers. Once it’s installed 

you’ll see a small animated green icon 

in the lower right. Right-click this and 

choose ‘Pointing device Properties > 

Device settings > Settings’. Here you 

can turn gestures on and off under the 

Scrolling, Pointing and Application 

Gestures headings, and once you’re 

used to them you’ll be flinging your 

way through websites and documents.

Enable gestures on almost any computer
Make the most of your laptop’s standard touchpad 
with Synaptics’ universal suite of multi-touch tools

TOUCHYFEELY Enabling multi-touch gestures with Synaptics’ 

toolkit can make your laptop feel like a whole new machine
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M
icrosoft has announced that 
the latest version of Windows, 
dubbed Windows 10, will be 
released in late 2015. Sitting 

somewhere between the much-maligned 
Windows 8 and the much-loved Windows 
7, Windows 10 will be available across a 
range of devices, from 4-inch phones to 
computers linked to 80-inch displays.

It’s more critical than ever that 
Microsoft gets Windows 10 right. 
Windows 8’s poor reception combined 
with its usability 
issues means that 
it hasn’t taken 
off as Microsoft 
hoped it would. 
Windows 7 is still 
the world’s most 
popular desktop 
operating system, 
according to Net 
Applications, 
with a 52 per cent 
market share. Embarrassingly for 
Microsoft, Windows 8 is installed on just 
12 per cent of PCs, while the 13-year-old 
Windows XP runs on 24 per cent.

Microsoft is taking a step back and 
making Windows 10 more like Windows 
7. The Start menu – which was replaced by 
Windows 8’s Start screen – will return, 
complete with all your recently-accessed 
programs and a search bar. The new Task 

View will make switching between apps 
and programs even easier, and multiple 
desktops will mean demanding users can 
run two virtual computers in one.

Despite its poor reception, we rather 
liked Windows 8. Its colourful, blocky 
design went against the more finicky 
layout of Windows 7 and Apple’s OS X, 
while the Start screen and Windows Store 
were ideal for kids and people who found 
themselves lost in Windows 7’s myriad 
options. These will remain in Windows 

10: apps will be displayed 
on the Start menu 
alongside full programs, 
and you’ll be able to run 
these apps in windows 
rather than full screen.

The ability to snap 
Windows into two halves 
of your monitor – known 
as Aero Snap – has been 
a feature of Windows 
since 7, but Windows 10 

will take things a big further by letting 
you snap a program to each corner of the 
screen, which is a boon for multitaskers 
with big monitors. 

Better still are rumours that the new 
operating system will be available free of 
charge, if not just for Windows 8 owners, 
then everyone. It could be just the ticket 
Microsoft needs to get on the next train of 
innovative technology.

After the misstep that was Windows 8, Microsoft seems 
back on track with its next operating system

1Google is trialling a 

video tool to connect 

people with whom?

A Firemen
B Doctors
C Deep sea divers

2Minessotan Anna 
Stoehr lied about her 

age to join Facebook. 

How old is she?
A Two
B 12
C 114

3 Scientists have 
created a battery 

that does what?
A Bends to any shape
B Beeps if it needs charging
C Warns users if it’s 
overheating

4 Google’s new cable 

between Brazil and 

the US will resist what?

A Crabs
B Sharks
C Kaiju

5 What is the unique 

selling point of 

Honeywell’s thermostat?

A It’s voice-activated
B It scans your body 
temperature
C It heats electric blankets

6 A proposed free 
school will use what 

to teach kids?
A Video conferencing
B Robots
C Videogames

Answers 1B. 2C. 3C. 4B. 5A. 6C

What’s in Windows 10 One Hero
www.onehero.ca

One Hero is a great example of how 
the web, and its HTML5 programming 
language, can be used to tell a story in a 
unique and powerful manner. It works 
much like a scrollable comic book, and 
features a heroic motorcyclist attempting 
to stop an ongoing mutant invasion 
perpetuated by a madman. Movement 
and sound are used to make it come to 
life, and it occasionally throws game-like 
interactivity into the mix.

It’s all been created to serve a heroic 
purpose, too – it’s a promotion to get 
young men to donate stem cells to 
Canadian Blood Services. In fact, the story 
itself a clever analogy for the experiences 
of victim who needs a stem cell donor, 
with the ‘cure’ for the invasion being a vial 
of blood. It won’t take you more than 10 
minutes to complete, but it’s a great way 
to experience the future of web-based 
entertainment.

THE ONE AND ONLY This nifty website uses 

sound, images and interactivity to spin a yarn

Discover
Talk
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…Britons have asked for results to be removed from 
Google searches since the introduction of its ‘right to 
be forgotten’ program earlier this year. The system was 
introduced after a European court of justice ruling on 
internet privacy, and it means that anyone can ask for 
outdated or irrelevent results to be removed. 145,000 
appeals have been made across Europe so far.

20,000...

The BBC launched its first website, the 
BBC Networking Club on 11 May 1994. 

It required members to pay a £25 joining fee and 
£12 monthly membership.

It registered www.bbc.co.uk in 1996 and 
launched its first publicly-accessible website.

The BBC launched its news site a year later. 
www.bbc.co.uk/news currently attracts 40 

million unique users a week.

In 1999, the BBC bought the www.bbc.com 
domain name, previously owned by Boston 

Business Computing, for a whopping $375,000.

As the BBC’s online content continued to 
grow, the site became harder to navigate. 

On 7 November 2001 it relaunched its content 
under the BBCi umbrella.

In 2007 the BBC introduced on-site 
advertisements for visitors from outside the 

UK, who don’t pay a licence fee.

   On Christmas Day 2007 the BBC’s iPlayer 
service launched, although it was only 

available to Windows XP users to begin with.

On 24 January 2011 the BBC announced 
plans to cut its online budget by 25 per 

cent (or £34 million), following complaints from 
competing broadcasters that it was attracting too 
many of their visitors.

In 2013 www.bbc.co.uk was the most popular 
site in Europe with 64 million visitors in 

January of that year. However, it’s since fallen 
behind Twitter and Google.

With 3.63 million requests for playback, 
Sherlock: The Empty Hearse has become the 

most popular programme on iPlayer.

WWW.BBC.CO.UK FACTS
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3% think it’s in their device.

4% say it’s at DARPA, the US military defence research agency.

8% reckon it’s in supercomputers.
10% believe it lives in ‘the cloud’.
25% don’t know.

51% correctly say it’s in network-connected data centres. 

WHERE DO PEOPLE THINK THE INTERNET RESIDES?

According to a survey conducted by US broadcaster 
CNBC, 49 per cent of Americans have economised 
so they can spend more on technology. A third have 
cut back on entertainment such as movies and eating 
out, 20 per cent have curbed spending on clothing, 
and 11 per cent purchased less food. Worryingly,  
10 per cent reported that they’d spent less on 
healthcare due to their obsession with gizmos.

Do you spend more on 
technology than anything else?
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Henry Winchester reveals a host  
of fascinating digital facts
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5TH

The tallest mountain 
in Wales has been 
recorded by Ordnance 
Survey as measuring 
1,085 metres above sea 
level. However, intrepid 

technology-equipped 
ramblers and climbers 
have found that their 
GPS devices record the 
summit at 1,086 metres. 
Ordnance Survey 

needn’t worry, though 
– the cause of the 
100cm discrepancy 
is simply due to a 
man-made plinth at the 
top of the mountain.

…is Microsoft’s ranking in 
Interbrand’s annual list of the 

world’s biggest brands. Apple, 
Google, Coca-Cola and IBM all 
rank higher, with the top two 

valued at over $100 billion for the 
first time ever. Interbrand recognises Microsoft’s 
attempts to keep up with the ever-changing world 
of technology. “Microsoft also repositioned from 
‘Windows first’ to ‘cloud and mobile first’, marking 
a departure from the company’s legacy strategy in 
desktop software,” it said.

HOW HIGH IS MOUNT SNOWDON?

WHAT’S THE BEST  
MOBILE NETWORK  
IN LONDON?
London is home to some of the 
world’s biggest tech companies, 
but its mobile standards leave 
a lot to be desired. Network 
analysis firm Global Wireless 
Solutions tested the capital’s 
networks by running high-level 
tests while out and about. It 
found that Vodafone is the best 
network for 3G connectivity, 
while EE offers the best 4G 
coverage. One in three mobile 
internet tasks and one in 
seven voice calls failed during 
testing on moving trains, and St 
Pancras Station was found to be 
a total mobile signal blackspot.

81 MILLION...
…people have listened to at least 
part of U2’s album Songs of 
Innocence, which was given away 
free by Apple to celebrate the 
release of the iPhone 6. 26 million 
people went on to download the 
album to their iTunes library. 
“To help put this into perspective, 
prior to this, 14 million customers 
had purchased music from U2 
since the opening of the iTunes 
store in 2003,” said Apple’s vice-
president Eddy Cue.

Discover 
Facts & figures
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REFRESH

WINDOWS
Don’t let your PC slow you down.  
Ben Andrews reveals some essential 
tips to get Windows 7 back up to speed

R
emember when you first powered up 
your shiny new Windows 7 PC and how 
quickly it sprang into life? Chances are if 
it’s been well used, things will no longer 

seem quite so nippy. Well fear not, because you 
shouldn’t need to fork out for a new machine 
just yet. With the aid of various Windows tweaks 
and some software tools, your computer can be 
restored to its former glory.

In this feature, you’ll discover why your once 
speedy computer is beginning to feel the strain, 
and learn the best ways to unshackle it from 
this virtual ball and chain. You may already be 
familiar with some of the techniques you can 
use to show your PC some love – whether 
it’s uninstalling unused software or simply 
protecting it with an up-to-date antivirus 
program – but we’ll reveal plenty more Windows 
7 tune-ups that’ll help you keep your computer 
in tip-top condition. 

Doubling your PC’s speed isn’t a fine art and 
you won’t need a degree in technical wizardry, 
either. One of the easiest and most effective 
ways to get your PC back on track is simply to 
keep it free of clutter. Just as you’d struggle to 
find a document in a filing cabinet bursting with 
papers, a hard drive stuffed full of unnecessary 
files isn’t going to be the fastest environment 
to work in. Once Windows has been given a 
thorough tidy, you’ll find out how a humble USB 
flash drive can boost its performance, and we’ll 
reveal hidden settings to deactivate some of 
Window’s 7’s most speed-sapping visual effects. 

Armed with these tricks you can spend less 
time staring at loading screens and get on 
with exploring the best bits of Windows 7. 
Most of the techniques here can be 
mastered with ease, and what’s 
more, they won’t cost you a 
single penny.
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Clean your hard disk

Put these easy tricks into practice and you’ll  
already be well on the way to a faster computer

Removing unnecessary files will really help speed up Windows

I mproving your PC’s performance 
can just be a matter of giving it 
a spring clean. Leave the feather 

duster in the cupboard though, as 
this housework only requires some 
deft mousework.

Click ‘Start > Computer’ and 
right-click on the hard drive where 
your Windows files reside (in most 
cases you’ll find them in the C: 
drive). Next, click the ‘Properties’ 
option to display a small window 
featuring a blue and purple pie 
chart. Notice the button next to this 
labelled ‘Disk Cleanup’ – clicking 
this will reveal various file 
categories you can cleanse. 

Generally any item on the list 
can be ticked for deletion, but give 
your Recycle Bin a quick once-over 
to make sure there’s nothing 
important lurking inside that might 
be purged accidentally. Leaving the 
‘Thumbnails’ box unchecked is also 
wise, as this saves your computer 
the trouble of regenerating image 
thumbnails when you next view 
your photo albums. Click ‘OK’ and 
Windows will commence the 
cleanup, free some hard drive space 

SHED THE WEIGHT 

Cleaning out your 

hard drive is one of 

the best ways to 

add extra speed to 

your PC or laptop

and make your PC run a little faster 
now it’s shed some of those extra 
virtual pounds.

To achieve a deeper clean, click 
the ’Disk Cleanup’ button next the 
pie chart again, but switch to the 
More Options tab. The upper ‘Clean 
up’ button opens the ‘Uninstall or 
change a program’ window where 
you can scour your computer for 

unnecessary software. Abandoned 
games, disused printer software 
and unnecessary web browser 
toolbars are all worth uninstalling. 
Back on the Disk cleanup window, 
the lower ‘Clean up’ button will 
delete Windows System Restore 
points apart from the most recent, 
potentially releasing gigabytes of 
storage space.

The Windows Disk Cleanup function does a pretty good 

job of clearing clutter, but CCleaner (on your free disc) 

will remove even more unnecessary Windows files and 

tidy up your existing programs.

All you have to do to set CCleaner on this 

comprehensive cleaning mission is to click the ‘Analyze’ 

button to see just how much rubbish CCleaner can find, 

followed by the ‘Run Cleaner’ button that completes 

the job. If you’d also like to tidy up the very bowels of 

Windows itself, select the Registry tab on the left and 

repeat the same process.

A word of warning though: while CCleaner is 

preconfigured to keep some useful content, it’s worth 

checking what the software is about to be deleted.

CCleaner will tidy up Windows files plus 
the leftovers from other programs, too

THE ULTIMATE DISK CLEANUP

SCRUBBING UP  

A program like 

CCleaner is perfect 

for clearing out 

any unnecessary 

files on your 

machine of choice
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Defragment  
your hard drive

Limit the number of 
start-up programs

Once you’ve had a data clearout, defragment 
your remaining files to ensure fast loading times

The more programs which automatically load 
when you start your computer, the slower it gets

The web breeds speed-
sapping software. Avoid 
them all with these tips F ragmented files are files that 

have been chopped up to 
fill vacant spaces on your 

hard drive, rather than being 
saved in one piece. Windows 
needs time to reconstruct these 
files when you come to load 
them, slowing your PC down. 

M any software programs 
have an annoying habit 
of assuming you want 

them to load and run in the 
background every time you start 
your PC. This can mean it takes 
longer to turn on and all those 
programs running behind the 
scenes sap a lot of power.

3 Miracle cures
Beware of ‘free’ software claiming to instantly 

speed up your PC. Some programs are legit, but many 
make false claims that your computer is at death’s 
door, offering to bring it back from the brink with the 
aid of your credit card. Avoid them at all costs.

2 Peer-to-peer file sharing software
Although not a threat in its own right, file 

sharing software can open the floodgates to viruses 
and malware. If you do use such software, pay close 
attention to the filenames you download and avoid 
anything ending ZIP, RAR or EXE.

1 Viruses & malware
If you often get suspicious pop-ups in Windows 

or your web browser homepage keeps changing 
itself, your computer may be playing host to some 
malicious software. Show it the door with 
Malwarebytes Free (www.malwarebytes.org).

Defragmentation rearranges the 
contents of your hard drive, 
creating large enough areas of 
free space for files to be stored as 
complete units that can be 
opened as fast as possible.

Thankfully, defragmenting 
your hard drive is really easy to 

do. Click ‘Start > 
Computer’, right-click 
on the drive’s icon and 
select the ‘Properties’ 
option, followed by the 
Tools tab in the next 
window. Press the 
button in the middle 
labelled ‘Defragment 
now’ and select the 
drive in question from 
the list. You can now 
start the defrag 

process by clicking on 
the ‘Defragment 

disk’ button.

Windows does, however, 
include a useful gadget to let you 
regain control of which programs 
automatically start up when 
Windows loads. It’s called the 
System Configuration tool and 
you can access it by clicking 
‘Start’, typing msconfig and 
pressing [Enter]. Switching to the 

Start-up tab reveals a 
list of programs that 
can be deselected 
from the start-up list. 
Most of these can be 
unticked without issue, 
but ensure items 
relating to antivirus 
and firewall software 
are left enabled for 
automatic start-up. 
Finally, click ‘Apply’ and 
restart your computer 

for these new 
changes to take a 

positive effect.
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A clean and tidy computer is all well and good, 
but adding extra performance is even better…

I f a name is anything to go by, 
ReadyBoost certainly sounds 
like it could deliver in the 

performance stakes. This Windows 
7 feature utilises a USB flash drive 
to help speed up your computer’s 
hard drive when it loads frequently-
used software and files.

ReadyBoost won’t work with any 
old flash drive though, as it needs 
at least a 256MB capacity and be 
fast enough to meet Windows’ 
requirements. To see if you’ve 
already got something suitably 
quick, plug the drive in, click ‘Start 
> Computer’ and right-click on the 
drive’s icon, then select ‘Format’ 
from the menu and leave any 
formatting options unchanged. 
Formatting will delete any data on 
your flash drive and prepare it for 
use with ReadyBoost, so if there are 
any files stored here you don’t want 
to lose, back them up first.

Once the format is complete, 
right-click on your hard drive again, 
but this time select ‘Properties’, 
followed by the ReadyBoost tab. 

Should you be met by a message 
stating that this device cannot be 
used for ReadyBoost – try clicking 
the ‘Test again’ button, but if 
Windows still won’t play ball, it’s 
time to buy a faster flash drive. 
Next, select ‘Dedicate this drive to 
ReadyBoost’ and click ‘Apply’.

As Windows learns the software 
you use most, loading times will 
gradually reduce. Older PCs with 
512MB of RAM will reap the 
greatest speed increase, and while 
machines with 1GB or more RAM 
can benefit from ReadyBoost, don’t 
expect to be blown away by it.

Windows 7 ReadyBoost
Give a spare USB flash drive a new lease of life and use it to boost Windows 7

GET BOOSTED 

 The kind of results 

you’ll get from 

using ReadyBoost 

will differ from PC 

to PC, so see what 

it can do for you

1 Disable User Account Control
This Windows security feature 

relentlessly asks your permission every 
time a program tries to make changes to 
your PC. To disable it, type UAC in the Start 
menu search box, press [Enter] and set the 
slider to ‘Never notify’.

2 Activate auto-logon
If your computer only has a single 

user account, did you know you can skip 
the logon screen and load straight to the 
desktop? Click ‘Start’, type run and press 
[Enter]. Type control userpasswords2, 
click ‘OK’ and uncheck the tickbox.

3 Check your power plan 
Sounds obvious, but it’s worth 

clicking ‘Start > Control Panel > Hardware 
and Sound > Power Options’ to ensure 
your computer is set to the speediest High 
Performance plan. Laptops tend to revert 
back to Power Saver when unplugged.

Step-by-step Three easy tweaks
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Stay familiar with Windows Task Manager
This Windows tool isn’t just useful for ending unresponsive 
programs – use it to monitor resource-hungry software as well

N ow your hard drive 
has been cleansed of 
unnecessary files and 

you’ve vetted which programs 
load at startup, it’s a good idea 
to keep track of what software 

is left running 
to ensure 
nothing is 
hogging an 
unfair share 
of computing 
resources. 
The good old 
Windows Task 
Manager is 
one of the 
most reliable 
tools for 
keeping 

you in the 
picture.

Access it by simply right-
clicking an empty area of the 
Taskbar and select the ‘Start 
Task Manager’ option. Switch 
to the Processes tab and click 
the column label ‘CPU’ to 
arrange each active program 
and Windows service in order 
of which is using the most 
processor power. Ignore the 
‘System Idle Process’ entry if 
this appears at the top of the 
list and instead check whether 
anything else is consistently 
ranking high on this power-
hunger scale. Clicking the 
‘Memory’ column header will 
also reveal any programs 
which may have an appetite 
for large amounts of RAM.

Update your 
graphics drivers
Outdated graphics card drivers can 
significantly reduce performance

W hether you’re an 
avid gamer or just 
enjoy an occasional 

HD video, keeping your 
computer’s graphics drivers 
up to date is vital. 

The graphics hardware 
in your PC is likely to come 
from one of three main 
manufacturers. The way to 
tell which one is to type 
dxdiag in the Start menu 
search box and press [Enter]. 
A notification window may 
appear, click ‘No’ to dismiss it 
and access Windows 7’s 
DirectX Diagnostic Tool. 
Switch to the ‘Display’ tab 

and in the upper-left corner 
your graphics hardware 
maker will be revealed.

Each manufacturer has 
automatic driver detection 
tools to help you upgrade to 
the most up-to-date drivers 
for your hardware. Visit 
http://support.amd.com, 
www.geforce.co.uk/drivers 
or http://downloadcenter.
intel.com for more info.

Before you install new 
drivers, it’s best practice 
to uninstall your existing 
ones by clicking ‘Start > 
Computer’, then ‘Uninstall or 
change a program’.

Adjust visual settings
Much of Windows 7’s visual flair can be 
disabled to free up some power reserves

W indows 7 may be a 
few years old, but it 
still looks the part 

thanks to its animated 
effects, drop shadows under 
each window and much 
more visual eye candy.

On modern PCs you can 
crank these effects to the 
max and they shouldn’t slow 
you down, but an older 
machine which may have 
only just met Windows 7’s 
minimum hardware 
requirements when new 
could now be struggling to 
make the grade. Help it out 

by disabling some of 
Windows’ pretty but 
non-essential frills.

You can do this by clicking 
‘Start’, typing windows 
performance and pressing 
[Enter]. Selecting the ‘Adjust 
for best performance’ option 
will disable all visual effects 
to give you the biggest 
performance boost. Click 
‘Apply’, but if you now come 
across something that looks 
a little too crude like jagged 
font edges or jerky list 
scrolling, revisit this menu 
and re-tick the options.

If you do come across a 
program that seems to be 
putting undue strain on your 
machine, head over to the 
software manufacturer’s 
website to see if any updates 
have been released to tackle 
the problem.

Next time you hear your 
hard drive crunching away of 
its own accord, bring up the 
Task Manager again, but move 
to the Performance tab and 
click the ‘Resource Monitor’ 
button. Next, select the Disk 
tab and click the column 
header ‘Total (B/sec)’ and any 
software monopolising your 
hard drive will be exposed at 
the top of the list.
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1 RAM on your hard drive?
When your computer runs out of 

memory (RAM), it borrows a portion of 
your hard drive to use as virtual memory. 
To improve performance by allocating 
more virtual memory, click ‘Start’, right-
click on ‘Computer’ and select ‘Properties’.

2 Do your sums
See the amount of ‘Installed memory 

(RAM)’ you have listed here? Multiply this 
figure by 1,024 and then multiply the new 
number by 1.5.  Make a note of the answer, 
before clicking the ‘Advanced system 
settings’ link on the left.

3 Complete the change 
On the Advanced tab, click the 

uppermost ‘Settings’ button, followed by 
the ‘Change’ button. Uncheck the top 
tickbox, choose the ‘Custom size’ option 
and enter your previously noted number 
into both boxes. Click ‘Set > OK’ to finish.

Step-by-step Increase your virtual memory

When quick fixes aren’t enough, Windows 7 still 
has plenty of clever ways to regain some speed

Partition your hard drive
Speed up Windows and your software by running them on their own virtual hard drive

O n many hard drives, your 
documents, photos and 
music are saved to the 

same area where your Windows 
operating system and software are 
located. Defragmentation can help 
organise everything, but having 
all your personal files crammed 
alongside Windows can really slow 
the whole system down. The 
process of partitioning solves the 
problem, enabling your Windows 
operating system and software 
to be digitally fenced off on a 
streamlined virtual hard drive. 
Windows 7 itself can create a 
partition, but MiniTool Partition 
Wizard (www.partitionwizard.com) 
is a free alternative program that’s 
more advanced, yet easier to use.

Once installed and loaded, notice 
the bar graph representing the 
available space on your hard drive. 
Right-click on the section where 
Windows and your files are stored 
(usually the C: drive) and select 
the ‘Split’ option. Inside the new 
window, move the slider to the 

point where you’d like your 
partition, but remember to leave 
at least 20GB of free space with 
Windows to allow for future 
software installation. Next, click 
‘OK’, followed by the ‘Apply’ button 

in the top-left of the main window. 
The partition will now be created 
and another virtual hard drive will 
have magically appeared in your 
Windows Explorer menu for you to 
transfer your personal files onto.

PARTITION TIME 

Dividing your files 

from Windows and 

software apps is 

great, but regular 

defragmentation is 

important, too
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Want your PC to perform even better than 
new? Then it’s time to overclock your machine

OVERCLOCKING

Just as a car engine can be tuned to run faster, the same 

principle can be applied to computer processors. 

Manufacturers like Intel and AMD typically set the speed of 

their chips quite conservatively, but the art of overclocking can 

unlock any extra performance potential.

To give it a go, you first need to know the component 

specification of your computer. CPU-Z (www.cpuid.com) is a 

free and very useful software tool which tells you exactly 

what’s under the bonnet, so you can determine whether your 

machine is ripe for overclocking.

The tuning process itself can be performed via desktop 

software or through the PC’s BIOS, but often there’s a huge 

range of options available to tweak. Alter the wrong one or try 

boosting things too far and your PC could crash or overheat 

– and don’t expect a warranty to pick up the pieces, either.

Doing the right kind of research is vital for successful 

overclocking – for more information you can check out our 

sister website, www.techradar.com.

CLOCKING IN  

A good overclock 

can do wonders 

for your PC, but 

do so with caution

Tweak the Registry
Making the right adjustments to the 
Windows Registry can yield results

W indows 7 has some 
nifty time-saving 
features, such as 

the mini preview windows 
which pop up if you slide 
your mouse cursor over a 
Taskbar icon. By default, 
there’s a small delay 
between when you point 
at an icon and anything 
happening, which can get 
frustrating if you preview 
windows frequently. To 
speed this up, click ‘Start’, 
type regedit in the search 
box and press [Enter]. This 
gives you access to the 
Windows Registry, the secret 
control panel where you can 
fine tune your OS.

Using the folder menu 
pane on the left, double-
click ‘HKEY_CURRENT_USER’, 
then ‘Control Panel’ and 
finally ‘Mouse’. Now find 
‘MouseHoverTime’ in the list 
displayed in the right-hand 
pane and double-click it to 
reveal a new window. Here 
the number 400 in the ‘Value 
data’ box represents the 
millisecond delay between 
you hovering over a Taskbar 
icon and a preview window 
appearing. Changing this to 
a lower figure like 100 will 
speed things up nicely. Click 
‘OK’, restart your computer 
and hey presto, faster 
Taskbar previews.

Streamline any 
Windows services
Control which Windows services are able 
to take a share in processing power

W e’ve already 
used the System 
Configuration 

tool to stop unnecessary 
programs starting up when 
you load Windows, but it’s 
also possible to take this 
concept a stage further and 
prevent individual elements 
of Windows itself from using 
precious power resources.

To free up some extra 
speed this way, type 
services.msc in the Start 
menu search box and press 
[Enter]. You’re now greeted 
with a long list of services 
Windows may use to 
operate your computer. It 
looks daunting at first, but 
notice the Description 

column, which adds a little 
background information 
about each service name.

Clicking the ‘Status’ 
column will order the list so 
you can see which services 
are currently active, then it’s 
a matter of scrutinising these 
to see if any can be disabled. 
As a rule of thumb, if you’re 
not absolutely sure what a 
particular service does, 
simply leave it alone.

This isn’t to say other 
services can’t be tweaked, 
but we’d recommend 
visiting www.blackviper.com 
and finding the Windows 7 
Service Pack 1 Service 
Configurations chart to see 
which ones can be altered.

Speed tips 
Refresh Windows
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Step-by-step Back up your files

1 Load Windows Easy Transfer
You won’t need to shell out for pricey backup software as 

Windows 7 can do the job itself, but an external hard drive or a 
high-capacity USB flash drive is a must for temporarily storing 
your files. When you’re ready, type easy transfer into the Start 
menu’s search box and press [Enter] to load Windows 7’s Easy 
Transfer backup tool.

2 Select the files to keep
Windows assumes you’re transferring files from an old to a 

new computer, rather than a newly restored one, but go ahead 
and select the ‘Old computer’ option. The software will now 
search for files to back up, however if it finds too much for the 
capacity of your external storage, click the ‘Customise’ link and 
deselect files you could do without.

Windows 7’s performance-enhancing tricks will usually 
rescue a slow PC. Here’s what to do if they don’t…

Reinstall Windows
Wiping your PC and reinstalling Windows can be the most effective way to boost it

START AFRESH  

It may sound a 

little drastic, but a 

reinstallation of 

Windows 7 can 

give your poor old 

PC a real boost 

I f you’ve tried clearing the clutter, 
vanquishing viruses and making 
performance tweaks, but your 

computer is still on a go-slow, it’s 
time to return it to its former glory 
by reinstalling Windows. This will 
delete everything from your hard 
drive though, so if there are any 
files, emails or even Internet 
Explorer Favourites you don’t want 
to lose, it’s essential to back these 
up. Take a look at the step-by-step 
guide below to learn how to do this 
in a little more detail.

Know your methods
There are two main methods for 
reinstalling Windows, but we’ll start 
with the most common procedure 
for computers made by companies 
such as Dell or Acer. These 
manufacturers often allocate a 
small area of your hard drive to 
store a duplicate of the computer’s 

original Windows 7 data, which can 
now be used to overwrite any 
clogged Windows files. 

To access this preserved copy of 
Windows, restart your computer 
and as soon as it begins to fire back 
up, repeatedly tap [F8] until a menu 
entitled ‘Advanced boot options’ 
appears. Select the ‘Repair your 
computer’ option and press [Enter]. 
At this point, the computer’s 
recovery software may start to 
kick in automatically. If it doesn’t, 
continue until you reach the stage 
where you’re required to select 
your usual Windows account name 
from a drop-down list and enter 
the associated password as per 
normal. You’ll now be met with a 
list of various options, but the one 
we’re looking for activates the PC 
manufacturer’s recovery software 
and is normally the last link to 
appear on the list.

It’s now a matter of following 
the specific instructions for your 
recovery program, but if given the 
choice between preserving new 
and changed software or wiping 
everything back to exact factory 
specifications, plump for the latter. 
This way any undesirable digital 

20  |    |  Christmas 2014



3 Save the backup
Next you’ll be given the option to password protect your 

backup file, or you can head straight to saving the data to your 
external storage. Depending on the amount you’ve selected to 
back up, the process may take a while. When complete, be sure to 
unplug your backup storage from the computer before 
reinstalling Windows.

4 Restore your files
Once Windows is reinstalled and your computer is rearing to 

go, open Windows Easy Transfer again, but now tell it that this is 
your new computer. Plug your external storage back in and direct 
the software to the backup file it initially created. Finally, sit back 
put the kettle on and let Window’s restore your files to their 
previous locations. And that’s it, you’re done!

Okay, so this trick isn’t free, but it’s has 
the potential for a hefty speed increase

If you’re going to the trouble of reinstalling Windows, 

it makes sense to consider what it’s being installed on. 

Nowadays, you don’t have to put up with an old hard disk 

drive chugging away just to load a web page, as new SSD 

(solid state drive) technology really could double your 

loading speed.

Acting like a scaled-up USB flash drive operating inside 

your computer, this speedy storage can be had from a 

reasonable £50, and it’s also possible to continue using 

your existing hard drive for storing your personal files. 

With Windows and software at home on their own 

super-fast SSD, loading times will be slashed and your PC 

should feel considerably more responsive.

Switching to an SSD is one of the most significant 

performance upgrades you can make to a PC. For an 

installation guide, search www.techradar.com for ‘How to 

install a hard drive’ and skip to stage 2.

HIT TOP SPEED  

A SSD will do wonders for the  

speed and performance of your PC

intruders which may have set up 
camp on your computer over the 
years will be evicted.

Reinstallation with a disc
The second method for reinstalling 
Windows requires a genuine 
Windows 7 installation DVD, which 
you may have been given if your 
PC was built by a low-volume 
manufacturer. To use this disc, first 
back up your files then restart your 
computer, but instead of pressing 
[F8] on start-up, tap [F12] to load 
the DVD. When prompted, click the 

large ‘Install now’ button and 
continue until you’re asked which 
type of installation you want. Pick 
the ‘Custom (advanced)’ option 
and you’ll now have the choice of 
where to install Windows. Choose 
the partition where Windows is 
currently installed (usually the C: 
drive) and click the ‘Drive options’ 
link beneath. Double-check you’ve 
highlighted the correct partition, 
select the ‘Format’ option and 
when this finishes, click ‘Next’ to 
commence the main Windows 
reinstallation process.

You’re nearly ready to enjoy your 
newly-restored, fighting fit PC, but 
there are a couple more hurdles to 
clear. During the Windows set-up 
process you’ll have to enter your 
very own Windows product key. 
This is usually found on a sticker 
attached to your computer, or on 
the original packaging of your 
Windows disc. Finally, once you’re 
back online, be sure to regularly 
visit the Windows Update web 
page to apply essential security 
updates and add any missing 
hardware drivers. 

A SPEEDY UPGRADE

Speed tips 
Refresh Windows
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 WINDOWS TIPS   INTERNET ADVICE   YOUR DISC SOFTWARE

Your free disc…

On your disc
Install the free Windows 
Essentials suite from the 
Extras section.

Our promise to you…
Get more from Windows, software and all your favourite sites

Packed with informative tutorials
Every issue, we guarantee to pack the 
magazine with great tutorials teaching 

you all the best things you can do with your PC. 
Each article features step-by-step instructions 
to make learning new skills fast and enjoyable.

Customise Windows to work your way
We all know how to do the basics but 
getting the most from Windows isn’t 

always easy. Our dedication to the operating 
system means you get the very best tips and  
tricks for all versions of Windows.

Get more from your favourite websites 
We all have our list of favourite sites  
but often we miss out on great features 

because they’re dif cult to use or hidden from 
sight. We’ll show you how to do more online, 
for a more satisfying web life.

Use our full software to try new things
Our exclusive industry access enables us  
to pack your free disc with full commercial 

software. From speed-up and security software 
to superb photo apps, there’s always 
something new to try on your PC.

Welcome
Whether  
you’re stuck for 
inspiration or 
want to become  
a master of your 

Windows computer, our 
Explore section is the place 
to come. Each month we pack 
it with tutorials covering  
a range of subjects suitable 
for all levels of expertise.

This month, Nick explains 
how to research your family 
tree, Christian shows you how 
to get the best deal on your 
next holiday with Bing Travel, 
and Ed helps you back up the 
most valuable data on your PC. 
There’s never been a better 
time to see how your PC can 
make your life easier than ever! 

Graham Barlow  

editor-in-chief 
graham.barlow@futurenet.com

“Mastering Device 
Manager is the best way of 
fixing hardware issues and 
making sure old drivers 
don’t cause problems.”

This issue’s free disc is packed 
with full software, essential 
toolkits, apps and resources  
to help you get the most  
from your computer.

Look out for the badge 
(below) pointing to key files  
for the article you’re reading.
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Record your 
family history

“My Family Tree is a great tool 
for building and managing your 
family tree. Find out how.”

istory can be boring without 
context, and what better 
context could there be than 

to place your ancestors at the heart of 
it? Genealogy is an exciting way to 
learn about where you came from 
and reconnect with your family.

Family history software is plentiful, 
but most packages cost money. 
If you’re dipping your toe into the 
genealogical waters, then My Family 
Tree is one of the best free tools you’ll 
find for recording and managing your 
family’s rich history. The program 
offers all the core tools you need, 
helping you build your tree, flesh 
out your ancestors’ lives with events 
and attributes, attach old family 
photos and video, and even preserve 
stories handed down through the 
generations. Thanks to powerful 
reporting and analytical tools, you 
can take your research to the next 
level too. You can even customise its 
appearance with themes. Read on…

1 Download, install, set up
Go to www.chronoplexsoftware.com/myfamilytree and 

click ‘Get it free’. 32-bit users should click the orange ‘Download’ 
button and 64-bit users should choose the purple ‘My Family Tree 
(x64’) option. Once downloaded, double-click the setup file and 
follow the setup wizard to the end. Once complete, leave ‘Launch 
My Family Tree’ ticked and click ‘Finish’ to open the program.

2 Set up new tree
When the main menu appears, click ‘Start a new family tree’. 

You’ll be prompted to add your first family member – typically 
yourself. Enter your gender, then add your forename(s), surname, 
date of birth and birth place (use the format town, county, 
country) and click ‘Add’. You’ll see yourself appear in the centre of 
the main screen with your details in the right-hand pane.

Step-by-step Record your family history

ANCESTOR AGE
The age displayed next 
to a person is either 
their age at death or 
the age they were at 
the year set using the 
time slider. 

MARRIAGE DATE
Husbands and wives 
are linked with a 
green line, and the 
marriage year is 
displayed above this. 

H
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista

 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEN

SUITABLE FOR

1 hour
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3 Edit personal details
After saving your file for the first time (select ‘File > Save’, 

then choose a folder and name for your file), click the ‘Details’ 
button underneath your avatar to record more information 
about yourself. Start by clicking the little map icon next to your 
birthplace – you can record the exact Latitude and Longitude of 
your birthplace if you wish (see my best tip for details).

4 Add more facts
Click ‘Edit more facts’ to add extra attributes (such as 

education or nationality) and events (such as christening, census 
or emigration) by clicking the appropriate button. Then click the 
event on the left to fill in the details, such as details, date and 
place. Use the Address field to record an exact street address and 
contact details. Add as many facts as you wish to include.

Jargon buster!
 Attachments

Attachments allow 
you to link any file to 
an individual, and 
are typically scanned 
documents such as 
birth certificates.

 Pedigree tree
A horizontal diagram 
that shows a 
selected individual 
on the left and 
a set number of 
generations of their 
direct ancestors on 
the right.

 Theme
My Family Tree 
supports the use of 
different themes, 
which you can  
use to change its 
appearance for 
either cosmetic 
or accessibility 
purposes.

TIME SLIDER
The time slider 
lets you view your 
tree as it stood in 
a specific year, 
greying out events 
and people born 
after this date. 

CHART CONTROLS
The spanner button 
lets you customise 
your tree’s 
appearance and 
what’s shown; the 
cog button lets you 
switch views. 

EDIT CONTROLS
The currently 
selected person is 
displayed in this 
pane. Use the various 
options to add more 
detail and media to 
their tree entry. 

FAMILY VIEW
Use the search box 
to locate a person 
in your tree, then 
click on them to 
make them the 
tree’s focal point. 

Explore 
Build a family tree
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9 Plot your ancestors on a map
Open the Family menu for more analytical options – we 

particularly like the mapping tools found under ‘Places’. Select a 
place in the left-hand pane, then click the ‘Search’ button to try 
and locate it on the map. If no results are found, try refining your 
search terms or Googling the street address to see if there are any 
records about what happened to the street.

7 Family statistics
Once your tree is well established, packed with lots of 

information and photos, My Family Tree provides a number of 
useful tools for analysing and viewing it all. Start by clicking the 
‘Family data’ button in the right-hand pane. You’ll be shown a list 
of all individuals on the left, and some handy stats and graphs on 
the right. Select ‘Family > Statistics’ for even more useful stats.

5  Attach photos
Click ‘Back’, then click ‘Photos and story’ to upload photos of 

yourself, or ‘Attachments’ to link other files. Either drag them into 
the space provided, or click ‘Add > Scan new image’ to scan them 
in. Add as many as you like, then click one to add information 
such as date, title and caption. Select ‘Edit’ to view the photo’s 
properties and editor toolbar to make further changes.

10 And there’s more
With the basics covered, you can tap into more useful 

features: record free-form narratives about individuals in the 
‘Photos and Story’ section, or click ‘Genetics’ to record information 
including eye and hair colour. It’s also possible to switch the main 
view to a pedigree tree; click ‘Settings’ and choose ‘Ancestors tree’ 
to do so. Whatever your needs, My Family Tree has it covered. 

8  Generate reports
My Family Tree also provides a large collection of reports – 

click the ‘Reports’ menu to access them. Reports can be on a 
family, individual or topic, such as birthdays or places. Click the 
‘Preview’ button to see what it looks like, then click ‘Customise’ 
to refine it further by choosing which options to include or leave 
out. Click ‘Save’ to save it as a web page, or ‘Print’ to print it out.

6 Build your tree
Click ‘Back’, then click the arrow beside ‘Create relationship’ 

to choose the next person in your tree. This is typically someone 
related to you directly, but you can select ‘Unrelated’. Fill in their 
details and add photos as before. If they’re present in a photo 
you’ve already uploaded (say a wedding photo), you can edit the 
photo and use the ‘File tags’ field to link the photo to them.
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Set a Picture 
Password

“You don’t have to remember a complex password to 
log in to Windows. You can draw a series of gestures 
on a picture instead, even without a touchscreen.”

ave trouble remembering 
whether your high-security 
password goes 39*th@1 or 

39*th@l? Windows 8 offers a couple 
of ways to log in to your account 
securely, and one of them involves 
pictures. Choosing to use a picture 
password means you’ll be asked to 
sketch out a series of taps, lines or 
circles on a previously chosen picture, 
using either your mouse or gestures 
on a touchscreen.

It’s a security measure that has 
been criticised for being easy to 
guess – when faced with a picture 
containing three obvious circles, for 
example, the first thing an intruder is 
going to do is to try drawing a swirl 
over all of them. But with a bit of 
thought, the correct combination 
can be obscure enough to deter 
unauthorised entry to your system.

Windows uses the Pictures folder 
to source images, so make sure it’s 
well stocked before you begin.

1 Open Settings
To use a Picture Password, you need to find User Accounts 

Settings. This can be done in a number of ways. You can bring up 
the Charms bar by moving your mouse to the right-hand edge of 
the screen and pushing it up, then clicking ‘Settings > Change PC 
settings’. Alternatively, you can bring up the Start Screen and type 
users, or open the Control Panel and select ‘User accounts’.

2 Type your password
However you get there, once you’re in User Account 

Settings select ‘Create a picture password’ under Sign-in Options. 
You’ll need permission to change your account password, so you 
may have to talk nicely to whoever holds the Administrator 
account. Windows will also ask for your account password before 
it lets you choose a picture. Type this in and press [Enter].

H

Step-by-step Log on with a picture

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista

 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEN

SUITABLE FOR

10  minutes
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7 Sign in
Click or tap your account name to begin the signing in 

process as you normally would. The picture you chose in Step 3 
will appear, and you’ll be ready to input your gestures. It’s a bit 
easier to do with a touchscreen device than a mouse, but there’s 
not much in it, and with a bit of practice you’ll be logged in within 
seconds. It’s certainly faster than typing a complex password.

8 Remove the picture
Get the picture password wrong five times in a row and 

you’ll be asked for your alphanumeric password, so don’t forget 
it. If you ever want to disable the Picture Password and go back 
to the old-fashioned alternative, go to ‘User accounts > Sign-in 
options’, and click the ‘Remove’ button under Picture Password. 
The next time you log in, you’ll be asked to type your password. 

5 Input gestures – twice
Click or tap on the picture to register your gestures. A tap, 

which is a single point, can go anywhere. Lines can be dragged in 
any direction for any length, and circles can go in either direction. 
You’ve got three gestures to use, you so could draw a cross across 
the image with a tap or circle in the centre, for example. You’ll be 
asked to confirm the gestures before they’re finalised.

3 Choose a picture
Hit ‘Choose picture’ and the contents of your Pictures folder 

should appear. You can use the ‘Go up’ button to leave this folder 
and choose an image from anywhere on your PC. The choice of 
picture is important: an image with three parallel lines, for 
example, could be easily guessed unless you deliberately set out 
to confound potential PC intruders. We’ll use a picture of a bird.

6 Sign out
If you enter the gestures the same way again, Windows will 

congratulate you and you’ll see a ‘Finish’ button. Click it, and you’ll 
be returned to the User Settings screen. Nothing will change until 
you next log in, so hit the [Windows] key to bring up the Start 
screen, click your account name at the top right and select ‘Sign 
out’. You’ll soon be presented with the Windows logon screen.

4 Decide on gestures
The majestic bald eagle (this one’s name is Orion) offers a 

variety of potential gestures. We could draw a line along his beak, 
a circle around his eye, tap his nostril or go abstract and draw 
a series of lines and circles on the background – anyone trying 
to break in to the PC is unlikely to guess that, but there’s more 
chance we’ll forget where we put them when we need to log in.

Explore 
Set a Picture Password
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Write your  
first novel

“Plan your perfect story and then 
write it with the help of the free 
yWriter word processor.”

hen there’s a story in your 
head that you’re itching to 
commit to paper, you need 

yWriter. This is more than just a 
simple word processor; it’s a fully 
featured project management tool 
aimed at budding novelists. It 
provides everything you need to 
plot, structure and write your tale, 
including tools for managing your 
story’s characters, locations and 
objects, plus a handy set of note-
taking features.

yWriter divides your story 
into chapters, which are split into 
scenes. This lets you break each 
chapter down into manageable 
chunks that can then be rearranged 
at any time. You’re then provided 
with everything you need to write 
your story, complete with easy access 
to all that planning material to keep 
things consistent. All that’s left is for 
you to unleash your inner author. 
Read on to find out how…

1 Set up your project
Install yWriter from your free disc, then launch the program. 

Open the Project menu and choose ‘New Project Wizard’. Click 
‘Next’, then enter your project’s title. Click ‘Next’ and type your 
own name, then click ‘Next’ again. Now click the ‘…’ button to 
pick a suitable folder to save your project to. Once done, click 
‘Next’ followed by ‘Yes’ to create the folder. Finally, click ‘Finish’.

2 Create first chapter
Open the Chapter menu and choose ‘Create new chapter’. 

Change the title from Chapter 1 if required, then provide a brief 
description of what happens in the chapter. Ignore the Scene 
Summaries tab – this is read-only and filled automatically when 
you set up each scene. If your book is going to be split into 
sections, tick ‘This chapter begins a new section’ and click ‘OK’.

Step-by-step Plan, write and publish your novel

CHAPTERS
yWriter organises your 
story into chapters. Click 
one to select it, or double-
click it to rename it. 

PROJECT NOTES
Use this tab to 
record notes that 
apply to your whole 
story. You can also 
alter existing notes 
from here via the 
‘Edit’ button. 

W
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista

 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEN

SUITABLE FOR

25 minutes
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3 Set the first scene
Each chapter is broken down into individual scenes, which 

split your story into manageable bite-sized pieces that can easily 
be moved around. Open the Scene menu and choose ‘Create New 
Scene’ to open the main Scene editing window. First, choose a 
suitably descriptive title to help you identify the scene, then add a 
more detailed description beneath it – typically a brief synopsis.

4 Add characters
You’ll see a Viewpoint menu above the scene title – this 

allows you to choose the scene’s main protagonist. First, you need 
to create one or more characters. Click the ‘Add’ button to the 
right followed by ‘Add new’ when the new window appears. Start 
by giving the character a short name and indicating whether 
they’re minor or major, then fill in the rest of the Name tab.

Jargon buster!
 Autobackup

yWriter makes 
backups of your 
main project files 
once a day, but also 
backs up a scene 
each time it’s 
opened for editing. 
Access these via 
‘Tools > Backups’.

 Scene
The basic building 
blocks of your story, 
scenes are short 
passages of text 
that combine into 
chapters to form 
your story’s narrative.

 Storyboard
A graphical 
horizontal timeline 
view of your novel, 
organised by 
chapter, showing 
each character and 
the scenes in which 
they appear.

TOOLS MENU
You’ll find some handy 
project management 
tools here, including a 
storyboard function 
and access to previous 
story autobackups. 

SCENES
Each chapter is 
broken down into 
scenes. The selected 
chapter’s scenes are 
shown here. Double-
click one to edit it. 

SCENE SUMMARY
The selected scene’s 
content will be shown in 
this pane – the Content 
tab is read-only. To edit 
it, double-click the 
scene above. 

EDITABLE TABS
All other scene tabs 
– including Description, 
Characters, and Scene 
Notes – can all be 
edited from the main 
yWriter screen. 

Explore 
Write docs with yWriter
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9 Rearrange your story
One of yWriter’s strengths is the way it allows you to reorder 

your story – simply drag and drop scenes to move them around, 
or drag a scene to another chapter to move it to that chapter. 
Want to split a lengthy scene in two? Easy: simply type a # at the 
point you wish to break the scene in the Scene Editing window, 
then choose ‘Scene > Split scene on ‘#’’ to break it up.

7 Advanced scene tools
Check out the other tabs: Details records information like 

how long the scene is, or whether it’s a major plot or subplot. 
The Locations and Items tabs allow you to attach key places 
and objects to the scene (right-click under ‘Present in Scene’ 
and choose ‘New’) to help you keep track of what’s linked where. 
There are also tabs for scene-specific notes, photos and goals.

5  Complete character setup
If applicable, use the Bio tab to provide your character 

with a background. The Notes tab lets you record miscellaneous 
information about them, while the Goals tab lets you specify 
their motivation. The Picture tab lets you attach an image to the 
character – not really required unless you’ve based them on a real 
person and want a visual cue to help you describe them.

10 Keep writing – and publish!
Now you have all the tools in place to help you, there’s no 

excuse not to embark on the novel, memoir or travelogue that’s 
been rattling around in the back of your head. yWriter supports 
multiple projects too, so you can work on more than one story at 
once. Once it’s complete, choose ‘Project > Export Project’ to save 
it in your preferred format, including text, ebook and HTML. 

8  Review and update
Click ‘Save and Exit’ to return to the main screen where 

you’ll see a summary of the work you’ve done so far. Select a 
chapter from the left-hand column and all its scenes will appear in 
the right-hand pane. You’ll notice your scenes have a status. This is 
set to Outline by default, but you can change this by right-clicking 
the scene and choosing ‘Draft’, ‘Edit 1’, ‘Edit 2’ or ‘Done’.

6 Start writing
You can now start typing the scene into the Content tab’s 

text window. You’re supplied with some basic formatting tools, 
including a useful highlighter. Click the ‘Save’ button regularly 
to update your work. When you’re ready to move on to the next 
scene in your story, simply select ‘Scene > Add Scene (after 
current)’. You don’t need to finish your current scene first.
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“Planning a holiday online should be simple, but that’s not 
always the case when you have to hunt around for the best 
deals. Windows 8’s own Travel app is here to help.”

indows 8’s Travel app 
(incorporating Bing Travel’s 
search) enables you explore 

over 2,000 destinations through 
beautiful photos and 360-degree 
Bing Panoramas. Travel guides, 
booking tools, real time currency 
conversion and weather provide 
everything you need to turn travel 
inspiration into your next great trip. 

You can use it to find the perfect 
destination for your holiday, or look 
up information if you know where 
you want to go. Naturally, you can 
also get details on airports, hotels 
and restaurants, and even use it to 
book your air travel and make your 
hotel reservations. It’s been designed 
as a Modern app for Windows 8, and 
you’ll love how easy it is to browse 
through holiday details. It’s much less 
cluttered than most travel agents’ 
sites! Here’s a quick look at how to 
use Windows 8’s Travel app to map 
out your next trip.

1 Fire up the tile
From the Start screen in Windows 8, click or tap on the tile 

for Travel (which you can identify by its attractive destination 
picture). The Travel app will open to reveal the current featured 
destination as selected by MSN. Scroll to the right to discover 
more destinations, see panoramic photos of different locations 
and read various recommended travel articles.

2 Browse destinations
You can browse through the different featured destinations 

or search for a specific one if you’ve got something in mind. Here 
we’re planning a trip to Rome. In the search field in the top right 
of the app window, type Rome. Underneath the search field, 
‘Rome, Italy’ appears as the top suggested destination. This is 
what we want, so click on that destination result.

W

Step-by-step Plan your trip with Windows 8

Plan the perfect trip 
away with Bing Travel

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista

 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEN

SUITABLE FOR

20 minutes
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7 Book a hotel
To make a hotel reservation, click on the ‘Book from’ button. 

You’ll then be shown a list of websites where you can reserve your 
chosen room. Click one and, as before, a browser window will 
open showing the site of the hotel or agent you need. Depending 
on the site, you might be able to adjust your booking here and 
perhaps see offers that weren’t available in the app.

5 Book a flight
Enter your departure and return details, 

then click ‘Search flights’. You’ll see all the flights 
matching your dates, along with each one’s ticket 
price, airline, departure and arrival times, duration 
and so on. Click on a specific flight for more details. 
Click ‘Book’ if you wish to confirm the flight.

3 Destination details
The app displays details about Rome, 

including 360-degree panoramas. Scroll to the 
right to see the city introduction, a map, currency 
information, weather and a link to book a flight 
or hotel. Scroll to the far right to explore nearby 
destinations that may be of interest.

8 Have a great trip!
Now you’re all booked up and ready to go it’s time to 

get packing! Check out the 360-degree panoramas of your 
destination by scrolling along until you see ‘Panoramas’. Just click 
the left mouse button and move it around to get an amazing 
view. You can also check on the weather from the app. You’ll find 
the forecast next to the exchange rate, under the map. 

6 Find a hotel
Scroll to the right 

until you see the Hotels 
section (or click ‘Find hotels’ 
under the map on the left). 
Click ‘Find hotels’ and enter 
the check-in and check-out 
dates, the number of rooms 
and the number of guests. 
Click on ‘Search hotels’ and 
you’ll see all the suggested 
hotels matching your dates, 
along with price, rating and 
amenities. Click on a hotel 
to view more details.

4 Find flights
Click ‘Find Flights’, then click the ‘From’ field. 

The app asks if you want to turn on location services 
and allow Travel to use your IP address. In the ‘From’ 
field, click the round icon to let the app consider all 
airports in your vicinity, or delete the suggestion 
and type the name or code for your closest airport.

Jargon buster!
 Bing

Microsoft’s search 
engine and search 
services, which are 
all connected to 
each other.

 Bing Panorama
An interactive 
360-degree view of 
a location, made up 
from a series of real 
photographs.

 Tile
One of the large 
icons on Windows 
8’s Start screen.

Explore 
Plan the perfect trip
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Your guide Microsoft Remote Desktop

Connect to your PC 
using an iPad

“If you have an iPad, you can use it 
to access your desktop PC anywhere 
thanks to Microsoft Remote Desktop.”

sing an iPad, it’s 
possible to access your 
Windows PC thanks to a 

free app called Microsoft Remote 
Desktop. It’s like having a version 
of your PC running on your iPad, so 
you can get to all your files with 
ease, and even run programs.

For the app to work, you need 
to tweak a few settings in your 
version of Windows and have 
your iPad and Windows PC on 
the same wireless network. The 
app works with Windows 7 and 
Windows 8/8.1, but we’ve used 
Windows 7 here since it’s still 
the most popular version and the 
one you’re most likely running. 

U
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista

 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEN

SUITABLE FOR

20 minutes

Once you’ve tweaked a few of 
your system settings (which we’ll 
show you how to do here) you’re 
ready to use the app. You need to 
identify the computer you’re using, 
and ensure you have the username 

and password for your login handy. 
If you have an Administrator 
account then you will already have 
access, but if you’d like to give 
individual users of your PC access, 
you can do this as well.

ADD A CONECTION
At the top right of 
the screen is a + sign 
– tap here to open 
a new connection.

APP SETTINGS
The settings icon 
at the top left of 
the screen is used 
to administer user 
names, or to set 
up a gateway if 
required – see 
the walkthrough 
opposite for more.

HELP
Click the help icon at 
the top left to access 
Microsoft’s online 
support database 
for the iPad app. 
Obviously, you’ll 
need to have an 
internet connection.

YOUR DESKTOP
This is where the 
app keeps a 
collection of all the 
different desktop 
connections you’ve 
set up. This is handy 
if, for example, you 
want to connect 
to both work and 
home-based PCs.

DESKTOP SETTINGS
Tap and hold any of the 
desktop connections you’ve 
created to reveal a small cog 
icon, which is how you access 
its settings (or delete it).

IOS COMPATIBILITY
The remote app works on an iPad, but 
it’s also been optimised for use on an 
iPhone 5 or later, although you might 
find working on such a relatively small 
screen to be quite fiddly. 
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5 Time to connect
On your iPad, fire up the Microsoft Remote Connection app, 

and tap the + icon at the top right. Tap ‘Add PC or server’, and in 
the section PC Name, type in your IP address. Tap ‘Username > 
Add user account’ and type in your username and password. Head 
back to the home screen and tap the new desktop connection 
you’ve created. If all’s well, you can now control your PC remotely!

6 Troubleshooting
If you’re having difficulty, it could be due to Windows 

Firewall actively blocking remote connections. You’ll need to 
either turn your firewall off for now (remember to turn it back on 
after the session), or enable incoming connections in all profiles. 
Click ‘Start’, then type Windows Firewall. There are three profile 
settings; the quick fix is to make sure it is turned off in all three. 

Step-by-step Connect to your PC from your iPad

3 Set up users
If you want to log in as the system administrator using your 

iPad, there’s no reason to bother selecting which users have 
access. However, if you want other users of your PC to be able to 
log in as themselves, you can set this up now. Click ‘Select users’ 
then enter the names of the users in the box provided, and click 
on ‘Check names’ to make sure they are correct. Finally, click ‘OK’.

1 Download and install
Download the app from the App Store and open it on your 

iPad. Now it’s time to head to your Windows PC. You will need an 
Administrator account, or have administrative privileges, to make 
the necessary changes; if you’re the only user on your PC, this is 
likely to be the case by default. See http://bit.ly/ZrqcaS for more 
on this, and if necessary get the password for an admin account.

4 Find your IP address
There’s one more thing you need to know: your IP address. 

Click ‘Start > Control Panel > Network and Internet > Network and 
Sharing Centre’. You’ll see your current Wi-Fi connection listed in 
the active networks section. Click it, then click ‘Details’ in the box 
that pops up. Your IP address will be listed opposite ‘IPv4 Address’ 
– it will be something like 192.168.133.118. Write it down.

2 Tweak your settings
The first step is to allow remote connections on your PC. The 

instructions for Windows 8 vary slightly (http://bit.ly/1jGNCMX). 
Click ‘Start’, right-click ‘Computer’ and select ‘Properties > Remote 
settings’. Make sure the box ’Allow remote assistance connections 
to this computer’ is ticked and select the bottom option (’Allow 
connections only…’) in the Remote Desktop section.

Explore 
Access your PC with an iPad
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Back up with 
File History

“Windows 8 makes it incredibly 
easy to keep a running backup of 
your most precious data.”

ow often are you exhorted 
to regularly back up your 
data in case something goes 

wrong with your PC? And how often 
do you actually remember to do it? 

Fortunately, Windows 8 comes 
with an extremely handy built-in 
utility called File History that can take 
a lot of the pain out of the process. 
It automatically backs up the entire 
contents of all your Libraries to an 
external drive or USB stick every 
hour (using the default settings). 
If you ever want to recover an older 
version of a file, you can browse the 
backups by day and time to pinpoint 
the exact version you need.

Better yet, although File History is 
designed to work with an external 
drive, you can use File Sharing to 
‘fool’ it into working with a second 
internal hard drive, if you have one 
installed. Once it’s running you can 
pretty much forget about it – until 
you really need it, of course!

1 Plug it in
By default, File History uses an external drive. This can be a 

hard drive (perhaps the one you use for your normal backups) or 
a USB stick. If you opt for a stick, make sure it has plenty of free 
space: we recommend at least 8GB. Either way, make sure your 
drive is always plugged in (and powered on, if it’s external), or 
there’s no point in running File History in the first place!

2 Turn it on
From the Start screen, swipe in from the edge of the screen, 

select ‘Search’ and then type file history settings. You can do the 
same from the Windows 8 desktop by hitting the [Windows] key 
and typing file history settings into the search bar. Click the entry 
to open File History, then click ‘Select a drive.’ Choose one and 
that’s it – your Libraries are now being backed up automatically.

Step-by-step Protect your data

NERVE CENTRE
Go to ‘Control Panel 
> File History’ to 
access File History. 
When it’s running, 
you can see how 
much space is being 
used and the time of 
the last backup. 

GET IT ALL BACK
Click ‘Restore personal 
files’ to open the file 
browser (shown on 
the right) and scroll 
through your backups 
by date and time. 

KEEP IT SLIM
If you don’t want 
certain folders within 
a Library to be 
backed up – all your 
huge videos, for 
instance – you can 
exclude them here. 

DIGGING DEEPER
The Advanced settings 
enable you to change 
how often backups are 
made and how long you 
want them to be kept 
for, among other things. 

H
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3 When to save?
You can further tweak File History by going to ‘Control Panel 

> File History’ and clicking ‘Advanced settings’. Under ‘Versions’, 
you can choose how often to back up. In practice, setting this to 
‘Daily’ or ‘Every 12 hours’ probably gives the best balance between 
security, performance and space-saving. If you’re using a smaller 
USB drive, you might want to reduce the frequency of saves.

4 Caching in
If File History is unable to copy your data (if you’ve 

temporarily removed the backup drive, for example), it will still 
run, but will save the data to a temporary store on your main 
drive. As soon as File History can connect to your backup drive, 
this data is transferred. The setting ‘Size of offline cache’ specifies 
what proportion of your disk can be used for this purpose.

Jargon buster!

If File History can’t 
immediately back up 
files to your external 
drive (because it’s 
been disconnected, 
for instance), it 
temporarily stores 
the backup data in 
an offline cache, 
then transfers it 
whenever possible.

 Libraries
Windows 8’s way of 
virtually organising 
data such as music, 
pictures, videos and 
so on. Unlike a file 
folder, Libraries only 
‘point’ to data stored 
elsewhere, so they’re 
very flexible.

 External drive
File History will never 
allow you to back 
up to your main 
Windows drive 
as that would be 
pointless, so you’ll 
need an external 
drive for back-ups: 
either a hard disk or 
a (large) USB stick.

FIND THE FILE
Scroll through backup 
sets by date and time 
using these arrows, and 
restore the selected file 
to its original location 
with the big button. 

MOVING FILES
Click the cog if you 
want to restore a file to 
a different location. You 
can also search for files 
in the whole backup 
using the search box. 

Explore 
Use File History
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9 Protect and survive
In the left pane, click ‘System Protection’. Click the ‘System 

Protection’ tab, and then click ‘Create’. Ensure your Windows drive 
is selected, then click ‘Configure’. You can save system settings and 
data, or just data. Choose one then click ‘OK’, then ‘OK’ again in the 
System Properties box. Windows will now take regular snapshots 
of the drive, so you can roll back if something goes wrong.

7 Sharing openly
First, open the extra drive’s Properties page, then select the 

‘Sharing’ tab. Click ‘Advanced sharing’, then tick ‘Share this folder’. 
Click ‘Permissions’ and tick all the ‘Allow’ boxes. Close each box by 
clicking ‘OK’. Now, back in File History click ‘Add network location’ 
rather than ‘Select a drive’. Your extra internal disk will show up as 
a destination, so simply select it and proceed as normal.

5  Old news
In ‘Keep saved versions’, you can specify if and when to 

delete older backups. For instance, if this is set to ‘One month’, 
you’ll be able to see and restore back-up versions going back a 
month from the current date, but no earlier. Note the ‘Clean up 
versions’ option – here you can manually delete all versions older 
than a certain date, or all but the latest version.

10 Restore a previous version
Any time you want to restore an older version of a file, 

right-click it and select ‘Properties’, then the Previous Versions 
tab. Provided the file has changed since the last backup, all the 
versions that have been saved with restore points are shown 
in the list, and you can open it, copy it elsewhere, or restore the 
version to its original location. It might just come in handy! 

8  Backups in Windows 7
Windows 7 features a more primitive version of File History 

called Previous Versions, and it takes a bit of digging to make use 
of it. For Previous Versions to be available, you need to turn on 
Windows 7’s System Protection feature, which takes snapshots 
of your drive(s) at regular intervals. First, open the Start menu in 
Windows 7, right-click ‘Computer’ and click ‘Properties’.

6 A different drive
As we’ve said, File History doesn’t normally allow you to 

save to an internal disk drive, even if it’s an additional drive that 
doesn’t contain your Windows data, such as the M: drive shown 
here. One easy way around this is to set up the extra drive to 
be shared in Windows 8 so it can essentially act as a network 
connection, because File History does support networks.
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“Learn all about the Action Center – it’s your one 
stop shop for all system messages, warnings and 
updates within Windows 7.”

indows 7 is fast and 
reliable, but it’s not perfect. 
Programs and services can 

still silently crash in the background 
and bring the whole thing to a halt, 
losing work and data. The problem is, 
if we don’t know about these internal 
problems, we’ll always be at their 
mercy. As I’ve certainly discovered, 
saving my work doesn’t always 
ensure that it is committed to disk. 
It may only be sent to cache memory 
to await a larger disk write. Foul 
oaths and frustration follow.
Windows 7 does contain built-in help, 
however, in the form of the Windows 
7 Reliability Monitor. This little-
known utility has saved me more 
than once from an unstable system, 
and it can do the same for you by 
pinpointing exactly what’s gone 
wrong. It also gives you peace of 
mind that crashes and system 
foul-ups and driver issues, and not 
malware are causing your crashes.

1 Open Performance Monitor
The Windows 7 Performance Monitor is buried away in the 

depths of the Control Panel. To open it, first open the control 
panel from the Start button. Once running, click the ‘System 
and Security’ section. Inside, click the ‘Action Center’ group and 
expand the ‘Maintenance’ section that appears. Here you’ll find 
the option to view your PC’s reliability.

2 View Reliability History
Click ‘View Reliability History’. This creates a report using the 

reliability data Windows 7 has stored. The report takes a minute or 
so to compile and display. Towards the top you’ll see a graph that 
gives a simple indication of your computer’s overall reliability. 
Underneath that is a chart of the different kinds of problem that 
are keeping your PC from scoring a perfect 10.

W

Step-by-step Identify Windows 7 reliability issues

Investigate and improve 
Windows 7’s reliability

Anyone can do it 
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Tricky in parts
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7 Update troublesome drivers
It’s highly likely that as you step back through the reliability 

history you’ll find certain drivers that keep crashing. Sometimes 
these crashes can cause system instability. This can also happen 
with browser plug-ins – Adobe Flash Player is a particular 
favourite. If you’ve not updated such software recently, add it to 
your list of potential updates for later. 

5 Check for solutions
Windows can help solve issues by accessing 

its online database of previous problems. To seek 
out a possible answer, click ‘Check for a solution’ in 
the Action column of the relevant entry in the lower 
pane. There’s no guarantee that Windows can put 
things right itself, but it’s worth a try.

3 Weekly view
To get a fuller overview of system reliability, 

click the ‘Weeks’ option at the top of the screen. You 
can scroll back and forth over the weeks with the 
left and right arrow keys. To see the associated data, 
press [Enter] and a list of all the system problems 
the day or week contains appears in the lower pane.

8 Investigate info messages
Select an entry where there are blue ‘I’ symbols in the data. 

As well as telling you about failures and warnings, Windows 
Reliability Monitor also tells you about things that have gone well. 
You can see how the system and applications have been updated 
automatically. In many cases, these updates happen silently, so 
this is the only notification you have that they succeeded..

6 Windows Update 
problems

In order to keep your 
computer safe and secure, 
it’s essential that your 
installation of Windows is 
updated with the latest 
patches. This should happen 
without any input from you, 
but if the automatic update 
process fails, you usually 
don’t find out about it. 
Click on the weeks that are 
highlighted with a yellow 
warning triangle. Now 
look in the lower pane – are 
there any ‘Failed Windows 
Update’ entries? If so, make 
a note reminding yourself to 
update Windows manually 
later. It will take too long to 
do right now.

4 Event details
Critical events are ones that cause internal 

failures or complete operating system crashes. 
They’re listed in the top three ‘Failure’ lines of the 
data table under the graph. Click on weeks when 
these occurred to see what they were. Double-click 
on an entry to see the technical details.

Jargon buster!
 Service

Software that runs in 
the background and 
handles events that 
would disrupt your 
applications. 

 Reliability Monitor
Special recording 
software unique to 
Windows 7 that 
keeps a full history 
of updates, software 
reconfigurations and 
software failures, 
along with any 
other crashes and 
unexpected events.

 Anonymous report
A message about a 
software crash that’s 
sent to Microsoft.

Explore 
Master the Action Center
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13 Auto update applications
It’s possible that installed software can update itself. To test 

this, open the application you want to update. In this case, we’ll 
use Mozilla Firefox. Click the Firefox button and allow your cursor 
to rest on the Help menu. Select ‘About’. It’s usual for the About 
pane in many applications to either auto-update the software or 
to provide an update button

11 Check all solutions
If you just want to see if there are any available solutions 

to the collection of problems your computer has encountered 
to date, on the main Reliability Monitor screen click ‘Check for 
solutions to all problems’. Windows may need to send anonymous 
information to Microsoft to get solutions. If this is the case, click 
‘Send information’ to receive any available answers.

9  Show all problems
At the bottom of the screen, you’ll find the option to view 

all problem reports. This produces a long list of all the problems 
the operating system and installed software have encountered. 
You can sort this list by clicking a column title. You might find that 
an anonymous report has been sent to Microsoft to help the 
programmers concerned with system stability.

14 Update Windows manually
Finally, if you need to update Windows, it’s time to do so. 

Click the back button at the top left of the screen, then click 
‘Windows Update’ at the bottom left. Click ‘Install Updates’. 
You may have to reboot when this is complete. Check with 
Reliability Monitor regularly to see if there have been any failures 
– especially with Windows updates– to keep your PC healthy. 

12  Set crash settings
When a program fails, Windows automatically starts looking 

for a solution, but this isn’t always appropriate. Click the back 
button in Reliability Monitor and open the Maintenance section. 
Click ‘Settings’ to set the default behaviour when a program 
crashes. It’s best to check for solutions as you go, but you can 
have Windows ask you what to do when something crashes.

10 Identify available solutions
In the list of problem reports, you’ll see solutions listed 

for certain applications and drivers. Find one and right-click it, 
then select ‘View solution’. Windows Reliability Monitor accesses 
what’s known about the problem. It might provide instructions 
for you to follow, or it may give you a link that will let you 
download a more recent version of the application.
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Fix hardware 
problems

“Mastering Device Manager is the best 
way of xing hardware issues and making 
sure old drivers don’t cause problems.”

ach piece of hardware 
inside your PC needs 
a software component, so 

that Windows knows how to access 
and use it properly. This software 
element is known as a driver, and 
it handles everything from solving 
little problems with the hardware 
that have been spotted after it was 
manufactured, through to providing 
some funky capabilities for that 
device, like letting you assign 
functions to any extra buttons on 
your mouse, enabling visual effects 
on your webcam, or making sure 
that the latest games run properly 
on your graphics card. 

Handling all these drivers can be 
tricky, but Microsoft has created 
a handy tool to look after all the 
hardware in your machine and ensure 
there are no incompatibilities. That 
tool is the Device Manager, and I’m 
going to show you how to get the 
most from it. Let’s get started!

1 Launch Device Manager
There are several ways to access the Device Manager. The 

usual way is to click ‘Start > Control Panel’ and then, depending 
on your view, either select ‘Hardware and Sound > Device 
Manager’ or, if you have Control Panel showing the Classic View, 
select ‘Device Manager’ directly. You can also launch it from the 
Run command by typing mmc devmgmt.msc and hitting [Enter].

2 Find problem devices
The first thing you should do is get acquainted with Device 

Manager. It works in a similar way to Windows Explorer, with 
devices represented in a tree-like way, so you’ll find your webcam, 
if you have one, under the Imaging Devices tree. Have a look 
around and see if there are any devices that have any marks next 
to them, which generally shows there’s a problem or conflict.

Step-by-step Sort out hardware problems

CONFLICTS
If a device is causing a 
problem with another piece 
of hardware in your machine, 
then the conflicting device 
list under the Resource tab 
can be useful. 

CHANGES
The ‘Scan for hardware changes’ 
icon is mostly used when you’ve 
just uninstalled a device and want 
Windows to update its drivers. 
Simply click this and see which 
hardware devices are found. 
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3 Uninstall a device
If you spot a problem, the easiest way to fix it is to uninstall 

the driver that goes with it. Simply expand the tree to show the 
item you want to fix, right-click the item itself and then select 
‘Uninstall’ from the drop-down list. Don’t worry, this won’t do any 
serious harm, as the driver will still be available for that device and 
it’s easy to reinstall it, as we’ll see shortly.

4 Scan for changes
Device Manager will now redraw its display and, if that was 

the only device under that branch, it will disappear. Don’t worry 
though, to get it back, simply hit the ‘Scan for hardware changes’ 
button in the top button bar. This will check for new hardware, 
meaning it will find the device that you’ve just uninstalled and 
automatically try reinstalling the driver that you’ve just removed.

Jargon buster!
 Driver

The software 
component for a 
hardware device,  
which enables 
Windows to use that 
device. The driver is 
generally produced 
by the hardware 
manufacturer, but 
Microsoft also 
produces a lot of 
standard drivers

 Environment 
Variable
Windows uses The 
Registry to store 
most settings, but as 
the registry is so big 
and complicated  
for users, it makes 
sense to have  
some variables 
stored in this more 
accessible form.

 Resource tab
Hardware devices in 
your PCs need access 
to certain resources 
to run. These are 
listed under the 
Resources tab for 
each device in the 
Device Manager.  
You generally can’t 
change these, but 
any conflicts are 
listed here.

UNINSTALL
Uninstalling a device can be 
the easiest way of sorting out 
conflicts. Uninstall the device, 
then perform a scan to see if 
Windows can sort out the issue 
itself – most of the time it can.

UPDATE
You can right-click an 
entry to search for driver 
updates, or you can click 
this icon to perform the 
same job. Windows keeps 
most hardware up-to-date 
itself, but it’s worth trying 
this if you have a problem.

DISABLE
If you’ve got a problem with 
a device that you don’t use 
very often, then you might 
decide that you want to 
disable it. It’s not ideal, but 
it can mean your machine 
at least works.

Explore 
Fix hardware problems
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9 USB fun
Another tree that’s likely to contain an alarming number of 

entries is Universal Serial Bus controllers. Every USB stick you’ve 
ever plugged into your machine has its own driver stored here. 
Deleting these can reduce the time your PC takes to recognise a 
new USB stick, and also solves any problems you’ve had with USB 
drives. Use the [Delete] key to uninstall them quickly.

7 Show hidden devices
Start Device Manager as before. You probably won’t see any 

difference straight away. In order to see those missing devices, 
you have to select ‘Show hidden devices’ from the View menu. 
This usually just shows system devices that you wouldn’t normally 
touch, but thanks to our previous step, now shows devices that 
have been installed previously.

5  Update drivers
As the device is going to use the same driver, there’s 

a chance that this won’t solve the problem. The next stage 
therefore is to see if there’s a newer driver available for that 
device. After your scan, simply right-click the device in question 
and select ‘Update Driver Software’ from the drop-down list. Elect 
to search automatically and confirm that it’s fine to search online.

10 Job done
Well done, you’ve not only learned how to remove and 

update drivers that may be causing problems with your machine, 
but you’ve also seen how you can get rid of devices that you 
don’t even use anymore. This is great if you’ve had problems with 
some hardware in the past, but also means your machine can be 
quicker at recognising some devices that you plug in. 

8  Remove old devices
arch through the list of devices for items that you know you 

no longer use. This is particularly useful if you’ve upgraded your 
PC, but still have old peripheral entries visible. If you’re anything 
like us, you’ll have several mice listed under ‘Mice and other 
pointing devices’. Pick an item you know you no longer use, 
right-click it and select ‘Uninstall’ from the drop-down list.

6 Old conflicts
Device Manager can also show devices that aren’t currently 

connected. Close Device Manager first, then right-click ‘My 
Computer’, select ‘Properties’, click ‘Advanced system settings’ and 
select the ‘Environment Variable’ button. Under ‘System variable’, 
click the ‘New’ button. Enter a variable name of DEVMGR_SHOW_
NONPRESENT_DEVICES and set the Variable value to 1. 
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Discover music 
in Windows 8

“We have access to more music than 
ever before, and you can discover new 
tracks straight from the Start screen.”

treaming services such as 
Last.fm and Spotify have 
dominated the music scene 

over the last few years, but you don’t 
need one of those accounts to enjoy 
music streams in Windows. Xbox 
Music gives you access to millions of 
songs to stream completely free with 
Windows 8’s Music app and on the 
web at http://music.xbox.com. Search 
for any artist, song, or full album and 
instantly play what you want. You can 
even create and save playlists for 
easy access to the songs you love.

Xbox Music brings you all the 
music you love in one simple app. 
It’s easy to play and manage music 
from your personal collection and, of 
course, browse and buy songs from 
the Xbox Music store. As with Spotify, 
limits on free streaming apply. The 
Xbox Music Pass gives you ad-free 
streaming for £8.99/$9.99 per month, 
which is slightly more affordable than 
Spotify Premium.

1 Launch the Music app
Open the Windows 8 Start screen and find the Music app 

(an orange tile with headphones). If it doesn’t show up in your 
list of tiles, type the word music to search for it. Click the tile and 
you’ll launch the fullscreen Xbox Music app. You’ll see a welcome 
screen. If you have an Xbox account you’ll be prompted to log in, 
but you only need a Microsoft account to use the service though.

2 Find and play a track
On the left you’ll see the main navigation, and at the top 

is the search field. Just type the name of an artist or album and 
you’ll see suggestions appear. Press [Enter] to run the search, 
or choose from the list. You might be presented with several 
possible results, so choose one to see the artist’s discography, 
with their most recent albums listed first.

Step-by-step Discover music with Windows 8

SEARCH
Start by exploring an 
artist you know by 
typing their name 
in here. The app 
suggests artists held 
in its database as 
you type. 

PLAYLISTS
What made the digital 
jukebox popular was the 
ability to create personalised 
playlists. Click here to scour 
Xbox Music for tracks you 
would like to add. You can 
also import playlists from 
other programs. 
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3 Using playlists
Digital jukeboxes (and iTunes in particular) have made 

playlists essential for music lovers. They work here in the way you 
would expect. Select ‘New playlist’ from the left-hand side and 
then give the playlist a name. To add a song to your new playlist, 
return to the list of tracks by an artist, select a track and hit the ‘+’ 
button, then choose your playlist from the drop-down list.

4 Import playlists
Xbox Music also supports playlists created in iTunes or 

Windows Media Player, but not Spotify. Choose ‘Import playlist’ 
from the left-hand menu and you’ll then see a pop-up window 
asking you to import again. This process is automatic and you 
can’t choose which playlists to import. You can, however, delete 
any imported playlists you don’t want to keep.

Jargon buster!
 Playlist

Either a track list 
compiled by the user 
or one created by a 
program like Xbox 
Music or iTunes.

 DRM
Digital Rights 
Management is 
applied to digital 
music tracks to tie 
them into a specific 
store so that those 
tracks can only 
be played on the 
owners devices. 
DRM-free music 
enables users to 
put their music 
onto more devices 
and programs.

 Live tile
On the Windows 8 
Start screen, each 
Live tile displays a 
thumbnail image 
that alternates with 
the app’s icon. In 
Music, the Live tile 
for pinned playlists 
will feature an image 
of the artist.

COLLECTION
Downloaded music not 
subject to store-specific 
DRM will appear here. 
It’s common now for 
purchased CDs to come 
with a downloadable 
version that’s DRM-free. 

RADIO
Create playlists of music you’ll 
love by creating a radio station 
based around a chosen artist. 
Visit the ‘Now playing’ screen 
to see what’s coming up next 
on your station. 

EXPLORE
Click here to get the 
top picks from the 
Xbox Music app. 
New albums are 
highlighted for you 
and you can drill down 
to more useful picks 
by choosing ‘View 
genres’ on the right. 

NOW PLAYING
Whether you’re 
playing a song or 
album from Explore, 
or you’ve started a 
playlist or radio 
station, ‘Now playing’ 
will show you your 
traditional track list 
view to see what 
music is queued up. 

Explore 
Discover music in Windows 8
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9 Tweak the menu
There’s not a great deal you can do in the way of 

customisation within the Xbox Music app itself, but you 
can collapse the sidebar menu for a larger view of the main area. 
Simply click the three lines to the right of the words ‘Xbox Music’. 
Most settings are still available in the slimline menu, but the 
option to import playlists disappears.

7 Pin station to Start
If you really love the results of the radio station based 

on a particular artist, you can save the station as a tile in your 
Start screen for easy access in future. Right-click and choose ‘Pin 
to Start’. Then, on the Start screen you can left-click to play the 
station. You can right-click to unpin it, change the tile size or turn 
off the Live tile element (which updates its image).

5  Explore new music
The real fun in Xbox Music comes when you start to 

discover new tunes. This is done by through the Explore and 
Radio features. Explore is home to the Xbox Music picks from 
MSN. Here you’ll be introduced some of the most popular and 
highly rated songs and albums. Just click on one of the artist/
album covers to see full track listings and play the music.

10 Go Premium
As with Spotify, not all of the app’s features are available 

in the free version. Sign up for an Xbox Music Pass and you’ll get 
unlimited ad-free listening on all your Windows devices. You can 
also download music for offline listening and create playlists that 
automatically sync across all your devices. There’s a 30-day free 
trial available if you want to try it out before buying. 

8  The ‘Now playing’ screen 
The final option you’ll see listed in the left-hand menu is 

‘Now playing’, which is the place to visit whenever you have 
chosen a piece of music to listen to. This is where you’ll find the 
full track listings, which is especially useful for the Radio and 
Playlist options if you want to see what’s coming up, and go back 
to replay your favourite tracks.

6 Build a radio station
Just like Spotify’s radio feature, Xbox Music enables you to 

discover new music through related artists. Choose Radio from 
the left-hand menu and type an artist then hit [Enter]. Click the 
‘Play’ icon and a playlist will play based on that core artist you 
selected. You can’t actually see the list on this Radio view, instead 
you click on ‘Now playing’ in the left-hand menu.
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Use Microsoft’s 

s Microsoft’s own online storage offering, 
OneDrive joins the likes of Dropbox, Google 
Drive and BT Cloud in the scramble to get your 
files backed up in the cloud – that nebulous 
term for banks of storage racks humming 
away in a data centre... somewhere.

OneDrive has been through a couple of 
different incarnations since its launch in 2007. 
You might remember it as SkyDrive, which was 

its codename before it became available for beta-testing as 
Windows Live Folders. It became Windows Live SkyDrive very 
shortly after launch. The ‘Windows Live‘ part of the name 
was quietly dropped, and SkyDrive rumbled on through the 
launches of Windows 7 and 8 until 2013, when a case in the 
High Court in London determined that the name infringed 
BSkyB’s ‘Sky’ trademark. From these Murdoch-stoked ashes 
rose OneDrive, and that moniker has stuck.

Cloud storage is important for anyone who wants an 
off-site backup of important information they can’t afford to 
lose. This might be your accounts, irreplaceable photographs 
or home movies. OneDrive protects you against data loss by 
saving multiple copies across its servers, so if one fails there’s 
always another to take its place. Your data is hidden behind a 
password and two-step authorisation system (if you enable 
it) so only you can access it, and thanks to mobile apps, 
everything stored there can be at your fingertips wherever 
you are, on any device. You can think of OneDrive as an extra 
15GB of storage for your smartphone; the files from your PC 
can be delivered over its data connection with a few taps.

If you’re a Windows 8.1 user, you’ll find that OneDrive is 
built in, and if you use a Microsoft account to log in to your 
computer it will use OneDrive to sync your files and settings 
across multiple PCs. If you’re using an older version of 
Windows, there’s a desktop app that offers file syncing.

DRIVE

 THEM ALL



or Windows 8.1 users, 
OneDrive is transparent as 
long as you’re signed in with a 
Microsoft Account. Set it to 
run automatically in the 
background, backing up your 
documents and settings, and 

you’ll never even know it’s there. 
Bring up the Start screen, and start typing 

OneD... by the time you’ve got that far 
through its name, Windows will have 
displayed three options at the right of the 
screen: OneDrive itself, and two lots of 
settings. If you’re already signed in, it’s worth 
paying a trip to the settings to make sure 
you’re getting the most from the service.

Click on ‘OneDrive Storage Space’, and 
you’ll enter the part of the PC Settings app 
dedicated to OneDrive. First up is your free 
space. You get 15GB by default, although 
there are ways to expand this (see ‘Get more 
OneDrive storage’ on p62). That’s quite a lot 
of storage though, as you’re only going to 
use it for documents and data rather than 
for installing programs or operating systems. 

There’s only one option on this page 
(underneath the prominent ‘Buy more 
storage’ button), and that’s ‘Save documents 
to OneDrive by default’. It’s worth having 
this switched on so that all your documents 
go into the cloud as well as being stored 
locally on your hard drive. If you’ve got more 
than one Windows 8.1 PC, logging into 
them all with the same account means your 

ONEDRIVE IN WINDOWS 8.1

documents will be automatically synced 
between the computers, meaning you’ll 
never need to run upstairs to switch on the 
desktop computer to find a spreadsheet 
when you could be sitting in the garden 
with your laptop instead.

PC settings can also be synced between 
computers, including things like desktop 
icons and wallpaper, making it feel like all 
your computers are one computer and 
removing the need to make the same 
change on all your systems.

Click ‘Sync Settings’ on the right of the 
PC Settings app and you’ll see a long line 
of options with simple yes/no options.  
If you want your PCs to feel familiar, with 
no differences in wallpaper, Start screens 
or even things like mouse acceleration 
settings, then turn all these options to 
‘On’. The last one is especially interesting: 
‘Back up settings’ means that you can save 
all your PC settings to OneDrive without 
having them synced across multiple 
computers. You can restore the settings to 
your PC if you ever need to replace its hard 
drive, or reinstall the operating system 
for another reason, making your ‘new’ 
computer just like your old one.

Jumping back up one level, the option 
above Sync Settings is Camera Roll. This 
automatically uploads your pictures from 
your PC hard drive to OneDrive, and 15GB 
can hold a lot of photos. 

Once photo uploading is turned on, you 
can forget about it. Every time you save a 
new photograph to your PC, it will appear 
online a little later, depending on the speed 
of your internet connection. Once it’s there, 
it will also be available to any other PCs or 
devices you’re logged in to with the same 
Microsoft account.

Photo uploading also works the other 
way – images taken on your phone can be 
synced to your desktop PC without having 
to connect the two with a cable. This is 
where the final option in OneDrive’s settings 
comes into play: Metered Connections.

If you’re using Windows 8.1 on a tablet 
or laptop with a SIM card slot, you might 
not want uploaded photos running up 
your phone bill. Metered Connections gives 
you options for controlling this, allowing 
your device to synchronise settings, for 
example, while turning off photo or movie 
uploading while you’re using 3G.

SEARCHING WINDOWS

Microsoft hasn’t forgotten about 

the legions of users Windows 7 still 

commands. While the venerable 

operating system doesn’t have 

the full OneDrive functionality of 

Windows 8.1, there’s still an app you 

can download to gain at least some 

of the cloud backup features.

To get started with OneDrive, 

point your Windows 7 PC’s web 

browser to www.onedrive.com, 

where you can either sign in with an 

existing account or create a new one. 

You don’t have to do that yet though 

– just click ‘Get OneDrive on your 

devices’, then ‘Download OneDrive 

for Windows’ on the left-hand side. 

A setup file will download, which 

you can double-click to run, and the 

app will install. You’ll need to 

provide the app with account details 

and choose a location for the 

OneDrive folder on your hard drive. 

Any files you copy into this OneDrive 

folder will be mirrored on the 

OneDrive website, and any you 

upload from mobile devices will 

appear here once synchronisation 

has taken place. 

If you’ve got a lot of data stored 

in the cloud that you don’t want to 

appear on your hard drive, you can 

use OneDrive’s selective sync feature 

to limit what gets downloaded. 

Right-click the OneDrive icon in 

the notifications area, then select 

‘Settings > Choose Folder > Choose 

Folders’. Here you can decide which 

folders stay in the cloud, and which 

ones are synced for you to use.

Microsoft has made the cloud an integral part of its latest OS

WHAT ABOUT WINDOWS 7?
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ince 2010, Microsoft has 
offered a cut-down 
version of its Office suite 
that runs in your web 
browser and saves its files 
to OneDrive. Office Online 
is completely free to use, 

and for general word processing and 
light spreadsheet use, it’s the only 
office suite you’ll need (as long as 
you’re connected to the internet).

To use Office Online, head to www.
office.com and click the tile for the 
application you want to use. You might 
have to sign in with your Microsoft 
account if you haven’t already done so. 
You’ll be offered the choice between 
templates or a blank document, just as 
you would in the desktop version of 
Office, and the apps behave very like 
their full-fat cousins – the ones Microsoft 
would like you to pay for.

Office Online documents are saved in 
the Documents part of your OneDrive 
folder as ordinary files (.docx, .xslx, etc), 
just like the desktop equivalents would. 

OFFICE ONLINE GET FREE SPACE 
FROM MULTIPLE 
CLOUD SERVICES

BOX
Box has been around since 2005 
and currently offers 10GB with 

a free personal account. The size of 
each file, however, is limited to 250MB. 
This makes it less useful for archiving 
movie files, which can be very large. 
In comparison, OneDrive and Dropbox 
allow files up to 10GB each. You can 
expand Box to unlimited storage with 
a paid-for enterprise account.

iCLOUD
Apple recently expanded its 
online storage offering, with 5GB 

available for free and 20GB for 79p a 
month. If you’re an iPhone user you’ll 
already have an iCloud account attached 
to your Apple ID, but iCloud doesn’t 
work like other cloud storage offerings. 
There’s no simple folder syncing here, 
even through the Windows app.

AMAZON CLOUD DRIVE
Amazon offers 5GB for free and 
paid plans ranging from 20GB 

for £6 a year up to a whopping 1TB for 
£320 a year. Geared more toward photo 
and video backup rather than general 
file storage, Amazon offers apps for 
mobile devices, but documents other 
than photos and videos won’t appear 
on mobiles even if they’re in your drive. 
Only eight devices are allowed access to 
your account at any one time.

It’s Microsoft Of ce, in your web browser

OFFICE ONLINE 

This means you can write up a proposal 
and send it by email as a simple 
attachment to be opened on the 
recipient’s PC. And while it’s not made 
very clear, you can rename a file by 
clicking its name on the browser app’s 
blue header bar, so you don’t end up 
with lots of files just called ‘Document’.

There’s something else OneDrive 
can do that’s a little more clever. You 
can use it to embed documents into 
websites, making it easy to display 
information that can be edited in Office 
Online rather than tinkering with HTML. 

From your Office Online document, 
select ‘File’ (that’s Office Online’s File 
menu, not your web browser’s) then 
‘Share’. Hit the blue ‘Generate’ button, 
and you’ll be prompted to select a 
width for your document in pixels. 
When you’re happy, copy the code 
from the bottom of the window, and 
paste it into a page of your website. 
Your text, table, presentation or 
diagram will now be visible to anyone 
who visits your site.
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f This Then That (www.ifttt.com) is 
an extremely handy online service 
that can automate the interactions 
between other online services. 
This sounds like madness, but a 
simpler way of thinking about 
it is that, if you want, all the 
pictures you’re tagged in 

on Facebook can be saved 
directly to OneDrive. 

The service keeps running until you tell 
it to stop, so any pictures you’re tagged in 
future will be saved to OneDrive too, and 
from there appear on your hard drive.

IFTTT uses ‘recipes’ to do its work, and at 
the time of writing there were 643 available 
that make use of OneDrive, from saving all 

your Instagram photos to OneDrive, to 
Gmail attachments (useful for immediately 
opening Office documents in Office Online), 
to Bing’s image of the day. You can even 
save tracks from Soundcloud direct to 
OneDrive, if they’re available for download.

GET MORE ONEDRIVE STORAGE

Until the end of September 2014, any 

user who activated automatic picture 

uploading to OneDrive, would be 

rewarded with an extra 15GB of free 

space, for a total of 30GB. Sadly that’s 

now passed, but there are other ways 

you can boost its capacity.

Referring your friends is the easiest, 

and is free. On www.onedrive.com, 

click the Get more storage link at the 

bottom of the right-hand sidebar. You 

can earn a 500MB bounty for anyone 

who signs up for the service from one 

of your referral links – something that’s 

well worth having even though it 

might take a lot of friends to match the 

15GB of free capacity. 

The alternative is to pay for it. 

Extra storage can be bought from the 

OneDrive website, or through the 

OneDrive storage space app we looked 

at on page 60. Either way, the only 

way to access truly huge amounts of 

storage, enough to back up whole hard 

drives’ worth of data, is to pay for it, 

and this is likely to be the choice of 

the professional who can’t risk losing 

images, movies or audio data.

A terabyte of space will set you 

back £7.99 a month. It’s not a huge 

amount of money, and this includes a 

subscription to Office 365 for five users 

– each of whom gets the full 1TB. 

There are cheaper options available. 

£1.99 or £3.99 a month gets you 100GB 

or 200GB of storage space respectively 

(in addition to your free 15GB), but 

without the Office subscription.

IFTTT AND 
ONEDRIVE
Automate your cloud backups

SELECTIVE SYNC 
In Windows 8.1, you’ll notice 
that your OneDrive folder 

has a new column in the Details 
view: ‘Availability’. Right-click a file 
or folder, and the context-sensitive 
menu has new options: ‘Make 
available offline’, and ‘Make 
available online-only’. The former 
means the file is always downloaded, while the latter means 
it won’t be, but will be available from the OneDrive website.

VERSIONING
Shared documents are 
vulnerable to being 

overwritten, but OneDrive allows 
you to roll a file back to an earlier 
version, potentially saving hours of 
work. Head to www.onedrive.com 
and log in. Find the document in 
question, right-click it and select 
‘Version history’. The document will open in a new browser tab, 
with a sidebar that lets you see earlier saved versions of the file. 

TIPS AND TRICKS

If you’re looking for a really secure off-site 
backup plan, you could even use IFTTT to 
synchronise the contents of your OneDrive 
with another cloud storage system, such as 
Dropbox, mirroring your files between the 
two and knowing nothing will be lost.

FINAL FRONTIER 

AUTOMATED
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ENTERPRISE

neDrive for Business can be 
seen as a company’s fileserver, 
but online and accessible from 
anywhere. This enterprise 
version of OneDrive is 
fundamentally different to 
the consumer edition we’ve 

discussed in the rest of this feature, 
though. Although they’re both available 
under the same OneDrive banner, 
OneDrive for Business runs on Microsoft’s 
older Sharepoint application framework, 
first launched in 2001. In fact, if you search 
for OneDrive for Business on Wikipedia, 
you’re redirected to the Sharepoint article.

This means that if you use OneDrive 
for Business, you won’t be able to use the 
same username and password to log into 
a standard OneDrive account. The two 

services have different development 
histories and different ways of working. 

In general use, OneDrive for Business 
looks and acts just like the consumer 
version, with integration into Office Online 
and the desktop Office apps available as 
part of Office 365. Teams can collaborate 
on documents, with OneDrive for Business 
keeping files up to date across computers 
that aren’t necessarily all in the same 
building or connected to the same 
network, as long as they’re online. If you 
can’t connect to the internet, OneDrive 
for business will sync your documents as 
soon as you reestablish a connection.

OneDrive for Business is a powerful 
aspect of the service, which comes with a 
monthly fee for every user, but offers 1TB 
of storage for each one.

ONEDRIVE FOR 
BUSINESS
Those about to work, we salute you

RECYCLE BIN
If you’ve deleted something 
from OneDrive by mistake, 

head to www.onedrive.com and log 
in. On the left, near the bottom of 
the sidebar, you’ll see a link to the 
Recycle Bin, which behaves much 
like the one on the Windows 
desktop. Find the file in the list and 
right-click it, then select ‘Restore’ from the menu that appears. 
Your file should now be back in your OneDrive folder.

GET FREE SPACE 
FROM MULTIPLE 
CLOUD SERVICES

DROPBOX
Dropbox is a simple idea: a single 
folder on your PC that’s synced 

through the cloud and appears the same 
on every computer you sign into it on. 
There’s an app for most platforms – 
including mobile, where your files can 
be viewed and individually downloaded 
– but you only get 2GB of space for free. 
Upgrade options include 1TB of space 
for £7.99 a month.

GOOGLE DRIVE
 Google’s cloud service offers 
15GB of storage space for free, 

and is tied in to the Google Docs online 
office suite that works very much like 
Office Online. Your storage space is 
shared across Drive, your Gmail inbox 
and Google+ photos. Upgrade options 
span from 100GB for £1.25 a month all 
the way to 30TB for £190 a month.

BT CLOUD
If you’re a BT Broadband 
customers, BT Cloud is worth 

a look as it offers up to 50GB of free 
space, depending on your package, as 
a nice bonus on top of your monthly 
broadband payment. BT Cloud works 
through an app on desktop and mobile 
devices that lets you decide what it back 
up. Set it to watch your Documents 
folder, and anything that appears there 
is silently sent to the cloud.
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neDrive’s integration with 
other apps is one of its most 
powerful features. These 
apps come in two guises: 
those that use OneDrive 
as a storage area, allowing 
your data to appear on 
every device running 

the same program, and those that add 
OneDrive functionality to devices that 
otherwise wouldn’t have it.

To get OneDrive on your mobile device, 
head to the appropriate app store. For Apple 
devices that’s the iTunes App Store, where 
you’ll find a OneDrive app that’s designed 
for use on both iPhones and iPads. For 
Android phones and tablets there’s an app 
on Google Play, and Blackberry users will 
find one on Blackberry World. Windows 
Phone users can get it from Apps+Games 
if it’s not installed already, and Xbox One 
gamers can install OneDrive on their 
consoles. There’s even a plugin for the 
Chrome web browser you can install from 
the Web Store, but it seems to do little other 
than launch the OneDrive website. 

The website is a useful way of accessing 
files if you can’t install an app on the PC 
you’re using, as you can still upload and 
download the files you need manually. In 
this way, OneDrive becomes like a remote 
USB flash drive, allowing you to copy files 
and take them to another computer – as 
long as you’re connected to the internet.

The mobile apps work in a similar way. 
Because of the limited storage on mobile 
devices – 16GB isn’t an uncommon 
capacity, and many don’t have a microSD 
card slot to add more storage – syncing all 
your OneDrive files to them is impractical 
and could push up your phone bill if it’s 
using your mobile data connection. 

Unlike their desktop counterparts, mobile 
OneDrive apps display the contents of your 
OneDrive folders without immediately 
downloading their contents. You can 
browse your files, choose the ones you 
need, then save them to your phone, but 
any changes you make to them will not be 
saved and synced to your other computers 
unless you re-upload the file to OneDrive.

OneDrive offers automatic camera roll 
uploading for mobiles, something it has in 
common with other cloud services such as 
Dropbox. This means that if you take a snap 
with your phone camera it will upload to 
the cloud, and appear on your desktop PC 
the next time you switch it on, without you 
having to connect the two devices and 
copy the file over manually. 

Anyone reading the news recently will 
be aware of the ‘leak’ from Apple’s iCloud 
of intimate photographs of celebrities. 
OneDrive has some of the toughest terms 
and conditions of any cloud service. Content 
placed in OneDrive is monitored by 
Microsoft, and anything that contravenes 
the service’s code of conduct is subject 
to removal, and the account that placed it 
there can face being closed down.

Photos on OneDrive are scanned with 
Microsoft’s PhotoDNA tool, also used by 
Google and Facebook, and subject matter 
that contravenes the code of conduct 
includes nudity, and anything related to the 
purchasing of guns. This means celebrities’ 
nude selfies couldn’t leak from OneDrive, as 
in theory Microsoft would have removed 
them long before.

The second type of app is aware of 
OneDrive, and will sync its data through 
it across devices without you needing to 
set it manually. There’s a small but growing 
number of apps that support this 
functionality, including OneNote, which we 
discuss in greater depth below, 3D image 
visualisation app Cooliris and Genius Scan +, 
which uses your phone to scan documents 
and upload them to the cloud.

These apps often come with a desktop 
counterpart, so the OneDrive integration 
makes sense as you can view your work on 
a larger screen, and go on to share or even 
print your creation – perhaps incorporating 
it into a PowerPoint presentation that will, 
in turn, be saved back into OneDrive and 
shared with multiple recipients.

OneNote is an interesting app first released 

by Microsoft 10 years ago, but recently made 

available for free on many different platforms. 

In essence it’s a notebook, and indeed its saved 

files – placed in OneDrive – are referred to as 

such. It may look a little like a word processor, 

but OneNote allows you to save pictures, 

drawings and text anywhere you like on its 

pages. Just tap or click somewhere and start 

typing – or write with a stylus or finger.

OneNote comes into its own on tablet 

computers. Its functionality is built in to the 

Surface Pro 3, where clicking the Surface Pen 

will allow you to take a note even if the device 

has its screen locked. You can have it on your 

iPad and make a shopping list as you look 

through your kitchen cupboards that’s then 

synced to your Android phone ready for 

reading back when you’re at the supermarket. 

Or you can arrange pictures you’ve taken into 

the order you want, then view the arrangement 

on your desktop PC when you get home. 

Notebooks are also available in a web browser 

at www.onenote.com

It’s a powerful and convenient way to take 

notes, especially with a touch interface, and the 

OneDrive syncing means you’re never far away 

from your most recent to-do list.

TAKE NOTE OF ONENOTE

TEAMWORK 

APPS THAT WORK 
WITH ONEDRIVE
Gigabytes of cloud storage are no good unless you put them to use
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LISTEN UP

hile Microsoft, at the 
time of writing, has yet 
to announce a music 
streaming service that 
includes OneDrive, the 
functionality is there 
within its mobile apps. 

If you upload your 
legally acquired MP3s to a folder on 
OneDrive, taking careful note of the recent 
changes to the UK’s copyright laws, which 
came into effect in September, and then 
access the folder from one of SkyDrive’s 

he default location of your 
OneDrive folder is in C:/user/
name/, but you can move it 
to a more convenient location 
– perhaps on a larger hard drive 
if you’re running short of space. 

In Windows 8 or before, right 
click ‘OneDrive’ icon in the 

notification area, select ‘Settings’ and click 
on ‘Unlink OneDrive’. You’ll go through the 
same setup procedure you did when you 
first installed the app, and will have to wait 
until your files download from the internet 
into their new location before it’s finished.

In Windows 8.1, the process is different. 
OneDrive is a part of the OS itself, so you 
can move the folder just as you would 
something like the Documents folder. 

MEDIA STREAMING

MOVE YOUR 
ONEDRIVE FOLDER

Listen to music stored in your OneDrive account anywhere

Make Microsoft’s cloud storage work around you

mobile apps, you’ll find you can play the 
files from within the app on iOS, and using 
the built-in Sound Player app on Android. 

Of course, Microsoft has a full streaming 
music service called Xbox Music that you 
should probably use instead, since it’s free 
for the basic version. You can find out 
more about it on page 54 this issue.

You can also use the OneDrive website 
to play video files directly from your 
storage, as long as they’re in the MP4, 
QuickTime movie (.mov) or Apple video 
(.m4v) format.

Right-click the OneDrive folder in the 
right-hand sidebar of an Explorer window, 
and select ‘Properties’. From there click 
‘Location > Move’. Point the following 
window to the new location you want, 
and click ‘OK’. The folder is then moved, 
without having to redownload the files. 

SHARE A 
DOCUMENT 
FROM ONEDRIVE

CHOOSE TO SHARE
You can share documents and 
folders directly from OneDrive in 

Windows 8.1, and allow recipients 
to either read or edit them. From the 
desktop, locate the document you want 
to share and right-click it, then select 
‘Share’ and ‘OneDrive’ from the menu. 
Your web browser will open and load 
the OneDrive website, so you might 
need to log in.

ADD RECIPIENT
Once logged in, you’ll get a screen 
like this one. If using an operating 

system older than Windows 8.1, you 
can share the file from the website and 
get to the same stage. Enter the email 
address of the recipient, and type a 
message in the box if you want. An 
email with the message and a link to the 
document will be sent to the recipient.

SET PERMISSIONS
There are a couple of further 
options on the webpage, accessed 

by clicking the blue ‘Recipients can 
edit’ link. Here, you can choose whether 
your recipient can edit the document 
or merely read it – editing is useful for 
collaborating with workmates, but not 
ideal in every situation. Last is a toggle 
for whether or not the viewer needs to 
log in with a Microsoft account.

1

2

3

MOVE IT, MOVE IT

Christmas 2014  |    |  65

Feature
OneDrive



66  |    |  Christmas 2014

You can download the latest Windows 10 yourself, 
but before you do, find out what we think of it so far
By Mary Branscombe, Mayank Sharma,  
Dan Grabham and Graham Barlow

Hands on with

Windows 10

“We expect some new features to be 
added before its final release in 2015”

A
s a Windows user, we’re hoping 
you’ve heard of Windows 10 by 
now. If not, then it’s the next 

version of Windows; Microsoft is skipping 
Windows 9 entirely and going straight to 
10. It announced Windows 10 in October 
and made a Technical Preview version 
available to download the next day. The 
Technical Preview of Windows 10 doesn’t 
have every feature of the upcoming 
operating system, but Microsoft has 
revealed that over a million people are 
testing it anyway, and we’re among them.

“It’s been awesome to see so many 
of you joining the Windows Insider 
Program and letting us know what you 
think about the Windows 10 Technical 
Preview software,” Microsoft’s corporate 
vice president of operating systems Joe 

Belfiore wrote in a Windows blog post, 
celebrating the millionth download.

Here at Windows Help & Advice we’ve 
been getting stuck into the new operating 
system for a good few weeks now, and 
here we present our findings. You’ll find 
out what Windows 10 is really like to use, 
what we like and what we don’t.

To summarise, we think Windows 10 
is going to be a hit. It’s already won our 
hearts by combining the best bits of 
Windows 7 and 8, but perhaps the best 
news is that there’s more to come. We 
expect some new features to be added 
before its final release around summer 
2015, so look out for details of those in the 
pages of this magazine shortly.

In the meantime, let’s take a closer look 
at what Windows 10 has in store for you…
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Yes, the Start menu is back. Yes, there 
are virtual desktops. No, the Charms 
bar hasn’t gone away. And no, we 

don’t know precisely when Windows 10 
will be released or what it will cost. But 
we’ve seen the Technical Preview of the 
new operating system, and the word to 
bear in mind is ‘productivity’.

This isn’t the place to look for changes 
in Explorer or the Control Panel, let alone 
desktop tools like Paint and Notepad, 
or Store apps like Music and Video. 
The Technical Preview is about the core 
features that are supposed to prove 
Microsoft can balance touch, mouse 

and keyboard input without making any 
users feel abandoned.

Boot it up!
There are profound differences between 
Windows 8.1 and Windows 10, even in this 
early technical preview. For starters, the 
installation process has been streamlined. 
You can get through the entire process 
without creating a local account on your 
machine and instead authenticate via 
your existing Microsoft account. We also 
like the ability to setup and configure 
sync settings for Microsoft’s OneDrive file 
hosting service from the installation itself.

 Unlike Windows 8/8.1, Windows 10 
boots straight into a traditional looking 
desktop. This contains all the elements 
you’d expect, with icons on the desktop 
and a taskbar at the bottom and a fully 
functional Start menu. As expected, 
the Start menu is the default if you use 
Windows 10 with a keyboard and mouse, 
but you can keep the full-screen Start 
screen if you prefer it. Even on the Start 
menu, you can pin Live tiles in multiple 
sizes on the right, but on the left you also 
get the familiar list of pinned and recent 
apps, with jump lists for files, the search 
box (which you can also use to run typed 
commands), and a power button for 
shutting down or restarting your PC.

The search box has all the Windows 8 
features, including results from Bing and 
the Windows store, and a separate Search 
menu next to the Start button gives you 
trending topics directly from Bing, too.

You can resize the Start menu, although 
you can only drag to change the height; 
changing the width means picking a 
separate setting. This is more familiar for 
mouse and keyboard users, but it remains 
to be seen whether Windows 8 users who 
like touch will find it a step backwards.

Snaps, apps and desktops
You can still use [Alt]+[Tab] to move 
between open windows. As in Windows 
8.1, these now include any modern apps 
you have running, and those now open as 
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The new Start menu contains 

elements of the familiar 

Windows 8 Start screen

You can customise the new  

Start menu in various ways

Hands on with Windows 10
Microsoft tries to strike a balance for every kind of user



The user icon at the top of the Start menu makes 

it easy to lock your PC or sign out of Windows

windows on the desktop like any other 
software you’re running, ready to be 
resized or snapped side-by-side. The new 
Task View button on the Taskbar is there 
to introduce the idea of moving between 
windows to the many Windows users who 
have never tried [Alt]+[Tab].

There are many more ways to snap 
windows than there were in Windows 8. 
If you have a narrow window, the second 
one can take up all the rest of the space, 
or you can snap four apps, one in each 
corner. Windows even shows thumbnails 
of open windows to help you pick one to 
snap without rearranging everything.

The [Windows]+[Tab] keyboard shortcut 
now gives you a view that’s the same as 
[Alt]+[Tab], except for a button at the 
bottom for adding virtual desktops, and 
the list of desktops you already have 
open. You can use your mouse to pick the 
set of windows you want to put on screen, 
and the window you want to start using.

Virtual desktops aren’t new, but they 
never graduated from a utility to a main 
Windows feature because they can be 
confusing to manage. There’s a subtle 
clue in the Taskbar to help you; if an app 
is open but not in the current desktop, it 
is underlined rather than outlined, and if 
you click on its icon you go straight to it 
and the rest of that desktop. It remains to 
be seen whether that’s enough to avoid 
confusion, but it certainly signals that 
Microsoft has power users in mind.

Works like a charm
Despite rumours, the Charms bar hasn’t 
gone away, but you might not see it when 
you use the [Windows]+[C] shortcut. If 
you have a mouse and keyboard and the 
window that’s active is a modern app like 

the Windows Store, that shortcut brings 
up a mini Charms menu hanging off the 
top left corner of the app instead.

This has the three dots that give you 
any relevant extra commands (labelled 
as App Commands). These include the 
Search, Share and Settings charms that are 
usually on the Charms bar, other useful 
commands like Play, Print and Project, plus 
the option of running the app full screen. 
If you can’t print from the app, the Print 
charm on the menu is greyed out.

That makes the Charms less touch-
friendly, but much more mouse-friendly 
when you’re controlling an app. That’s 
exactly what users without touchscreens 
want; moving all the way over to the side 
of the screen and all the way back isn’t 
efficient with a mouse. When you’re 
controlling Windows – which is what you 
get when you don’t have a modern app 
selected – having the Charms and settings 
bar at the side of the screen is fairly 
logical. And those Charms are staying 
around (although probably in a different 
arrangement with a more logical division 
of what shows up where) because when 

the Windows team took tried taking them 
out, users at Microsoft complained loudly. 
That big, friendly sidebar for choosing and 
changing Wi-Fi options turned out to be 
really handy and surprisingly popular.

This is the Windows 10 experience in 
microcosm. Microsoft is trying to keep the 
bits of the modern interface that people 
like and find useful, but not have them be 
annoying and intrusive when mouse users 
are getting things done.

The command prompt
At the other extreme from Charms is the 
command prompt, where you go to run 
scripts and batch files. In recent years 
the emphasis has been on the far more 
powerful PowerShell automation system, 
but in the spirit of ‘no feature left behind’, 
the humble command line is getting 
the same harmonisation as the rest of 
Windows 10. You can finally use keyboard 
shortcuts to select a line or a word at a 
time, and to copy and paste text.

Only a tiny fraction of Windows users 
may ever use the command line, but 
Microsoft wants them to be happy as 
well, and this is the kind of modernisation 
that’s a decade overdue.

New tools
Some of the most interesting features for 
business aren’t visible in the Technical 
Preview. These include the ability to 
upgrade PCs using management tools, 
and manage them through the same 
Mobile Device Management systems used 
for smartphones and tablets. There will 
also be an enterprise app store that lets 
businesses manage volume licences for 
modern apps instead of making users sign 
in to a work PC with a personal Microsoft 
account, and separation of personal and 
business data using encrypted containers. 
These features will appeal to businesses, 
but they can’t try them out until the 
previews of Windows Server and the 
necessary management tools come along.

Integrated Internet Explorer
The preview of Windows 10 only includes 
a desktop version of Internet Explorer, 
and it’s not a new one; future updates to 
the web browser are coming out on their 
own schedule. That doesn’t necessarily 
mean the immersive version of Internet 
Explorer is going away, but it doesn’t 
make sense to have a separate, full-screen 
browser when all the modern apps are 
now just windows on the desktop.

We don’t know what changes there will 
be to the IE interface, and the Windows 
team hasn’t yet decided how to handle 
the different modes of the browser. 
Having a plugin-free version of the 
browser is definitely a real security 
advantage, but unless it’s immediately 
obvious how to switch between them 
people will get annoyed and confused. 
Getting challenges like this right without 
abandoning the benefits of Windows 8 is 
where Windows 10 will succeed or fail.
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Hands on
 Using Windows 10

Pin favourite apps  

or contacts on the right  

side of the Start menu

Access frequently  

used programs  

and files easily
EARLY VERDICT
Windows 10 is all about balancing the 

demands of different people. It’s not just 

business users with desktop PCs and 

keyboards versus tablet users. Windows 

is for sensors and data centres, phones, 

the Xbox One, tablets, laptops, desktop 

PCs, giant wall screens and everything 

in between. What we’re seeing in 

this first Technical Preview release is 

very much about balancing the heritage 

of two decades on Windows with the 

new world of touch, and with making IT 

teams comfortable with the BYOD and 

consumer-focused features introduced in 

Windows 8 by giving them more security 

and management options.

At the preview event there wasn’t a 

touchscreen in sight and we only got 

to use Windows 10 with a mouse and 

keyboard on a big screen that takes full 

advantage of the new ways of arranging 

windows and swapping between virtual 

desktops. The Technical Preview is 

designed to make power users happy, 

not change the world.



The Start menu has been given a Live 
tile makeover, and you can now pin 
whatever you want to the panel on 

the right. So, just like on Windows Phone, 
you can pin a favourite contact or app for 
easy access. Live tiles are dynamic, so they 
can show the latest news for your current 
location for example. You could also pin a 
folder you use regularly; it’s up to you.

The left-hand side of the Start menu 
works like the old Windows 7 one, so you 
can search for whatever you want and 
launch it using the [Enter] key on your 
keyboard. You can see recently accessed 
programs and browse through other 
programs too, via an All Apps menu.

The All Apps option now features a 
vertical scrollbar, so there’s no stacking of 
multiple menus. As with Windows 7 and 8, 
however, the best way to find anything is 
to search rather than browse for it.

By restoring the Start menu, Microsoft 
is acknowledging that Windows 8 went 
too far for some users, especially in the 
corporate space. But those Modern UI 
apps (now referred to as Universal apps) 
still provide the link with touchscreens.

New layout
The top of the Start menu contains your 
account icon, so you can lock your PC, 
change your account picture or sign out. 
Another power button enables you to 
sleep, shut down or restart your PC.

A panel underneath provides access 
to your files, as well as shortcuts to your 
Libraries. An arrow beside the File Explorer 
icon in the Start menu shows your most 
recently accessed folders for quick access.

As in Windows 8.1 you can right-click 
on the Start button to get a ‘power menu’ 
with quick access to the Control Panel and 
other advanced features such as Run, Disk 
Management and the Task Manager.

One big change is that you can now 
resize the menu. This doesn’t work that 
well at the moment, as you can only make 
it flatter (more of a horizontal bar) or taller. 
You can’t freely resize it to form a smaller 
version of the now-old Start screen.

Right-clicking an item in the Start menu 
brings up other options, such as pinning it 
to the Taskbar, removing it from the menu 
or, if appropriate, removing it from your 
PC. As with the Windows 8 Start screen, 
you can drag tiles to rearrange them.

You can also turn off individual Live 
tiles and change their size. Small, Medium, 
Wide and Large are the sizes available.

Right-clicking a blank space in the 
menu gives you two other options: 
‘Personalize’ and ‘Properties’. The first 
of these is currently about as useful as a 
chocolate teapot – it just takes you to a 
subset of the Control Panel that gives you 
a few colour options to choose from.

Selecting ‘Properties’ takes you to the 
Taskbar and Start menu Properties app 

in Control Panel. Strangely, you’re sent to 
the Taskbar tab by default. Clicking on the 
‘Start menu’ tab shows you a few options, 
the top of which is a box labelled ‘Use the 
Start menu instead of the Start screen’. 

Some other options concern privacy for 
shared user accounts – you can clear the 
personal information from your Live tiles, 
as well as options to choose not to ‘store 
and display’ recently opened programs in 
the Start menu.

Deep customisation
A ‘Customize’ option provides more 
granular control over what is shown in 
the Start menu as well as behavioural 
characteristics such as whether sub-
menus open automatically when you 
hover over them, or whether dragging 
and dropping is allowed (both of these are 
permitted by default).

You can also choose to show system 
administrative tools in the menu, plus the 
Control Panel, This PC (formerly known as 
My Computer), your personal user folder 
or your music and video folders should 
you wish. It’s all very customisable.

Whatever you think of the new Start 
menu, one thing is for sure – it makes 
Microsoft’s insistence on not even 
having a Start button in Windows 8 seem 
ridiculous. Just think about it; Microsoft 
missed out the button’s raison d’être for 
a whole version.
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The Start menu makes a 

welcome return in Windows 10

A closer look at the 
Windows 10 Start menu



Windows 10 Technical Preview is here. 
Despite Microsoft calling it a ‘moving 
target’, you can install and use it (at your 
own risk), and many of its features do 
work well. Here’s your guide to installing 
the Technical Preview and using it safely. 
Expect to see it evolve over time, as 
Microsoft has promised regular updates.

1 It’s for experts
Don’t install it if you don’t know 

what an ISO file is, or you don’t have a 
separate PC to install it on. Microsoft is 
stressing that without that knowledge, 
you won’t get on very well. This is 
extreme pre-release software. It will 
have bugs in it. It will probably crash. 
It might change. Things might not work. 
In short, don’t depend on it!

2 You need to prepare 
As well as that second PC, you need 

to do a few things in preparation. The 
main one is to back up any data stored 
on the hard drive. If you are intending 
to install it on a PC you use regularly, 
you might like to think again. If you 
didn’t use Windows 8.1, there might be 
issues with compatibility, so check the 
Compatibility Center first (http://bit.
ly/1oRG4dz).

3 You need to sign up
Once you’ve done that, you’ll need 

to sign up for the Windows Insider 
Program ( https://insider.windows.com). 
Specifically, you need to agree to the 
terms and conditions that don’t hold 
Microsoft responsible if you’re silly 
enough to install it on a PC that contains 
important files that you haven’t backed 
up. Your Windows 10 install will receive 
regular updates, and there’s a chance 
your data might be lost.

4 The download is around 4GB
The ISO files for Windows 10 are 

around 4GB, but the exact size depends 
on which version you download – 

INSTALLING THE WINDOWS 10 TECHNICAL PREVIEW?  
HERE ARE 12 ESSENTIAL THINGS YOU SHOULD KNOW

there are 32- and 64-bit versions of 
several different language versions. The 
Windows 10 key is NKJFK-GPHP7-G8C3J-
P6JXR-HQRJR. If you want an enterprise 
version, head to http://bit.ly/1qiL9eG 
to download Windows 10 Technical 
Preview for Enterprise. 

You will need a DVD or USB drive  
large enough to hold a 4GB ISO file, and 
to download one of the Windows 10  
ISO files if you’re installing it on a clean  
PC. We recommend a tool like Rufus  
(http://rufus.akeo.ie) or ImgBurn  
(www.imgburn.com) to copy the ISO.

5 It has a limited shelf life
Your Windows 10 installation will stop 

working on 15 April 2015. Windows 10 
almost certainly won’t be released then, 
but we may well see a beta of the OS to 
replace your Technical Preview install. 
Microsoft will remind users to upgrade 
after April 1 2015.

6You can install it directly on a 
Windows 8.1 PC

If you’re installing it from Windows 8.1 
you can simply mount the ISO and 
execute setup.exe. If you’re installing it 
from an older version, you can run setup.
exe from the USB drive you created from 
the ISO. Double-tap or double-click 
‘setup.exe’, then follow the steps.

7 You can keep your files (probably)
If you’re upgrading from Windows 8.1 

or Windows 8 you can keep Windows 
settings, personal files, and most apps. 
If you’re upgrading from Windows 7 you 
can keep Windows settings, personal 
files, and most apps. If you previously 
ran Windows Vista you must perform a 
clean install and can keep nothing. Sorry, 
Microsoft doesn’t like Vista any more.

8 You don’t need a very powerful PC
If your PC can run Windows 8.1, it can 

also run Windows 10 Technical Preview. 
You need a 1GHz or faster processor with 

1GB of memory for 32-bit, or 2GB for 
64-bit. You’ll also need at least 16GB of 
free hard drive space. The Technical 
Preview won’t work on Windows RT 8.1 
and Windows N editions.

9 There are limited features for touch
The Technical Preview works with 

touch, but “some things will be rough 
and unfinished” says Microsoft. The 
corporation is working on improvements 
for the OS to work with touch.

10 You’ll need to reinstall any 
language packs you use

If you’re running Windows 8.1, Windows 
8, or Windows 7 and have installed a 
language pack or a they’ll be removed 
when you install Technical Preview. You’ll 
see a message telling you to re-add them.

11You can’t go back
You won’t be able to use your 

recovery partition to downgrade from 
Windows 10 to Windows 8.1 or similar. 
If you have a recovery partition on your 
system, it will no longer be able to restore 
your computer to the version of Windows 
you had before. And, as you’d expect 
from a system with no recovery partition, 
you’ll need to install a previous version of 
Windows from a DVD or USB drive when 
it comes to overwriting or wiping your 
Windows 10 install.

12Using a virtual machine could be 
the safest way to try it

You can use something like VirtualBox 
(www.virtualbox.org) to install Windows 
10 as a virtual machine. Simply click 
the ‘New’ button in the main window 
to create a new machine, then give it 
a name (you’ll need to choose the 
‘Windows 8.’1 option). When finished, 
go to ‘Storage’ in the left sidebar, and 
next to Controller: IDE, select the ‘Add 
CD’ button. Click or tap ‘Choose disk’ and 
select the Windows 10 ISO. And there you 
have it – Windows 10 in a virtual machine.

If you’re not comfortable with 

using advanced features, wait 

until the full version is released

You can’t easily roll back to your  

old operating system once you’ve 

installed the Technical Preview
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During Microsoft’s Windows 10 
launch event, one thing became 
clear: it is desperate to banish the 

dual-interface confusion that Windows 8 
created. However, with the move to a 
more unified interface, we can’t help but 
feel like Microsoft is turning a little against 
touch with this release. Could Microsoft 
yet reveal a tablet version of Windows 
Phone 10? It’s possible, but looks unlikely.

As Microsoft’s Terry Myerson says: 
“Windows 10 will run across an incredibly 
broad set of devices – from the Internet 
of Things, to servers in enterprise data 
centres worldwide. Some of these devices 
have 4-inch screens, some have 80-inch 
screens, and some don’t have screens 
at all. Some of these devices you hold 
in your hand, others are 10 feet away. 
Some of these devices you primarily 
use touch/pen, others mouse/keyboard, 
others controller/gesture – and some 
devices can switch between input types.”

Continuum is key
That’s why the new Continuum feature 
is key to the success of Windows 10 – the 
operating system’s ability to adapt its 
interface depending on the type of input 
and display it’s attached to. It’s a very 
Apple-style feature in name and function, 
and should bridge the gaps between the 
diverse community of Windows devices.

As we’ve said, Microsoft is trying to 
strike a balance for every kind of user with 

Windows 10. And that includes business 
and enterprise. The preview event was 
designed specifically to signpost Windows 
10 for these types of users, some of whom 
are persevering with the non-supported 
Windows XP while others wonder where 
they will go after Windows 7.

There were some interesting 
developments for those users, especially 
around device management and the 
ability to customise enterprise app stores 
and ensure that personal and corporate 
data don’t mix. But the event didn’t go 
that heavy on the detail so enterprises 
will certainly need to check out Windows 
10 and its associated tools themselves.

One important benefit is that 
businesses will be able to choose between 
Windows Group Policy and Mobile Device 
Management (MDM) for the management 
and deployment of all Windows devices. 
That includes the management of what 
users do with their data, which is great 
news as the bring your own device (BYOD) 
culture spreading throughout businesses 
is leaking data left, right and centre.

Apps for all
Developers have a lot to celebrate with 
Windows 10’s Universal apps. There 
will be one app store across all devices 
including mobile and Xbox and apps 
will run on all sizes of device and in all 
environments. Apps will update across all 
devices and be simpler to administrate.

Right now, Windows 10 doesn’t feel 
particularly different to Windows 8.1 
for consumers. Yes, the new Start Menu 
should assuage some users coming from 
Windows XP and Windows 7, but there 
is precious little polish in the Technical 
Preview build. That’s okay – Microsoft has 
two thirds of a year to add all that in.

Microsoft cites 14 per cent growth in 
shipments of enterprise PCs during the 
first half of 2014 alongside a rise in 
enterprise tablet shipments of 33 per 
cent, and those are the users Microsoft 
desperately wants to target with this new 
OS as it endeavours to persuade them 
away from older products. Microsoft is 
not only offering a Technical Preview of 
the OS itself, but is also releasing Technical 
Previews of Windows Server and its 
management tools, too.

So does Windows 10 mean the 
operating system is getting back on 
track? Probably. But Microsoft has a big 
challenge in persuading people that it is 
serious about Windows 10 as a corporate 
tool as well as something that consumers 
should want to upgrade to, whether 
they’re converts to Windows 8 or they 
resolutely stuck with Windows 7.

And that’s before you mention the 
millions of people still persevering with 
Windows XP – the operating system that 
simply won’t die. Truth be told, Microsoft 
still needs to bridge the gap back to all 
those people, too. 

A new beginning
Microsoft needs to persuade everyone it’s time to upgrade

Microsoft hopes the changes 

it’s making in Windows 10  

will appeal to businesses



TERMS AND CONDITIONS Europe and RoW have no set newsstand prices therefore we cannot advertise the specific savings 
you will make. All customers will be charged in GBP. This offer is for new overseas print subscribers only. You will receive 13 
issues a year. If you are dissatisfied in any way you can write to us or call us to cancel your subscription at any time and we will 
refund you for all unmailed issues. Prices correct at point of print and subject to change. For full terms and conditions please 
visit www.myfavouritemagazines.co.uk/terms. Offer ends 23 December 2014.

INTERNATIONAL  
READERS CAN  
SUBSCRIBE TOO!

WHY SUBSCRIBE? 
  Stop paying overseas cover prices  
and save yourself money
  Never miss another issue
  All 13 issues a year will be delivered direct to 
your home or workplace by airmail

Don’t wait for the latest issue to 
reach your local store – subscribe 
today and let Windows Help & 
Advice come straight to you

TO SUBSCRIBE
  Live in Europe?  
Pay £71.99 a year for 13 issues 
  Live in the USA?  
Pay just £77.49 a year for 13 issues 
  Live elsewhere?   
Pay just £80.99 a year for 13 issues  

Contact centre opening times are: 8am to 9.30pm weekdays, 8am to 4pm on Saturdays

TO SUBSCRIBE GO TO 
www.myfavouritemagazines.co.uk/WOMP2N

Or call our helpline on ( 44) (0)1604 251045  
and quote ‘WOMP2N’

Christmas 2014  |    |  73

http://www.myfavouritemagazines.co.uk/terms
http://www.myfavouritemagazines.co.uk/WOMP2N


 WINDOWS HELP  HARDWARE FIXES  SOFTWARE SOLUTIONS  INTERNET TIPS

Data recovery
CAN’T ACCESS DATA  
ON EXTERNAL DRIVE 

Q My Samsung D3 Station  
3TB hard drive suddenly 

stopped working recently, and 
is now refusing to power up, 
never mind show up in Windows. 
Unfortunately, I’ve got a lot of 
important data on there that I need 
to recover. Can you tell me how to 
get it back?
Graeme Porter

Graham’s solution
Returning the drive to 
Samsung won’t get your 
data back, but if you 

can manage to open the enclosure 
(see www.bit.ly/d3-disassemble 
for a guide) without voiding your 
warranty, you’ll probably find that 
it’s only the enclosure that’s failed, 
not the actual drive.

First, you need to connect the 
drive back to your PC. If you have 
the space and spare SATA data and 

power cables, you could connect it 
internally. Alternatively, you could 
try a device like the Plugable 
USB3-SATA Docking Station (around 
£28/$24 from Amazon). Hook this 
up and your drive should be visible 
in Windows again.

However, although you can now 
see the drive on your PC, you won’t 
be able to access it. Windows won’t 
let you open any partitions, and 
they will appear to be much smaller 
than they actually are. That’s 
because of the way drives larger 
than 2.2TB are set up to be visible 
to older versions of Windows.

From here, however, recovering 
data from the drive is mercifully 
simple. First, download and run 
DMDE Free Edition from www.
dmde.com. Select your physical 
drive from the list of Physical 
Devices and click ‘OK’. After the 
software performs a short partition 
scan, you should see your missing 
drive or partitions greyed out and 
listed with the F.System NTFS (4K). 
Select one and click ‘Open volume’.

The free version of DMDE allows 
you to recover individual files by 

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@

futurenet.com

PARTITION 

RECOVERY  

Try DMDE if your 

partitions become 

inaccessible
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Jargon buster!

browsing to them in the main pane, 
then selecting them and right-
clicking ‘Recover files’ to save them 
to a location on another drive. This 
is fine if you only have a relatively 
small number of files to recover, but 
if you want to recover the entire 
drive quickly, we’d recommend 
upgrading to the Express version 
(€16, or around £14/$20) once 
you’ve verified that the program 
has found your data.

Security
CAN MALWAREBYTES 
RUN ALONGSIDE OTHER 
SECURITY TOOLS? 

Q I’m tempted by one of the 
rapidly disappearing lifetime 

license offers for Malwarebytes 
Anti-Malware (MBAM) Premium. 
Does this provide anything extra 
over the free version other than 
real-time protection, and is it safe 
to run Malwarebytes alongside 
BitDefender Internet Security, 
which I also have installed?
Simon Jethwa

Nick’s solution
It should be perfectly 
safe to install the 
Premium version of 

Malwarebytes alongside another 
security product – MBAM has been 
deliberately engineered to co-exist 
peacefully with other anti-malware 
tools. The program provides you 
with a secondary layer of defence 
against malware – particularly 
potentially unwanted programs 
(PUPs), which most other security 
tools ignore because, despite being 
annoying, they don’t pose a direct 
threat to your PC. The Premium 

version also blocks hacking and 
phishing attempts and automatic 
scans, just like other tools. The 
lifetime license has now been 
discontinued, but can still be 
purchased if you look hard enough 
– otherwise a year’s subscription 
protecting three PCs costs $24.95 
(about £15.50) from www.
malwarebytes.org.

Windows
RIGHTCLICK MENU 
KEEPS VANISHING 

Q When I right-click in Windows 
Explorer, I often find the 

context menu vanishes before I’ve 
got a chance to click the option I 
want. How do I stop this?
Robert Lyle

Quickfire questions

FIND THE SOLUTION! Outlook & Exchange Solutions Centre
If you have a problem with Outlook or want useful tips and 
advice, you’ll find everything you need at www.slipstick.com.

How can I stop viewing 
someone’s annoying retweets 
in my Twitter timeline?
Wendy Harris

Go the user’s profile page on 
Twitter (www.twitter.com/
username, where ‘username’ is 
their Twitter @name). Click the 
‘Settings’ button next to the 
‘Following’ button and choose 
‘Turn off retweets’.
 
I’ve installed Classic Start in 
Windows 8.1, but can no 
longer access the Quick Access 
menu via the Start button.
Clive Ranger

The simplest way to continue 
accessing the Quick Access 
menu when needed is by 
pressing [Win]+[X]. 

“Malwarebytes has been 
engineered to co-exist 
with other tools”

 Quick Access menu 
A cut-down version of the 
Windows Start menu found in 
Windows 8, which contains a 
number of system shortcuts.
 

 Retweet
A Tweet that has been 
reposted by another Twitter 
user, for the purpose of sharing 
with their own followers. 

PUP 

PROTECTION 

Malwarebytes 

Anti-Malware 

Premium blocks 

PUPs at source

CONTEXT 

MANAGEMENT 

Manage entries in 

the right-click 

menu via CCleaner

Support 
Technical help
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2 Choose ‘Powerful Uninstall’
Once installed, IObit Uninstaller can 

be started from the Programs and Features 
Control Panel or its own user interface. If you 
choose the former, select the program you 
want to remove and click the ‘Powerful 
Uninstall’ button.

1 Manage programs efficiently
Most leftover Registry entries can be 

traced to programs you’ve removed in the 
past. If you’re looking for a tool that can 
detect and offer to remove leftover entries 
after you uninstall a program, try IObit’s free 
Uninstaller 4 – on the cover disc.

OPTIMISE THE  
REGISTRY SAFELY

Q Is there a safe way to optimise 
the Windows Registry without 

the nasty side-effects? 
Phil Green

Graham’s solution
I always recommend 
avoiding dedicated 
Registry cleaning tools 

because their approach is too 
random and unpredictable. 
Instead, adopt a DIY approach to 
cleaning out and optimising your 
Registry for genuine performance 
improvements without the 
potential pitfalls.

Quickfire questions

to bring the cursor back, or run 
Media Center in windowed mode 
instead. Also verify that the Mouse 
Trails feature is disabled by going 
to the Pointer Options tab in the 
Mouse Control Panel.

Sadly Robert didn’t reply to our 
email, so we can only offer general 
advice to anyone experiencing the 
first problem. A cause and solution 
may present themselves via your 
Event logs, or you might be better 
served switching to a different 
solution. NextPVR (www.nextpvr.
com) is available to download free 
and offers similar functionality to 
Windows Media Center, including 
the ability to record television 
programmes via a tuner.

Outlook
OUTLOOK PST FILE 
ERROR FIX 

Q Every time I try to open 
Microsoft Outlook I get an 

error telling me the PST file can’t be 
opened and it closes. What can I do 
to recover my data?
Faye Dawlish

Every time I try to uninstall 
Google Chrome I get a 
‘Problem with Windows 
Installer Package’ error. Can 
you help me solve it, please?
Bruce Alexander

This could be linked to a more 
deep-seated problem with 
Windows Installer itself – visit 
http://support.microsoft.com/
kb/290301 and run the 
Program Install and Uninstall 
Troubleshooter to resolve it.
 
I’ve accidentally set up a 
duplicate Facebook Group. 
How do I remove it?
Jules Derbyshire

You need to remove every 
single person you’ve invited to 
the group manually using the 
group’s settings button (click 
‘Edit settings’). Once everyone 
else has been removed, 
remove yourself and the group 
will be gone.
 
Is there a quick way to make 
all my OneDrive files available 
offline in Windows 8.1?
Vince Stevenson

Right-click the OneDrive 
Taskbar Notification Area icon 
and select ‘Settings’. Make sure 
you have enough free space 
for the operation, then tick 
“Make all files available even 
when this PC isn’t connected 
to the internet” and click ‘OK’.

Matt’s solution
This particular problem 
is usually caused by a 
third-party program 

that has added a shell extension 
to the context menu, which causes 
the menu to crash whenever it’s 
opened. Make a note of where the 
problem occurs – it may only occur 
when you right-click a specific type 
of file or folder, for example, which 
may help you identify the culprit.

You can manage your context 
menu items from within CCleaner, 
which you’ll find on your free disc. 
Select ‘Tools > Startup > Context 
Menu’ to view all third-party 
entries. If you don’t know which 
entry is the culprit, press [Ctrl]+[A] 
and choose ‘Disable’, then see if the 
problem is fixed. If it is, re-enable 
entries one at a time until you find 
the troublesome plugin, then 
troubleshoot the problem at the 
program’s website, or simply leave 
the extension disabled.

Media
WINDOWS MEDIA 
CENTER GLITCH 

Q My self-built Asus PC is 
running Windows 8.1 with 

Media Center, and I’m currently 
plagued by two problems. First, 
upon launching, Media Center 
often freezes before continuing 
after a few minutes. This problem 
occurs even after refreshing and 
reinstalling Windows a number 
of times. Also, the mouse pointer 
disappears when Media Center is 
run. Can you help?
Robert Peters

Adam’s solution
Tackling the second 
problem first, it sounds 
to me like Windows 

Media Center is running in 
full-screen mode. To resolve this 
problem, try pressing the [Esc] key 

PST RECOVERY 

Kernel for PST 

Repair is one of the 

cheaper recovery 

options out there
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Jargon buster!
 PST file 

This stands for personal 
storage table, and is the 
default file format for storing 
messages, contacts, calendar 
events and other items in 
Microsoft Outlook.
 

 Registry
A database stored in several 
files (known as ‘hives’) that 
contains configuration settings 
and options for programs 
installed on your PC, as well as 
for Windows itself. 

4 Compact and defrag
Deleting Registry entries won’t speed 

up your PC on its own, so install Auslogics 
Registry Defrag from the cover disc and click 
‘Analyze’. Once the results are in, click ‘Defrag 
on next computer bootup’ to optimise your 
head drive next time your PC starts up.

3 Dump leftover Registry entries
The quick install removes the program 

using its own uninstaller. After that, you can 
choose to perform a Powerful Uninstall to 
search for any leftovers. Review and select all 
the Registry entries and click ‘Delete’ followed 
by ‘Yes’ to remove them.

“Any security tool worth its salt should offer  
a manual removal tool that allows you to 

clear out all traces of the program”

Graham’s solution
The first port of call is 
Outlook’s own ScanPST 
tool, which you’ll find 

in the Microsoft Office\OFFICE14 
folder if you’re running Office 2010. 
Double-click ‘Scanpst.exe’ and 
follow the prompts to scan your 
files and repair them. Be prepared 
to run the tool a number of times 
before an error-free file is produced.

Faye ran the tool as requested, 
but Outlook still wouldn’t open it. 
Fearing she might need to invest 
in data-recovery software, we 
pointed Faye to the free demo of 
Kernel for Outlook PST Repair at 
www.nucleustechnologies.com. 
On installing and running this 
she reported that the file was 
completely intact, with all her data 
visible. Purchasing the software 
costs around £38/$60, but we were 
suspicious because the file was 
reported clean, but Outlook still 
wouldn’t open it.

Next, Faye attempted a repair 
install of Office 2010 via the 
Program and Features Control 
Panel (click ‘Change > Repair’), but 
while Outlook initially opened the 
PST file after completing the repair, 
it then reverted back to the same 
error message.

Our final throw of the dice was 
to instruct Faye to rename the PST 
file and then use the Mail Control 
Panel’s ‘Data Files’ button to add 
the new file, make it the default and 
then delete the original file. After 
doing this, Outlook opened again 
and this time worked correctly 
going forward.

Software
SLUGGISH  
BITTORRENT SYNC 

Q Why does BitTorrent Sync take 
such a long time to detect 

changes to files on my devices? 
I often have to wait 15 minutes 

before it starts syncing changes 
made on one device to another. 
Can you help?
Lee Parker

Nick’s solution
This is probably related 
to the default time 
interval of 10 minutes 

that BitTorrent Sync uses to check 
for changes to monitored folders. 
You can edit this figure on all of 
your computers running BitTorrent 
Sync by clicking ‘Settings > 
Preferences’ on each one 
separately. Switch to the Advanced 
tab and click ‘More options’. Check 
the folder_rescan_interval setting, 
which is set to 600 seconds (10 
minutes) by default. Change this 
figure to 60 (one minute) and click 
‘Set’. This should hopefully trigger 
faster updates.

Security
STOP BOTHERING  
ME, AVAST! 

Q I recently tried to install Avast! 
Antivirus with no success, but 

now I keep getting little Avast! 
reminders popping up. I can 
remove them easily enough, but 
how can I stop them permanently?
Derek Green

Matt’s solution
This can be linked to 
files left behind by the 
aborted Avast! install 

process. Any security tool worth its 
salt should offer a manual removal 
tool, which allows you to clear out 
all traces of the program, including 
leftover elements from a failed 
install. Go to www.avast.com/
uninstall-utility to download the 
Avast! removal tool. 

SLOW SYNC 

Change this figure 

if BitTorrent Sync 

is slow to notice 

file changes

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@

futurenet.com 

Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 

Windows Help & 

Advice magazine, 

Future Publishing Ltd, 

Quay House, The 

Ambury, Bath  

BA1 1AU

Support 
Technical help
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 NEW HARDWARE   ESSENTIAL ACCESSORIES   LATEST GAMES

The days of your 
computer being a 
grey box on your 
desk are long gone. 
You can now take 

your PC with you everywhere 
you go, ready for whenever 
you want to type out a report 
or relax and have fun.

This month we’ve been 
putting the latest version of 
Microsoft’s productivity suite 
through its paces. Microsoft 
Office 365 is an easy and 
cost-effective way to access 
essentials like Word, Excel and 
PowerPoint. We’ve also put five 
of the latest Bluetooth speakers 
through their paces, and tested 
two of the best new laptops. 
Whatever you need a PC for, 
there’s something here for you.

Nick Odantzis deputy editor
nick.odantzis@futurenet.com

Welcome

How we review
One of the key tenets of our 
review philosophy is that 
hardware should be compared 
against like products wherever 
possible. It is only when you pit 
the nest products of a certain 
type against one another – at 
the same time – that you can 
really come up with a de nitive 

verdict as to which is the very 
best in that category. The pace 
of development in computer 
hardware means that it is very 
dif cult to compare scores 
from today with those from, 
say, six months ago. Magazines 
and websites that review a new 
product on its own run the risk 
of confusing or misleading.

We guarantee to test every 
piece of hardware rigorously 
and thoroughly, using only 
acknowledged experts to 
establish the worth of a 
product. We always review 
from the viewpoint of our 
readers; the day-to-day 
practicality and quality of  
a product is paramount.

We use only acknowledged experts to review products, so you can use 
our ratings with full confidence to make your buying decision

RATING EXPLAINED Superb GoodVery good Disappointing Poor

Our awards…Our review guarantee
Only the very 
nest products 

receive our Best 
On Test Award. 
These will have 
excellent marks 
for quality.

Our Best Value 
Award is given 
to products that 
quite simply 
represent the 
best value for 
your money.

82 Acer Aspire S3
Sleek Ultrabook styling and dedicated 
gaming hardware combine to make a 
laptop that’s ideal for both work and play.

80 Mini test: Bluetooth speakers
Enjoy the Christmas classics anywhere in 
your home with wireless speakers that 
connect to your PC, laptop or phone.

88 The Sims 4
The latest installment in the hugely popular 
people-simulator features new emotional 
motivations, improved graphics and more.

86 Lenovo ThinkPad W540
A top-notch high-resolution worktop, with 
a price tag to match. A brilliant performer, 
but only if you can justify the expense.

78  |    |  Christmas 2014

mailto:nick.odantzis@futurenet.com


Upgrade 
What’s inside…

You can trust our reviews
Our expert reviewers are 100 per cent 
independent, with years of experience 

in the world of computing. Our rigorous 
testing procedures mean that only 
genuine, high-quality products are 
awarded high star ratings. Further, very  
few are handed our Best Value or Best  
on Test Awards. If you see an item of 
hardware bearing one of these marks,  
you can be con dent that it is an excellent 
product. Always check when the award  
was given, to ensure it is still up-to-date.

We choose the best products
Thousands of new products for your 
computer are released every year and 

choosing between them can sometimes be 
an impossible task. Our experts select only 
the best hardware and software to feature 
in this magazine, making your decision on 
which one to choose easier. Even better, 
our awards and star rating system make it 
simple to nd the best products for your 
needs, with our recommended products 
section giving you a fast, trustworthy guide 
to a wide range of hardware and software.

We’ll introduce you to new stuff
Wherever we can, we review new 
hardware comparatively, pitching  

it head-to-head against other similar 
products. (Full details of our policy can be 
found in the opposite page, under ‘Our 
review guarantee’.) Of course, this isn’t 
always possible with new products and 
part of our duty to you is to introduce you 
a wide range of fascinating new hardware, 
software, services and games.

The reviews of standalone hardware  
and software are just as thorough as our 
comparative reviews. However, we do not 
allocate scores to them because this can 
often be misleading. The only exception to 
this rule is on our games reviews, where 
the pace of change is a lot slower and 
single scores can be genuinely useful.

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

“Dead Rising 3 is one of those games that 
just wants you to have fun. It revels in its 

silliness, even when it’s being serious.” 

80 Denon Envaya
80 Jabra Solemate Max
81 Monster Superstar
81 Ted Baker Fastnet
81 Supertooth D4
82 Acer Aspire S3
84 Microsoft Office 365
86 Lenovo ThinkPad W540
88 The Sims 4
92 Dead Rising 3
94 The Walking Dead Season 2 
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82 Acer Aspire S3:  
 a stylish laptop  

with solid all-round 
performance

8
8
8
8
8
8
8
8
8
9
9

82 Acer Aspire S3:
 a stylish laptop 

with solid all-round 
performance

Our promise to you…

84 Microsoft Office 365: 
productivity enters the cloud



SINGING  
THE BLUES
Take the weight off your 
phone’s speakers with this 
latest batch of party-ready 
Bluetooth sonic projectors

111 Denon Envaya11
PrPrricicice e e £1£17070 | | $1$19999
(w(wwwww.d.denenonon.c.comom))

ThThThe e e EnEnE vav yayaa’s’s’s rrratatatheheher r bababasisisic cc lololookokoks s s anannd dd
cucucuririr ououous s s nnamememe mmmayayay nnnototot nnnecececesesessasasariririlylyly 
suggggesesest t t grgrgreaeaeat t thththinini gsgsgs aaarerere aaafofofoototot hhhererere,e,e,
bubb t you wowowon’nn’t t be dddissisapapappopopoinininteteteddd bybyby iiitststs 
performancncce.e.e. TTThehehe 22.1 ssspeeeakakakererer aaarrrrrrayayay 
dod es a size-dededefyfyfyinining g g jojoj b, makakakinning g g thththe eeyyy ggg jjj , ggg
most of evee ery notetete tttrararansnsnsfeff rrr edede ttto o o ititit vvviaiaia 
apt-tt X BlBllueuetooth. Its bbbatatatteteteryryry llife isis aalslso oo
sususurprppriririsisingnglyyy iimpmpmpreresssssivivve.e

UnUnUnlililikekeke sssomomome e e ofofof ttthehehe ssspepepeakakakererers s s hehehererere, , , ititit’s’s’s 
atatat hhhomomome ee wiwiwiththth bbbototothhh yoyoyoururur sssweweweetetet-v-v-vocococalalals-s-s-
ananand-d-d-acacacouououstststicicic-g-g-guiuiuitatatarsrsrs tttypypype e e ofofof mmmusususicicic aaandndnd 
sososomememethththinininggg momomorerere fffululull-l-l ononon,,, thththanananksksks ttto o o a a a fififinenene 
blblblenenenddd ofofof dddetetetaiaiail ll anannddd popopokekeke. IItIt’s’s’s hhhararardlddly y y 
popopockckcketetet-s-s-sizizizededed bbbututut yyyououou’l’l’ll l l bebebe mmmororore e e thththananan 
happy to find sppace for it under your 
trtrtreeeeee ttthihihisss ChChChririristststmamamasss.

2 Jabra 
Solemate Max
Price £249 | $399
(www.jabra.co.uk)

AtAtAt 333.7.7.7kgkgkg ttthehehe MMMaxaxax iiis s s stststrereretctctchihihingngng ttthehehe 
dededefififinininitititiononon ooof ff thththe e e wowowordrdrd ‘‘‘popoportrtrtababablelele’,’,’, bbbututut 

ededespspspittte e e ititits s bububulklklk, ,, ititits s s auauaudididio o o isisis sssurururprprprisisisinininglglgly y y 
lalaackckc inning.g.g. WWWititithhh alala lll thththatatat wwweieieighghght,t,t, aaandndnd ttthehehelackckinnng.g.g. WWWitth hh alaall l thththatatat wwweieieighghghtt,t aaandndnd ttthehehe  
cocoombmbmbinininededed ooutututpuuputt ofofof tttwowowo tttweweweetetetererers,s,s, tttwowowo 
wowowoofofofererers s s anananddd aaa bababassssss dddririvevever,r,r, yyyououou’d’d’d eeexpxpxpececect tt
plplplenenentytyty ooof f f thththumumump,p,p, aaandndnd iiit t t dododoeseses dddelelelivivivererer ttthehehe   
gogogoodododss s wiwiwiththth dddananancecece mmmusususicicic aaandndnd rrrococock,k,k, bbbututut iiit’t’t’s ss
momomorerere aaaboboboututut vvvolololumumume e e thththananan qqquauaualililitytyty, , , ananand d d a a a
lililittttttlelele uuundndnderererwhwhwhelelelmimimingngng fffororor ttthehehe hhhigigigh h h prprpricicice.e.e. 

OnOnOn ttthehehe ppplululus s s sisisidedede, , , thththe e e 141414-h-h-hououour rr bababattttttererery y y 
lilil fefe iiis s suuupepep rbrbb, , , ananand dd thththererere’e’e’s s s boboboththth NNNFCFCFC aaandnd 
aaa neneneatatatlylyly hhhidididdededennn cacacablblblee e asasas aaadddddditititioioionananalll
connn ectivity optpp ions, but its lack of 
subtbtbtlleletytt aanddnd pp iriricee tttagag llletett iiitt t dddown.

1

2

3

High-end Bluetooth speakers 
have surged in popularity over 
recent months, and you’re now 
spoilt for choice when it comes 
to choosing a battery-powered, 
wireless sound system to use 
with your phone, PC or laptop. 
With the latest crop of portables 
offering big sounds, bold looks 
and all-day battery life, they’re 
still essential even as winter 
takes hold, and outdoor events 
become less common. They’re 
a brilliant choice for playing 
the festive classics at Christmas 
parties, or enjoying some 
relaxing tunes on those cosy 
nights in beside the fire. So which 
should you choose? Read on for 
the truth about ’tooth and pick 
the best box of the bunch.
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55 Supertoooth 
D4
PrPrPricicice e e£5£50 0 || $6$600 ((wwwww.w.susupepertrtoooothth.n.netet))

Most ooof ff tht e offffeff ringggs heeerer  are at the 
premium end ofo tthe Bluettooooththt mmarket,
becausse e thththat’s whaat wew ’vvve chosenn tooo
focuc s onn iiin ththis ttest, butu  if all yoou waw nt 
is a more afforrdable hihih t t of volume, in n a,
vav riety of cccolololouoo r choices, you cccouoo lddd dddo oo a aa
looot tt worsse thhana  the D4.4.4. 

BoBoB asasastittingngng eeexcxcxcelellelentntnt bbbatatatteteteryryy liffe ee – upupp ttto oo
121212 hhhououoursrsrs ––– iiit t t alalalsososo ppperererfofoformrmrms s s a a a lololot t t bebebettttttererer 
thththananan yyyououou mmmigigighththt eeexpxpxpececect t t fofofor r r thththe ee prprpricicice.e.e. WWWilili l ll
ititit ppprororovivividedede sssoaoaoaririringngng hhhigigighshshs aaandndnd bbbasasass s s yoyoyouuu
cacacan n n fefefeelelel iiin n n thththe e e pipipit t t ofofof yyyououour r r stststomomomacacach?h?h? NNNo,o,o, 
bububut tt ititit ssstitit llllll sssouououndndnds pepeperfrfrfececctltltly y y gogogoododod. . AnAnAnddd
weweweigigighihihingngng iiinn n atatat aaa mmmererere ee 5050500g0g0g, , ananand d d wiwiwiththth aaa 
handle on top to boot, it’s as portable as 
ititit iiiss s unununprprpretetetenenentititiouououss.s

3 Monster 
Superstar
Price £99 | $130
(www.monsterproducts.com)

MoMoMonsnsnsteteter clclclaimsmsms ttthahahat tt ititits s s lililittttttlelele SSSupupuperererstststararar iiisss
“T“TThehehe wwworororldldld’s’s’s sssmamamallllllesesest tt auauaudididiopopophihihilelele ssspepepeakakakererer.”.”.” 
WeWeWe’r’r’re e e nononot t t sususurerere aaaboboboututut ttthahahat,t,t, bbbututut iiit t t dododoeseses 
pupuputttpupuputtt ouououttt aaa veveveryryry pppleleleasasasinininggg nononoisisiseee fofoforrr itititss prprpricicice.eeououout t t a aa veveveryryry pppleleleasasasininingg g nononoisisise ee fofor r r itts ss prrriccce.e. 
ThThThe e e bababassssss iiis s s pupupuncncnchyhyhy, , , thththe ee mimimid-d-d-rararanggnge e isisis
tititighghght,t,t, aaandndnd ttthehehe eeeffffffececect t t isisis eeespspspecececiaiaialllllly y y plplpleaeasiss ngngng  
ononon vvvocococalalal-h-h-heaeaeavyvyvy tttrararackckcks.s.s. 

YoYoYou u u cacacan’n’n’t t t cococompmpmplalalaininin aaaboboboututut aaa lllacacack k k ofofof 
vovovolululumememe eeeitititheheher;r;r; iiin n n fafafactctct, ,, ititit gggoeoeoes s s upupup ssso o o lololoududud 
thththatatat yyyououou ssstatatartrtrt ttto o o gegeget t t a a a bibibit t t ofofof dddisisistototortrtrtioioion n n atatat 
ititits s s upupuppepeper r r lililimimimitststs. . . AdAdAdddd aaa wawawateteter-r-r-rereresisisistststananant,t,t, 
rururubbbbbberere isssededed bbbuiuiu ldldld, , , aaa bababattttttererery y y thththatatat wwwililllll
lalalaststst bebebetwtwtweeeeeenn n fififiveveve aaandndnd tttenenen hhhououoursrsrs, anananddd
a chasssis small ennough to fit in your
po kkcketetet, anddd ititit’’s’s a ggreeattt lllititittltltle soounundbdbdbox.

4 Ted Baker 
Fastnet
Price £119999 || $n$naa (w(wwwww.t.tededbabakeker.r.cocom)m)

‘E‘E‘Elelelegagagantntnt’ isis nnnototot aa wwwororordd d bababandndndieieieddd abbout
thththatatat oooftftftenenen wwwheheh n n n tatatalklklkininng g g abababououo t BlB uetootoototothhh
spspspeaeaeakekekersrsrs, , , bububut tt TeTeTed d d BaBaBakekeker’r’r’s ss fiff rst fofoforararay y y 
ininintooto auauaudididio oo kikik t tt loloookokoks ss popp sisisitit vevevelylyly sssleleleekekek
cococompmpmparararededed tttooo thththeee rererest. Lookokokinininggg lilil kekeke acococompmpmparararededed tto o o thththe ee rerr st. Lookokokinining gg likek  a 
crcrcrosososs ss bebebetwtwtweeeeeen nn a retro oo cacacamememerarra and 
lululuxuxuxuryryry lluguguggag geg , thhhe e e leleleatatatheheh r-cllladaa  Fasasstnt et 
cococomememes ss ininin bbblalalackckck, , , brbrbrowowo n,n,n, pppininnk kk orro wwwhihihitetete  
ananand d d fefefeelelels s s rerereasasassususuririringngnglylyly wwwelelellll bububuilililt.t.t.

ThThThe e e auauaudididio o o hehehererere iiiss s alaalsososo rrrefefefinininededed.. MoMoMorerere 
ofofof aaa ssstititiffffff gggalalale e e thththananan aaa hhhurururririricacacanenene, , , ititit’s’s’s aaa 
grgrgrowowown-n-n-upupup aaaudududioioio bbbalalalananancecece ttthahahat’t’t’s s s hihihighghghlylyly 
eneenjojojoyayayablblble e e whwhwhenenen gggenenentltlt y y y grgrgrooooo vivivingngng tttooo
acacacouououstststicicic aaandndnd vvvocococalalal tttrararackckcks,s,s, bbbututut aaa bbbititit 
undercooked when the time comes
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The Acer Aspire S3 is an 
Ultrabook-style laptop with 
a difference. It’s quite light, 

portable and good looking, but 
also incorporates a dedicated 
graphics processor, making it one 
of the few laptops in its class that 
could be called a gaming device.

What’s the price of this sort of 
versatility? The Acer Aspire S3 with 
the Nvidia GeForce 735M costs 
£799/$899, which is no more 
expensive than some Ultrabooks 
with effectively no gaming skills at 
all. You pay for it in battery life, so 
this isn’t quite the perfect mix of all 
worlds, but it’s not bad at all.

New look
The Acer Aspire S3 has been 
around in various guises for a few 
years now, but the 2014 edition 
is quite a departure from the old 
models. Where the original Aspire 
S3 was quite rightly regarded as a 
bit of a MacBook Air rip-off in its 
looks, the new version looks a lot 

closer to the Acer Aspire S7, an 
Ultrabook with a snazzy glass lid.

In order to keep costs down, the 
Acer Aspire S3’s lid isn’t made of 
glass, but it still looks and feels as 
if it is. The aluminium frame is 
lacquered with several layers of 
glossy paint, providing a look quite 
unlike the metal underneath.

The rest of the Acer Aspire S3 
design is sound, if not quite as 
pristine and perfect as the very 
priciest, prettiest Ultrabooks. The 
prevalence of obvious seams and 
the slightly uneven distribution of 
the chunky screen bezel mean it’s 
not as pretty as a MacBook Air. But 
then few laptops are.

In practical terms, the Acer Aspire 
S3 is very good. It weighs 1.55kg 
and is 17.8mm at its thickest point. 
The S3 doesn’t match the thinnest 
or lightest of Ultrabooks, but a 
couple of deliberate design choices 
make that impossible.

First, there’s the use of dedicated 
graphics. Almost all slim laptops 

use graphics processors integrated 
into the central processor chipset 
to keep size to a minimum. There’s 
also the storage type inside. The 
Acer Aspire S3 uses a hybrid drive, 
which provides 500GB of traditional 
hard drive storage and 16GB 
of solid state memory for the 
super-fast startup people expect 
from Ultrabook. Hard drives are, 
generally speaking, chunkier than 
SSDs, but they are also far cheaper 
if you want plenty of storage.

Warm welcome
The Aspire S3’s bodywork is decent, 
if not deserving of any superlatives, 
and it’s the same story with the 
screen. It’s a 13.3-inch 1080p IPS 
display offering a bright backlight, 
vibrant colours and the great 
viewing angles you normally get 
with IPS. The tone of the screen is 
quite warm, giving whites a slightly 
yellow tone that skews the colours 
in general, but it’s not too serious 
and the look of the display is 

Acer Aspire S3
£799 | $899 www.acer.com

An Ultrabook-style laptop with dedicated gaming hardware
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doesn’t boast too much about its 
internal speakers.

We have no such kind words for 
the webcam. It’s a basic 720p affair 
and its footage is very noisy with 
indoor lighting, where it’s most 
likely to be used. Stills are no better 
either – pictures are very noisy and 
low on detail.

Most of the Acer Aspire S3’s 
specs are typical of a mid-range 
Ultrabook. You get an Intel Core i5 
4200U, a pretty battery-conscious 
1.6GHz dual-core CPU. It’s no 
cut-price solution, though – the 
lower-end version of the Acer 
Aspire S7 uses the same chipset. 
What’s more likely to prove a bit of 
a performance bottleneck for some 
is the 4GB of RAM.

Most Ultrabooks at this price 
have 4GB of RAM, but if you’re 
going to be doing any video 
editing or Photoshop editing of lots 
of high-resolution images at once, 
you may be better off with an 8GB 
laptop. There is no 8GB version 
of the Aspire S3, though, as it’s 
intended largely as an entry-level 
model filling space between Acer’s 
no-frills laptops and the Aspire S7.

The Acer Aspire S3 is a mostly 
pleasant laptop to use, with a light 
focus on gaming that may appeal 
to those looking for a work PC that 
can double up for some downtime 
fun. There are some minor quirks to 
the keyboard and trackpad, but the 
one thing that really holds it back 
is battery life. It’s just not remotely 
close to the best out there, and 
stamina really matters in a highly 
portable laptop like this. 

The Aspire S3 is a bit of a jack of 
all trades, but not every product 
needs to be a king to succeed.

perfectly pleasant. The display’s 
viewing angles are good too.

The screen rotates 180 degrees. 
This makes it easy to share the 
display, although obviously it’s not 
quite as flexible as a removable 
screen tablet-laptop hybrid, or one 
that rotates 360 degrees like the 
Lenovo Yoga. It’s a ‘normal’ laptop 
screen in this respect.

The Acer Aspire S3’s display has a 
standard glossy finish and doesn’t 
have the nova-like brightness 
needed to make it usable outdoors 
on a sunny day, but that’s expected.

As you’d expect of a modern 
Windows Ultrabook, the screen 
supports 10-point multitouch. 
There’s a fair bit of bezel around the 
actual display, but the entire top of 

the screen is a single pane of glass, 
giving it that higher-end look.

The Aspire S3 has a keyboard 
typical of a slim and light laptop. It 
uses chiclet keys that poke through 
the single-piece aluminium 
keyboard surround, and their 
action is a little on the shallow side.

While the usual letter keys are 
large enough to allow for typing 
that doesn’t feel cramped, the keys 
at the laptop’s edges have had to 
be crushed together a little in order 
to fit everything in. [Caps Lock] is 
tiny, as is the left [Shift].

Tiny trackpad
Another unfortunate effect of 
the keyboard’s layout is that the 
trackpad is a little on the small side. 
There’s plenty of room along the 

horizontal, but a little more room 
on the vertical scale would have 
been welcome for things like 
three-finger gestures.

Although clearly MacBook-
inspired in its execution, the 
trackpad isn’t all that great in 
use either. It gives slightly under 
your fingertips, and a light press 
registers as a click, making the 
tactile ‘click’ sensation pointless. 
If this is deliberate, we’d much 
rather see Acer adopt a lighter 
trackpad action than have this 
odd two-stage approach.

The surface of the Aspire S3’s 
trackpad feeks quite nice to use, 
though. It uses a similar sort of 
treated glass as the top Ultrabooks, 
offering a smooth surface that’s less 

tacky feeling than plastic trackpads 
on less expensive devices.

We were also pleased by the 
lacks of brand tie-ins. There are 
no Beats by Dre speakers, sucking 
up even more cash as marketing 
spend. However, the speakers are 
actually fairly good. They fire from 
each side of the laptop, giving at 
least the person using the thing a 
good sense of stereo.

While there isn’t an extra 
subwoofer driver to provide actual 
bass (or an approximation of it), the 
speakers go fairly loud and offer 
some of the mid-range bulk that’s 
so often missing from laptop 
speakers. They’ll more than do 
the trick for the odd YouTube 
video.  It’s good to see fair speaker 
performance in a slim laptop that 

“The Acer Aspire S3 may appeal to those looking for 
a work PC that can double up for some gaming fun”

Upgrade 
Aspire S3
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Acer Aspire S3
Supplier www.acer.com
Operating system Windows 8
Processor 1.6GHz Intel Core i5 4200U
Storage 500GB HDD, 16GB SSD
RAM 4GB DDR3 SDRAM
Graphics GeForce 735M 1GB
Connectivity 2 x USB 3.0, 1 x USB 2.0, 
HDMI-out, SD, Acer converter socket, 
headphone jack, 802.11b/g/n Wi-Fi, 
Bluetooth 
Weight 1.55kg 
Screen size 13.3-inch 
Display resolution 1,920 x 1,080 IPS

http://www.acer.com


Keeping in the spirit of 
Microsoft’s recent enterprise-
focused reboot, the new 

version of Office is more suited to 
business use than it used to be. 
It includes much more than the 
familiar set of software like Word 
and Excel, including tools for Office 
servers (Exchange, Lync, SharePoint 
and services that run on the latter 
like Excel Services, Project Services 
and the Office Web Apps). There 
are also hosted versions of these 
services provided by third parties 
and Microsoft itself. From March 
2015 you’ll also be able to buy 
Office 365 from Microsoft partners.

Now including hosted online 
services for company servers, Office 
365 provides Office Web Apps and 
the Outlook Web app as part of this 
service, with subscription licenses 
to the actual software usable on 
personal desktops. Additionally, 
Microsoft has launched Office 
365 Personal, which is intended 
for a single user and allows one 

download of Office. The consumer 
Office 365 ‘Home Premium’ service 
costs $100 a year (£80) for Word, 
Excel, PowerPoint, Outlook, 
OneNote, Access and Publisher.

Family values
That’s good value if you share it 
with the family; up to five people in 
the same household can have their 
own installation of Office on their 
PC or Mac at the same time. Apple 
device users get the current version 
of Office for Mac until a new release 
comes along in the future, and 
when the next version of Office for 
Windows comes out, you’ll get it on 
the same subscription too.

All five people get an extra 20GB 
of space on SkyDrive to store their 
documents, and 60 free Skype 
world calling minutes a month 
(which can be calls to a landline or 
a mobile and from your PC or from 
a smartphone with Skype installed).

You can download the Office 
programs temporarily on another 

PC if you’re away from your usual 
machine, even if it already has 
another version of Office installed. 
So if you have a document on a 
USB drive or on SkyDrive that you 
need to edit on another computer, 
and the Office Web Apps from 
SkyDrive lack a feature you need 
(like seeing revision marks in a 
document you’re collaborating on, 
for example), you can use Office on 
Demand to get the full version of 
Word in just a few minutes.

You manage all this from the 
revamped www.office.com, and 
there’s a link to your account in the 
ribbon of all the Office applications. 
To activate the Skype minutes you 
have to link your account to the 
Microsoft account you’re using for 
Office 365, which can be done at 
www.office.com. You also get a list 
of your recently edited documents, 
which helps when using Office on 
Demand to give it a fresh edit.

If you’re at college or university 
(or teach at one) it’s possible to get 

Microsoft Office 365
£80 a year | $100 a year http://office.microsoft.com

Office heads for the cloud, but does it send productivity sky-high?
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works in an established industry 
is likely to run into an Office 
document every now and again. 
There are some features of Office 
that cannot be found outside of the 
suite, especially in regards to Excel. 
Apple’s iWork suite has come on 
leaps and bounds, but Numbers 
can’t match the might of Excel for 
heavy number-crunching.

Cloud integration and 
subscription licensing made Office 
2013 a landmark release for 
Microsoft, and this functionality 
has extended to Office 365, too. 
It’s also worth noting that this is 
the first update that has upgraded 
the servers which host Office 365, 
making it even more stable.

The new Office 365 plans are a 
simple and cost-effective way to 
get access to new features in the 
desktop version of Office 2013 and 
new versions of Office servers, 
without the work of running 
your own servers. The new 
administration interface makes 
the service easier to work with, 
whatever your level of expertise, 
and SharePoint and Exchange 
Online have major new features.

Existing Office 365 users have 
to wait for Microsoft to schedule 
upgrades to their accounts (and 
some early migrations have caused 
issues with SharePoint online). Also, 
Microsoft still has to prove it can 
offer meaningful improvements 
on a regular basis, like taking 
advantage of Skype and Yammer 
inside Office 365.

For smaller companies that 
will appreciate the new, simpler 
interface, Office 365 is a reliable 
service that integrates email, 
document sharing and 
conferencing almost seamlessly 
with the new desktop versions 
of the Office software. It also 
has powerful options for larger 
businesses. The savings from 
putting commodity IT in the cloud 
and still being able to integrate 
with on-premise servers through 
Active Directory and hybrid 
Exchange deployments, could 
make the combined subscriptions 
for server and desktop products 
very attractive. 

Office 365 is an easy and cost-
effective way to get access to new 
features in desktop Office 2013.

Office 365 University on a four-year 
subscription for $80 (£60), which 
you can use on two PCs or Macs.

Beyond business
Office 365 is great for much more 
than enterprise applications. Much 
like Apple’s iCloud software, Office 

365 can sync documents to a wide 
range of devices as well as various 
other services such online editing.

There are currently two tiers 
for Office 365: Home and Personal. 
The Home version costs £8 ($10) 
a month and enables you to install 
Office on up to five computers 
(which can be running either 
Windows or OS X), five tablets and 
unlimited smartphones. You also 
get 20GB of extra cloud storage for 
each of the five users. Personal, 
which costs £5.99 ($6.99) a month, 
is intended for a single user and 
providees one download of Office.

In our tests, documents created 
in Office synced to an iPad and 
various PCs, and appeared online 
where we could edit them to our 
heart’s content. The seamlessness 
of the service is typical of Microsoft, 
whose business is based around 
offering such a smooth experience.

Online versions of Word, 
PowerPoint, Excel and OneNote are 
all here and work quickly, although 
users with slower broadband speed 
may not see such speed. In fact, we 
would go so far as to say that the 
services available in Office 365 
would be rendered useless by a 
slow broadband speed and users 
looking to purchase a subscription 
should check that their connection 
is able to support Office 365.

Still relevant
While many decry Office as being a 
relic of a bygone era, anyone who 

“The seamlessness of the service is typical of 
Microsoft, whose business is based around it”

Upgrade 
Microsoft Office 365
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The W540 is designed with 
graphical performance in 
mind, and is kitted out with 

a 15.6-inch, 2,880 x 1,620 pixel IPS 
display, a high-end 2.7GHz Intel 
Core i7-4800MQ processor and an 
Nvidia Quadro K2100M graphics 
card. It’s ready to tackle anything 
from simple Word documents to 
thousand-page spreadsheets and 
heavy 3D modelling, but you have 
to ask yourself whether the power 
is enough to justify the price.

Design
There’s nothing noteworthy about 
the W540’s design. The chassis is a 
carbon copy of previous ThinkPad 
notebooks. It folds up into a grey 
rectangle devoid of flashy accents, 
and with only a few curved edges.

But what the W540 lacks in style, 
it makes up for with a carbon-fibre 
reinforced plastic body wrapped 
around a magnesium rollcage. With 
these rugged elements, you can 
expect this laptop to survive falls 

and other accidents that would 
damage other notebooks.

Despite these toughened 
materials though, the ThinkPad 
W540 still has a few soft spots. The 
right-hand side of the palmrest 
creaks under the weight of your 
hand, and the chassis flexes when 
prodded along the display hinge. 
These are both small imperfections 
that you won’t notice unless 
you look for them, but it’s still 
disappointing that such a toughly 
built laptop bends under pressure.

Another thing you won’t like 
is the lid, which is coated with 
a soft-touch material that picks 
up dust and scratches easily. The 
interior is finished with a coarse, 
hard plastic texture. We think it 
would have made more sense to 
swap these, but the lid is made of 
a different glass-fibre reinforced 
material, which could explain why 
Lenovo used a soft-touch finish.

The W540 is a blocky beast that 
weighs in at 5.57lb and measures 

14.8 x 9.8 x 1.1in, much of which 
is due to the optical drive. For 
comparison, Apple’s MacBook Pro 
15 with Retina Display tips the 
scales at only 4.46lb with 14.13 x 
9.73 x 0.71in dimensions. The 14in 
HP ZBook is by far the smallest and 
lightest machine of its type though, 
at 13.35 x 9.33 x 0.83in and 3.57lb.

Value proposition
But size isn’t everything. The HP 
ZBook 14 is very expensive at 
$3,087 (about £1,927), but despite 
its loftier price, it’s a less capable 
machine. At its highest spec, it 
can be configured with a 1080p 
screen that pales in comparison 
to the W540’s 3K resolution. The 
HP notebook is equipped with a 
slower 2.1GHz Intel Core i7-4600U 
processor and a less powerful AMD 
FirePro graphics chip. However, 
it does come with 16GB of RAM 
– twice the amount of the W540.

Apple’s latest generation 
MacBook Pro 15 features a higher-

Lenovo ThinkPad W540
£796 | $1,600 www.lenovo.com

A top-notch high-resolution workstation with a top-shelf price tag
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system that packs plenty of power 
to get you through all your daily 
tasks. Of course, with such a high 
price tag for this configuration, it 
might be too costly to justify for 
everyday computing. Instead, it 
might be a unit best reserved for 
professional graphic designers.

Lenovo has inherited ThinkPad’s 
long heritage of building excellent 
business laptops, and the W540 
is another stellar notebook. The 
laptop’s rugged body will survive 
an accident better than a HP 
ZBook 14 or Macbook Pro 15 with 
Retina Display. Thanks to Lenovo’s 
software it’s a highly secure tool 
that won’t be hacked easily. Lenovo 
has figured out its keyboards to a 
science, and the Chinese computer 
maker has also designed a trackpad 
that’s twice the traditional size, 
making navigation even smoother 
and more comfortable if you’re 
working for long periods of time.

Aside from the solid build quality 
and usability that we’ve come to 
expect from Lenovo, the W540 also 
offers a uniquely gorgeous screen. 
It displays text and images with 
great contrast, gorgeous colours 
and an amazing resolution, and 
we’d go so far as to say it’s the best 
screen we’ve ever seen on a laptop. 
Importantly, the W540 actually has 
components with enough power 
to drive this high-resolution 3K 
display. If you’re in the graphic 
design or photography world, this 
is one laptop definitely worth 
checking out. 

The Lenovo ThinkPad W540 is a 
powerhouse, but too expensive 
for general home office use.

resolution 2,880 x 1,800 display, 
and is available on Amazon for 
$1,899. The thin machine is 
equipped with a 2.5GHz Intel Core 
i7 processor, complemented by 
Nvidia’s GeForce 750M GPU. It’s not 
as powerful as the W540, but you’ll 
get a better looking and lighter 
machine with double the RAM, 
better battery life and a much more 
reasonable price tag.

For the best bang for your buck, 
it’s worth considering the Dell 
Precision M4800. It costs $2,238 
(about £1,397) for a version with 
almost exactly the same specs as 
this W540, plus a higher-resolution 

display. The lower price means you 
can consider throwing in some 
additional storage, RAM or other 
upgrades, making it an even more 
tempting proposition.

Good looking
With such impressive (and costly) 
parts, we weren’t surprised to see 
the W540 perform flawlessly with 
any application we used. It never 
stuttered, regardless of whether we 
were browsing the web, editing 
images or looking at 3D printing 
models in AutoCAD. 

The best thing about the W540 is 
its gorgeous 3K screen. At 2,800 x 
1,620, the pixels on this 15.6-inch 
display are virtually invisible. What’s 
more, they’re all tuned to produce 
perfect and accurate colours, which 

can be adjusted with the optional 
Integrated Color Calibrator.

The high resolution makes text 
look crisp without turning the font 
into thin, unreadable scribbles, and 
makes just about any video look 
good. You can finally appreciate 
the quad-HD quality of the few 
snippets of 4K video on YouTube.

Unfortunately, the high-
resolution screen also eats into 
battery life. During our PCMark 8 
battery test the ThinkPad W540 
only lasted three hours and seven 
minutes. With normal use you can 
expect to squeeze out four hours 
and nine minutes split between 

more than a dozen tabs of web 
browsing, some image editing in 
Lightroom and streaming 4K video 
on YouTube. Even after activating 
the power saver profile on the 
W540, we got at best five hours 
and 17 minutes with modest use.

Lack of apps
Despite the W540 being designed 
for productivity and office work, 
there are hardly any business 
applications installed. Don’t expect 
to create spreadsheets, Word 
documents or images without 
paying for a suite or programs, or 
downloading a free alternative such 
as LibreOffice (www.libreoffice.org).

Despite this oversight, you 
won’t be disappointed with its 
performance. It’s a hefty and solid 

“The pixels on this 15.6-inch display are virtually 
invisible, and are tuned to produce perfect colours”
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Lenovo ThinkPad W540
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ThinkPad W540
Supplier Lenovo
Operating system Windows 8
Processor 2.7GHz Intel Core i7-4800MQ 
(quad-core, 6MB cache, up to 3.7GHz 
with Turbo Boost)
Storage 256GB SSD
RAM 8GB DDR3 (2x 4GB at 1,600 MHz)
Graphics Nvidia Quadro K2100M (2GB 
GDDR5 VRAM), Intel HD Graphics 4600
Connectivity VGA, 2x USB 3.0, 2x USB 
2.0, Express Card, 4-in-1 card reader, DC 
in slot, Thunderbolt, mini DisplayPort, 
802.11ac Wi-Fi, Bluetooth 4.0 
Weight 5.57lb 
Screen size 15.6in 
Display resolution 2,880 x 1,620

http://www.libreoffice.org


 Mortimer Goth,  

 charming as always 

to The Sims 4 with a desire to 
see the experience that I’ve 
enjoyed in the past deepened 
by new art and smarter 
characters. The verdict, on that 
count, is a partial success. The 
Sims 4 inherits an enormous 
number of its predecessor’s 
ideas, goals and structures.

It’s a sequel in a way that 
has become peculiar to this 
series – a fresh start that 
truncates or removes a huge 
number of elements from 
The Sims 3 and its expansions 
in order to begin the cycle 
again. In doing so, developer 
Maxis has rebuilt the game to 
support a new graphical style, 
better animation, and an 
emotion system that changes 
its feel and flow.

After comfortably sinking 30 
hours into the game I cannot 

Revisiting old haunts and geting all emotional
Price £50 | $60
Developer Maxis
Publisher EA  
Multiplayer Online sharing  DRM Origin  Web www.thesims.com
Recommended specs Dual-core CPU, 2GB RAM, 512MB GPU 

imagine being without many 
of these new features. 
Multi-tasking is one. In prior 
Sims games, your characters 
performed the tasks you set 
for them – or those they 
assigned themselves, based 
on need – as part of a queue. 
Now, that queue can 
accommodate multiple active 
tasks at once as long as doing 
so is physically possible. 
Listening to music, for 
example, is something that 
a Sim can benefit from 
anywhere in range. A Sim who 
is cooking a meal can talk to 
their partner while they do it. 
They can paint and flirt, write a 
novel and discuss videogames, 
sit on the toilet and drink 
coffee. It feels totally natural, 
and Sims will, if left alone, 
occupy themselves with 

There’s a blithe naivety 

to the way that life 

is presented in The 
Sims that can be 

either comforting or a little 

disturbing depending on 

your mood. It is set in a world 

where buying things is always 

awesome and everybody is 25 

until they’re 60. Regardless 

of aesthetic, the series has 

always been functionally and 

fundamentally Californian.

Which is fine. Ownership 
of a beautiful self-built home 
is a perfectly good fantasy 
to construct a game around, 
and given that the last two 
games I reviewed were 
about butchering goblins 
and disemboweling Nazis 
respectively, I’m not sure I’m 
in a position to pick too many 
holes in it. Nonetheless, I came 

The Sims 4
multiple tasks at once. The 
days of having to steer a Sim 
away from a rigid conversation 
to watch television in isolation 
are gone, and good riddance.

Moving experience
This newfound flexibility is 
matched in a movement and 
animation system that is 
– for the most part – much 
more forgiving than it was in 
previous games and far less 
dependent on an underlying 
grid to dictate movement 
patterns. Awkwardness is still 
a factor, and is sometimes 
exacerbated by the game’s 
willingness to let Sims clip 
through each other if it 
resolves a pathing issue faster, 
but I experienced far fewer 
problems negotiating space 
in The Sims 4 than I did in The 
Sims 3. Characters engage and 
disengage from conversation 
more fluidly than before too, 
and are able to do so from 
multiple standing and seated 
character arrangements.

It is not, however, without 
flaws. Sometimes, Sims will 
decide that they simply can’t 
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 “This is so awkward. I wish  

 it was morning already” 

 Sims will take 

care of basic 

needs on  

 their own, but 

need your 

input to thrive 

 

 “That’s so unfair, I hate you!” 

 There’s still some awkward clipping.  

 Note the old hand-through-the-apron trick 

go where you want them to 
go. Sometimes they’ll go to 
the toilet in the park three 
blocks away because they’ve 
decided they can’t get to the 
toilet next door. Sometimes 
two Sims on a date will sit and 
opposite ends of a bar and talk 
to each other across the six 
people in their way. Some of 
these oddities are new, and 
some of them are very, very 
old; I find it easier to forgive 
the former than the latter. 
Where a problem emerges 
from new technology, it can 
be filed under away under 
‘good intentions’. When basic 
pathing issues still occur after 
14 years, it’s harder to dismiss.

These details – both the 
positive and the negative 
– are so important because 
negotiating them is what you 
spend your time doing. As a 
management game, The Sims 4 
is not challenging. It’s about 
wish fulfillment to a fairly 

 Movement is now more  

 natural – most of the time 

Plotting and planning
How the world works

5  These buttons in the top-left switch 
between worlds. Sims can move 
between the two at will, so you’ll find 
Oasis Springs residents in Willow 
Creek’s nightclub.

1

2

3

4

5

4  Communal lots such as museums 
can’t be used as homes, but you can 
change that by altering the lot type via 
a menu. Live in a library! Turn a home 
into a cafe!

3  You can build anything you want 
on an empty lot, but the individual or 
family you want to move in will need to 
be able to pay the total cost of the 
building and its contents.

1  The currently-
controlled household 
is marked by a green 
plumbob. This is 
normally a family that 
you’ve created, and 
clicking on this allows 
you to return home.

2 Homes occupied by 
other families are 
marked with a grey 
plumbob. Click on it and 
then click the ‘Play’ 
button to switch over 
and start controlling 
them instead.
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This is in spite of the 
complexity promised by the 
new emotion system. Rather 
than simply be governed by 
their biological needs, Sims 
now have drives that come 
from their emotional state, 
and that, in turn, unlock new 
actions in the environment. It’s 
a strong addition that adds 
some welcome colour to the 
game, but it’s so easy to incur 
the ideal emotional state for 
what you want to achieve that 
it may as well be just another 
criterion to fulfill before 
packing your Sim off to work 
for the day. 

What a feeling
Where emotions more clearly 
show their promise is in the 
minute day-to-day interactions 
between Sims, and in the 
opportunity they provide the 
game’s designers to express a 
bit of personality. I wonder, 
earnestly and fondly, about 
the nature of the person who 
decided that a confident Sim 
should be able to ‘pee like a 
champion’, or that an enraged 

Sim should unlock the power 
to ‘have an angry poop’. 

The system is at its best 
when you’re steering your 
Sims directly, discovering new 
interactions through their 
feelings. It’s less successful 
as part of the game’s overall 
simulation. Without you 
prompting them into work, 
love, creativity or crime, 
unattended Sims will subsist 
on orange juice and cereal, 
watching the TV and browsing 
the internet until the bills go 
unpaid, utilities are shut off 
one by one, and they mooch 
around alone and unhappy. 
This has always been true 
of the series, but The Sims 4 
does so much to deepen its 
characters’ internal lives that 
it’s a shame that there’s no 
option to simply let the 
simulation run.

Emotions and traits can 
create entertaining situations. 
I watched a mother explain 
‘woohoo’ to her teenage  
son only for him to become 
embarrassed and run off to 
hide under his duvet covers. 
In one instance, two Sims that 
had both missed their birthday 
parties fled to separate rooms 
to cry in isolation. I saw a tiny 
Sim version of our editor-in-
chief Graham Barlow excise his 
anger by yelling at a child in 
the park. These little moments 
of character are great, but with 
prolonged exposure they 
become background detail 
rather than a lasting part of 
your ongoing narrative. In 30 
hours I never saw a Sim that I 
didn’t directly control make a 
bold decision because of their 
emotions, ambitions or traits. 

substantial degree, and while 
you’ll be asked to earn money 
and social standing and career 
success in order to achieve 
those wishes actually getting 
there is a matter of time rather 
than effort. Every Sim has a 
lifetime ambition, chosen 
at character creation – just 
like in The Sims 3. The criteria 
are more complex this time 
around, but it really just 
amounts to a longer list of 
things to do. Tell 20 jokes, 
write five books, own a 
voodoo doll, and so 
on. Finishing an ambition 
grants various awards and 
special abilities.

Careers are similar, but their 
promotion paths are longer. 
Beyond a few choose-you-
own-adventure style text 
boxes, you have no interaction 
with what your Sims do during 
their working day. Instead, 
as before, you attempt to 
meet certain criteria in their 
spare time in the hopes of 
earning a promotion. It’s 
pleasant and absorbing, but 
perhaps too straightforward.

Those choices are left to the 
player, even when you’ve 
opted in for full automation. 
There’s some sense to that, 
but I’d have loved the option 
to simply let my Sims out into 
the world and watch what 
they did.

A note on tone: I’ve heard a 
few longtime players express 
concern about the way that 
promotional material for The 
Sims 4 focused on the wackier 
elements of the gameworld 
– woohoo in space, man-
eating plants, and so on. 
All of that stuff is present but 
it’s included in the game at 
your discretion depending 
on your choice of ambition, 
career, and interior design. 
The Grim Reaper still shows 
up when a Sim dies, and 
from birth to death their lives 
are touched by silliness, but 
generally speaking you’re free 
to establish the tone you want 
for your particular story.

Location, location
Neighbourhoods have been 
restructured in a way that will 
be controversial with fans 
of The Sims 3 and anybody 
who has feared that the 
series would suffer the same 
downscaling that afflicted its 
cousin, SimCity. There are two 
‘worlds’, Willow Creek and 
Oasis Springs, each comprising 
a handful of small areas with 
four or five building plots. You 
can only load one interior at a 
time, and traveling between 
locations involves a (short) 
loading screen. The Sims 3’s 
cars and bikes are gone. 

AI-controlled Sims populate 
each area in substantial 
numbers, and even though 
the abstract map screen 
doesn’t quite have the same 
sense of life as The Sims 3’s 
open world, individual areas 
feel more active than they 
did before. With a bit of 
tinkering, it’s also possible 
to fundamentally customise 
these small words to your 
liking by changing plots to 
support different types of 
buildings. You can build your 
own cafes and museums as 
well as homes, and that 
encourages the degree of 
obsessive personal 
attachment that many fans 
will be looking for. It also 
seems like it’d be easier to 
expand upon in future.

If there’s a downside to 
these places it is that they 

Popularity contests
Which celebrities shine in the community gallery?

Barack 
Obama  
Some 
renditions 
are excellent. 
Others are 
less so.

Taylor Swift  
Popular 
with tweens 
and 20-  
something 
games 
journalists.

TotalBiscuit 
The popular 
YouTuber 
loses out to 
PewDiePie.

Leonardo 
DiCaprio 
Sadly, there’s 
no ‘Howard 
Hughes’ 
option.

Hitler   
In any online 
community, 
it’s only a 
matter of 
time before 
someone is 
compared to 
the dictator.

John 
Riccitiello  
Former EA 
CEO. Okay, 
I had to 
make this 
one myself.

 The toddler life stage has 

been removed  – Sims now go 

directly from infant to child  
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aren’t very interesting. During 
the game’s development, a 
single piece of concept art was 
shown off multiple times – a 
strip of moonlit bars and 
houses along a stretch of river 
in the bayou, Louisiana by way 
of Paris. It was an exciting 
image because it was very 
unlike what The Sims had been 
before; it suggested an 
intimacy and depth of detail 
that, sadly, this game doesn’t 
quite match. That strip of 
buildings is actually in the final 
game – if you spin the camera 
around in a particular plot in 
Willow Creek you can see it, 
across the river. But it’s just a 
static mesh in the distance; a 
hint of what might have been.

Of course, that’s before 
players themselves make it so. 
The Sims 4’s build tools are the 
best in the series. Rescaling 
rooms is far easier than it was 
before, and the improvements 
to pathing make unorthodox 
arrangements more viable. I 

spent an hour building a 
modernist home based on 
images I’d collected from the 
internet and the experience 
was far more gratifying than in 
The Sims 3. I expect to be 
amazed by what people with 
actual talent can do.

Making faces
The same is true for character 
creation. You tweak a 
characters’ features and body 
type by tugging them with 
your mouse, and there’s 
a wide variety of clothing 
options and styles. It’s possible 
to create simulacra of yourself, 
friends and celebrities to an 
uncanny degree of accuracy, 
with the main weakness being 
that everybody is the same 
height. Character creation 
qualifies as a game in its own 
right, if the number of famous 
faces being shared online is 
anything to go by.

Initially I was a little skeptical 
about the role of cloud sharing 

Once more with feeling. 
A fine if familiar base game, 
with great creative tools.

 Expect expansion packs with extra  

 furniture for your virtual dolls’ house 

 Fulfilling the life ambition to write 

captions for Windows Help & Advice

 Work on your skills at home  

 to perform better at work 

 If in doubt, discuss  

 the weather 
 Trying to watch  

TV? Tough 

in The Sims due to cynicism 
about EA’s ‘everything belongs 
online’ policy. In this case, it 
works brilliantly. The Gallery 
is a central repository for 
uploading your designs and 
downloading other people’s. 
If you feel like dropping a 
virtual Barack Obama into 
your neighbourhood, simply 
search for his name in the 
Gallery. Players are already 
sharing imaginative homes, 
and I suspect that it is possible 
to fill every home in the game 
with a different player’s 
interpretations of what Taylor 
Swift looks like.

Cynicism is sadly warranted 
by the asking price, however: 
the game is a staggering 
£50/$60 on Origin. EA knows 
that it doesn’t need to follow 
the trend of PC games getting 
cheaper because The Sims will 
always sell, but that doesn’t 
feel like an excuse. The 
absence of a microtransaction 
store makes the acting price 

feel less like a mugging, but 
you’ll probably end up paying 
for expansions in the future.

After a week of play, 
however, I feel confident in 
calling this the best Sims 
base game to date. It benefits 
from everything that Maxis 
has learned since making 
The Sims 3, and it provides 
a firm platform on which to 
build a future. It’s the game 
you know, but slightly better. 
No other game offers what it 
does. There is comfort in that 
familiar feeling. 
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explore the city, completing 
side quests, rescuing survivors 
and hunting for weapons. This 
feels like any number of other 
open-world games, complete 
with uninspiring fetch quests 
and arbitrary collectables.

But back to hitting zombies. 
Every weapon feels unique, 
whether you’re carving 
through the hordes with a 
chainsaw, lopping heads off 
with a broadsword or mowing 
them down with a minigun. 
The sheer number of ways to 
squish zombies is impressive, 
and it feels great thanks to the 
tactile, weighty combat.

A world of fun
Los Perdidos is brilliantly 
detailed. You can enter a huge 
number of buildings, and they 
all contain unique weapons. 
Realism is not in Dead Rising’s 

Enjoy comical zombie slaughter on a massive scale
Price £40 | $50
Developer Capcom Vancouver
Publisher Capcom  
Multiplayer Co-op, 2 players  DRM Steam Web www.capcom.com
Recommended specs 3GHz CPU, 2GB GPU, 6GB RAM

vocabulary, and there’s a shop 
that inexplicably sells swords, 
axes, knives and scythes. My 
face lit up when I found that 
place, for obvious reasons.

To make up for the bigger 
world, vehicles are littered 
around the map, including 
cars, bikes, vans and even 
steamrollers. Nick, being a 
mechanic, can also combine 
vehicles to create new, more 
deadly ones, like sticking the 
front of a steamroller onto 
a motorcycle. The combo 
weapon system is back too, so 
you can take a DIY approach.

Dead Rising 3 is one of 
those games that just wants 
you to have fun. It revels in its 
silliness, even when it’s being 
serious. There’s a cutscene 
where, after killing his first 
zombie, Nick has a moment 
of reflection – rendered 

The city of Los Perdidos 

has a zombie problem. 

Everywhere you look 

they’re there, shuffling 

and groaning. So it’s a good 

thing you have over 300 

objects to hit them with. Dead 
Rising has always had a vast 

array of very silly weapons, but 

the third game has taken this 

idea to new extremes.

You play Nick Ramos, a 
mechanic trapped in Los 
Perdidos with a group of other 
survivors. The government will 
drop a bomb on the city in five 
days, and you have to escape 
before it does. Dead Rising’s 
other ‘thing’ is giving you a 
time limit, but this is the most 
generous one yet – which 
actually works against it.

The first two games had a 
real sense of urgency, but now 
you have plenty of time to 

Dead Rising 3 accidentally hilarious by the 
fact that I had him wearing a 
child’s superhero costume and 
a big handlebar moustache.

While most of Dead Rising’s 
best bits have carried over 
– the persistent XP system, 
the combo weapons, the 
daft hats – some of its worst 
have too, namely the boss 
battles. They’re long-winded, 
attritional slogs and are 
no fun, following easily 
exploitable patterns. These 
and the filler sidequests sour 
the experience.

The killing-lots-of-zombies 
genre is overcrowded, but 
Dead Rising 3 is one of the 
best, with an endearing 
dedication to fun, and some 
of the most inventive, hilarious 
weapons on PC. Be warned, 
though: it’s a system hog, and 
you’ll need a substantial PC to 
run it on the higher settings. 

A fun open world zombie 
slayer with weapons, but the 
boss battles are a real pain.

 That expression just about  

sums up Dead Rising

Guns are powerful, but 

not as  much fun as 

melee weapons

Swords are hugely 

satisfying to  

swing about

 Motorcycles are fast, but  

 don’t offer much protection 
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point-and-click adventure 
legacy. Season 2 is stronger 
without them, but swings too 
far the other way, cutting out 
moments when you can 
explore and talk to characters 
between major story events. 
There’s usually one point in 
each episode where Clem is 
free to chat with her fellow 
survivors, but no one has 
much to say, and within a few 
minutes it’s time for the next 
conversation-driven cutscene.

I never got to know Season 
2’s characters as well as I 
wanted, but Telltale’s dialogue 
still sketches out their 
personalities effectively. 
The change makes sense in 
context: where Season 1 is 
more about how Lee relates 
to his group, Season 2 focuses 
on shaping Clementine as 
a character. I played her as 

Clem is back, making friends and breaking hearts
Price £19 | $25 for five episodes 
Developer Telltale Games
Publisher In-house  
Multiplayer None  DRM Steam Web www.telltalegames.com/walkingdead
Recommended specs 2GHz CPU, 3GB RAM, 512MB GPU

a savvy child, occasionally 
whimpering at adults for 
sympathy, but more often 
making the calculated choices 
of a survivor. She was good 
at heart though, trying to 
save everyone, even when it 
seemed hopeless. 

There were other ways to 
play her, all presented through 
great dialogue, but it’s soon 
obvious that she can’t be a 
powerful protagonist and 
a believable kid. Too many 
life-or-death decisions fall on 
her shoulders. Too many other 
survivors are incompetent.

Episode 2 is easily my 
favourite of the season. 
Clementine has the power to 
make choices, but isn’t treated 
like an adult. And for every 
important decision she can 
make, there’s another situation 
in which she’s powerless. 

Clementine was a sweet 

kid, wasn’t she? The 

breakout star of The 
Walking Dead Season 1 

steps into bigger purple 

sneakers in Season 2, two years 

older and a decade wiser. 

Season 2 follows the pattern 
laid down by the first series. 
Conversations are central, 
offering four dialogue options 
to influence the story. More 
dramatic binary choices 
sometimes affect who lives 
and who dies, but this is still 
The Walking Dead – anyone 
you save will probably kick the 
bucket before long. There are 
a few quick-time events, and 
playing as Clementine lends 
them a sense of desperation 
they didn’t have with this first 
season’s protagonist, Lee. 

This season shakes loose 
the last vestiges of Telltale’s 

The Walking Dead Season 2
Episode 2 also introduces 
antagonist Carver, voiced by 
the gravel-throated Michael 
Madsen. Carver is a great 
villain. He’s menacing, maybe 
insane, but hand-to-God 
believes that his decisions 
(which usually involve killing 
people) are justified. 

In Season 2, Telltale added 
the option to replay episodes 
from checkpoints and save to 
a different file. It sounds like 
heresy (the anguish is the 
point!) but seeing how the 
moving pieces fit together 
made me appreciate the game 
even more. Telltale knew how 
Clementine’s story would end, 
but you can shape the path 
that takes her there. 

Not as fresh as Season 1, 
but it packs an emotional 
punch when it counts.

 I sure hope there are no 

 cannibals in this one 

 If everyone’s happy, 

it’s probably  time 

for someone to die 

 Michael Madsen is even  

 creepier than in Reservoir Dogs 

The old ‘cover yourself in zombie  

 guts’ trick. Works every time 

Lee taught Clementine 

many skills. Dentistry was 

not one of them 

 You really only need   

 one hand, right? 
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Your disc
Hello and welcome 
to your free disc, 
exclusive to 
Windows Help & 
Advice. This month’s 

packed CD-ROM features great 
programs to help you get the 
best from your computer, plus 
essential resources for every 
Windows user.

In addition to a huge array 
of free apps, we’ve included a 
Windows 7 ebook worth £5.99 
in the Extras section on the disc. 
Whether you’re a newcomer to 
Windows or a seasoned expert, 
you’re guaranteed to learn 
something new. Enjoy! 

Jeremy Ford disc editor
jeremy.ford@futurenet.com

1 Get started 
Place your free disc into your computer’s disc drive. The 

AutoPlay prompt should appear on your screen and once this  
has happened, click ‘Run OWV.exe’ to start up the disc interface.  
A new window appears, telling you some important information. 
Read it, then click on ‘I agree’ to continue.

2 Browse the categories 
Click on one of the categories in the menu underneath the 

magazine logo to discover all the programs that are contained in 
each. Simply click on an app’s name to find out more about it.  
Full commercial products usually have information about how  
to register. To try out an app, just click the ‘Install Now’ button.

Step-by-step How to use your free disc

76 Remove all traces of old 
programs with iObit Uninstaller

14 Give your PC’s hard drive a  
thorough clearout with CCleaner

77 Let Auslogics Registry Defrag 
give your PC a speed boost

32 Use yWriter to plan, plot  
and write your first novel

 FULL PRODUCTS   HANDPICKED TOOLKITS   ESSENTIAL RESOURCES
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Your disc
Make the most of it!

3 Install the program 
When you begin to install your chosen applications, the  

disc brings up another message window to take you through the 
installation process. Each one of these is different – just follow the 
prompts until you get a message telling you that the installation 
is complete. Now it’s time to try out your free apps – have fun!

FIND THE SOLUTION! How to get your disc to play
If the disc doesn’t start automatically, hit the [Windows] key, 
then click ‘Computer’. Double-click the DVD drive to get going.

If you have  
a problem…
Please visit www.
futurenet.com/support. 
To contact our reader 
support team, email 
support@futurenet.com 
or call 01225 822743, 
quoting the magazine 
name and issue. We are 
only able to provide help 
with this disc, not the 
software contained on it.
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The technologies that will make 
AMD a force to be reckoned with

CREATE CHARACTERS
How games developers turn 

concepts into powerful heroes 
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¤ Speed up Windows 
 ¤ The best gaming 
headsets revealed
¤ Master PC audio
¤ Make awesome 
pixel art in GIMP

PLUS

G-Sync smoothness 
takes on cinematic 
gaming immersion

SCREEN WARS

ASUS RoG
SWIFT & LG 
ULTRAWIDE

VS

¤ What next for Nvidia, Intel and AMD?
¤ Next-gen CPUs, GPUs and more...
¤ Ultra-fast high capacity SSDs

THE IDEAL TABLET
FOR GAMERS!

FULL REVIEW
INSIDE

NVIDIA 
SHIELD

EXCLUSIVE

NO.1 FOR REVIEWS ¤ AORUS M7 THUNDER ¤ AMD A10-7800
¤ ASUS ROG G550 PLUS LOADS MORE!

OCTOBER  2014        PRINTED IN THE UK  £5.99          (£6.49 Outside UK & ROI)

OPTIMISE BOOT TIMES
How to tweak the Windows boot 
process to load your OS quicker 

MAKE YOUR OWN MUSIC
How to create tunes from scratch 
with the best free tracker tools

ISSUE 295/SEPTEMBER 2014

¤ Complete systems from just £337
¤ AMD Kabini vs Intel Pentium 
¤ More powerful than next-gen consoles

BUILD A 
BUDGET
GAMING PC

SAMSUNG 850 
PRO 512GB
The world's fi rst 3D V-NAND 
solid-state drive in the labs

NEXT-GEN SSD

THE BEST 
GAME ENGINES
Making your own games 
has never been easier

SUPERTEST THE BEST 4K DISPLAYS AVAILABLE

NO.1 FOR REVIEWSGIGABYTE Z97 GAMING 5INTEL CORE i5-4690KAPPLE iMAC 21-INCHPLEXTOR M6e M.2

SEPTEMBER  2014      PRINTED IN THE UK  £5.99       (£6.49 Outside UK & ROI)

NOW  
ON APPLE 

NEWSSTAND
Download the 

day they go  
on sale in the  

UK!
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